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Introducing Software
Management

This chapter includes the following topics:

■ About Software Management

■ Components of Software Management Framework

■ Components of Software Management Solution

■ Web parts for Software Management Framework

■ Web parts for Software Management Solution

■ What you can do with Software Management Framework

■ What you can do with Software Management Solution

About Software Management
Software Management consists of the management of software. The use of software resources
helps you gain efficiencies in the performance of your daily software management tasks. With
the Software Management Framework you can automate those tasks so you can spend more
time on other issues.

See “About Software Management Framework” on page 10.

Software Management Solution provides intelligent and bandwidth-sensitive distribution and
management of software. Software Management Solution integrates with the Software
Management Framework to focus on software delivery.

See “About Software Management Solution” on page 11.
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About Software Management Framework
Software Management Framework is part of the Symantec Management Platform. It provides
the Definitive Software Library and configuration management capabilities of a Configuration
Management Database (CMDB).

Software Management Framework facilitates integration between the solutions in Symantec
Management Platform by providing a common way to store, identify, and detect software. It
provides the structure in which to define the software and it provides the tools with which to
manage the software definitions.

Software Management Framework introduces a change in the way that software is identified.
All software is defined in a single location and in a consistent manner. The software definitions
are referred to as software resources. The software-related functions in Symantec Management
Platform can use these software resources, which ensures that they all identify the same
software in the same way.

The use of software resources helps you gain efficiencies in the performance of your daily
software management tasks. You no longer need to perform many of your software tasks
manually. Instead, you do some of the work initially by defining the information that helps to
automate those tasks. Then you can let Software Management Framework and the solutions
help manage your software so that you can spend more time on other issues.

Examples of how the software resource data can help you perform software tasks are as
follows:

■ You can define any other software that a specific software resource depends on. When
you deliver that software resource, the dependency software is automatically included in
the delivery. You do not have to remember to deliver the dependency software separately.

■ The software resource’s unique identifier provides a consistent way to detect the software
on the client computers. Before the software delivery process downloads the software to
a computer, it can determine whether that software is already installed. The delivery process
can also check the computer periodically to verify that the software is still installed and to
reinstall the software if necessary. This automated verification and remediation can
substantially reduce your need to respond to help desk calls for missing or broken software.
You can define a detection rule that contains additional information about the software and
makes the detection process even more accurate.

■ You can specify the critical executable files that are associated with a software resource.
Then inventory scans can accurately determine whether that software is installed on a
computer. For example, you specify four critical files and add them to the detection rule for
a software resource. When the detection rule evaluates a client computer, it considers the
software to be installed only if it finds all four files on that computer.

Software Management Framework promotes smart software management so that you know
all about your software as follows:
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■ You know what software you have, where it is installed, and where the physical software
packages are.

■ You know that the software you install is the software that you intended to install.

■ You know that the software remains in the correct state on the client computers.

■ You know that when a software inventory scan finds an application on a computer, the
application is identified as the same one that you installed.

■ You know that patches are applied to the correct software.

Your solutions can provide this knowledge because they use the software resource information
that you define in Software Management Framework.

Software Management Framework supports packages for the Windows, UNIX Linux, and Mac
operating systems. With few exceptions, all the functions in Software Management Framework
work the same for all platforms. For example, you use the same method to create a software
resource for a Windows, UNIX, Linux, or Mac OS package.

See “Components of Software Management Framework” on page 14.

See “About the Software Catalog” on page 25.

See “Benefits of the Software Catalog” on page 26.

See “About the Software Library” on page 28.

See “Benefits of the Software Library” on page 30.

About Software Management Solution

Note: Current documentation applies to the most recent version of the product.

Software Management Solution provides intelligent and bandwidth-sensitive distribution and
management of software from a central Web console. It significantly reduces desktop visits
and lets you easily support your mobile work force.

See “What you can do with Software Management Solution” on page 20.

See “Implementing Software Management Solution” on page 57.

See “Components of Software Management Solution” on page 15.

Software Management Solution also lets users directly download and install approved software
or request other software.

Software Management Solution integrates with the Software Catalog and the Software Library
that are part of the Symantec Management Platform. By leveraging this information, Software
Management Solution ensures that the correct software gets installed, remains installed, and
runs without interference from other software. This integration lets your administrators focus
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on delivering the correct software instead of redefining the packages, command lines, and so
on for each delivery.

See “How Software Management Solution integrates with Software Management Framework”
on page 13.

See “About Software Management Framework” on page 10.

See “About the Software Catalog” on page 25.

See “About the Software Library” on page 28.

Software Management Solution combines the functionality of earlier versions of Software
Delivery Solution and Application Management Solution.

Software Management Solution data is stored in the Configuration Management Database on
the Notification Server computer. The data is grouped in resource data classes. A resource
data class defines one or more fields, and the properties of the fields, that a resource of that
class may have.

Settings in the Symantec Management Platform determine how long the data is retained in
the database before it is purged. You can specify the retention period for specific data classes.
These settings are on the PurgingMaintenance page,Resource Event Data Purge Settings
tab, that appears in the Symantec Management Console.

The data classes that represent Software Management Solution data are as follows:

■ Computer Events:
AeX SWD Execution
AeX SWD Package
AeX SWD Status
SoftwareManagementSolution MSI Repair

■ Events:
SoftwareManagementSolution App State Failures
SoftwareManagementSolutionAppRepair

■ Policy Compliance Remediation

For UNIX and Linux computers, the data classes that represent Software Management Solution
data are as follows:

■ Computer Events:
AeX SWD Execution
AeX SWD Package
AeX SWD Status

Software Management Solution supports hierarchy and replication. These features let you
create tasks and policies at the top-level Notification Server computer and replicate them to
child-level Notification Server computers.
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Hierarchy defines the information flows across multiple Notification Server computers in an
enterprise. Hierarchy uses replication to copy and synchronize shared objects and data between
multiple Notification Server computers within the same hierarchical structure.

Software Management Solution supports full and differential replication. Differential replication
replicates only those items that changed since the last replication.

Hierarchy replicates each object or piece of data in one direction only.

Software Management Solution supports hierarchy editable properties (HEP). This feature
lets you configure which of the policies' properties can the administrators down the hierarchy.
By default, all of the hierarchy editable properties (Schedule,Resource targets, and Enabled)
are turned off and cannot be modified down the hierarchy. One exception is the Resource
targets property in the managed software delivery policies, which is turned on by default. This
exception is required for the managed software delivery policies to be published correctly to
the Software Portal down the hierarchy.

Software Management Solution supports packages for the Windows, UNIX, Linux, and Mac
operating systems. With few exceptions, all the functions in Software Management Solution
work the same for all platforms. For example, you use the same method to create a delivery
task for a Windows, UNIX, Linux, or Mac OS package.

For a complete list of the platforms that Software Management Solution supports, see the
Client Management Suite Release Notes.

How Software Management Solution integrates with Software
Management Framework

In Software Management Solution, Quick Delivery and Managed Software Delivery leverage
the software resource information that is in the Software Management Framework. Software
Management Framework consists of the Software Catalog and the Software Library, as well
as tools to create and manage the software resources. When you create a task or policy, you
select a software resource to deliver. Any information about the software that the task or the
policy needs is available from the software resource.

Software Management Framework, together with the Software Catalog and the Software
Library are part of the Symantec Management Platform.

See “About Software Management Framework” on page 10.

See “Components of Software Management Framework” on page 14.

See “About the Software Catalog” on page 25.

See “About the Software Library” on page 28.

See “Introducing software resources” on page 44.
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Table 1-1 How features in Software Management Solution use software resource
information

Usage of software resource informationFeature

The Quick Delivery wizard limits the selections that you need to make to deliver software.
You select the software resource to deliver, the command line to use, and the destinations
to target. The software resource provides any other information that is required for the
delivery. This simplified delivery method lets you entrust certain deliveries to
non-administrators such as help desk personnel.

Quick Delivery

The software resource information is essential for the complex deliveries that Managed
Software Delivery performs.

Managed Software Delivery uses the software resource’s rules to intelligently perform
applicability and compliance checks and to remediate the software that is out of compliance.
These checks conserve bandwidth by ensuring that the software is not downloaded to
computers on which it is already installed.

The Managed Software Delivery wizard can use the software resource’s associations to
alert you to the following situations:

■ When the selected software depends on other software resources
■ When an update to the selected software is available
■ When other software supersedes the selected software
■ (Windows only) When the selected software resource conflicts with another software

resource

See “About advanced software deliveries” on page 120.

Managed Software
Delivery

(Windows and Mac OS only) In each software resource, you can configure settings for
making that software available to the Software Portal. The settings determine which users
are allowed to request that software and whether their requests require approval.

See “About the Software Portal” on page 151.

Software Portal

Components of Software Management Framework
The components of Software Management Framework let you define and manage your software
resources.

See “About Software Management Framework” on page 10.
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Table 1-2 Components of Software Management Framework

DescriptionComponent

A centralized model of the software that is known in your organization.
The Software Catalog contains the meta data that describes your software
resources.

In ITIL terms, the Software Catalog represents a portion of a Configuration
Management Database (CMDB).

See “About the Software Catalog” on page 25.

Software Catalog

A secure directory that is the centralized repository of the definitive,
authorized versions of the software that your organization manages. It is
the physical source for your managed packages.

In ITIL terms, the Software Library is equivalent to a Definitive Software
Library (DSL).

See “About the Software Library” on page 28.

Software Library

These tools let you create the software resources that you need to
manage.

Tools to populate the
Software Catalog and the
Software Library and to
manage their contents.

Components of Software Management Solution
The components of Software Management Solution let you deliver and manage software on
client computers.

See “What you can do with Software Management Solution” on page 20.

Table 1-3 Components of Software Management Solution

DescriptionComponent

You can use any of several methods to deliver software to client computers.
The method that you use to create the task or policy depends on your delivery
requirements.

See “Methods for delivering software” on page 105.

Software delivery tasks
and policies

The Software Portal is a Web-based interface that is installed on the client
computers. With the Software Portal, users can request and install software
with little or no administrator involvement.

See “About the Software Portal” on page 151.

Software Portal
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Table 1-3 Components of Software Management Solution (continued)

DescriptionComponent

You can manage Windows Installer applications as follows:

■ Repair broken Windows Installer applications.
■ Update the source paths for Windows Installer applications.

Tasks and policies for
managing Windows
Installer applications

Predefined reports let you easily view and analyze your software management
data. You can also create your own custom reports.

See “Running a Software Management Solution report” on page 117.

Reports

Web parts for Software Management Framework
Web parts are the building blocks for portal pages in the Symantec Management Console.
Web parts are predefined for the products that you have installed. You can edit the predefined
Web parts, and you can create new Web parts. Your user privileges determine which of the
Web parts you can use and whether you can edit and add Web parts.
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Table 1-4 Web parts for Software Management Framework

DescriptionWeb part

Lets you view a list of registered data providers. For each provider, the list
displays the number of available software resources and when an import or
gather was last run. A software resource is available if it has data that is ready
to be imported.

On this Web part, you can add or delete a data provider. You can also open
a data providers page to edit its setting.

From the right-click menu of a data provider, you can schedule an import or a
gather. When you schedule an import, you can import the data provider’s meta
data. You can also import the software packages that are associated with the
meta data if the data provider supports this functionality.

See “Importing data from a data provider with a schedule” on page 89.

After the gather runs, the Available data column of the Data Provider Web
part is updated. A gather also gathers a list of the available software resources
and adds them to the Data Provider Summary page. From the right-click
menu of a data provider, you can click View Data Provider Summary to
access the Data Provider Summary page. On this page, you can select
specific software resources to import.

See “Importing data from a data provider manually” on page 90.

To use the functionality of the Data Provider Web part, you must be assigned
the Symantec Software Librarian security role.

Data Providers

Lets you perform a quick search of the software resources that are in the
Software Catalog. You can edit, delete, and perform other actions on the
software resources that are found.

Software Finder

Web parts for Software Management Solution
Web parts are the building blocks for portal pages in the Symantec Management Console.
Web parts are predefined for the products that you have installed. You can edit the predefined
Web parts, and you can create new Web parts. Your user privileges determine which of the
Web parts you can use and whether you can edit and add Web parts.

See “About Software Management Solution” on page 11.
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Table 1-5 Web parts for Software Management Solution

DescriptionWeb part

Lists each of the available data providers for the software management
products.

Data Providers

Displays a pie chart that summarizes all the open requests that are in the
Software Portal and groups them by status. It also shows the number of
requests that are in each status group.

Open Software
Request Status

Lists all software deliveries and displays a green bar next to those that
succeeded and a red bar next to those that failed. It includes the following
delivery types: Managed Software Delivery, Quick Delivery, Package Delivery,
and Legacy Software Delivery.

Recent Software
Delivery Status

Displays a pie chart that shows how many software installations are compliant
and not compliant among those that were installed with Managed Software
Delivery. This data is based on the most recent compliance checks that the
currently-active Managed Software Delivery policies performed.

A software installation is considered compliant when it is in the correct state
on the client computers. For example, if the software is installed and it should
be installed, it is compliant. If the software is installed but it should not be
installed, it is not compliant.

Software Compliance
Summary

Displays a graph that shows the number of deliveries that succeeded and
failed among the deliveries that were attempted within the specified time period.
It includes the following delivery types: Managed Software Delivery, Quick
Delivery, Package Delivery, and Legacy Software Delivery.

Software Delivery
History

Displays a pie chart that shows the number of deliveries that succeeded and
failed among all deliveries that were attempted. It includes the following delivery
types: Managed Software Delivery, Quick Delivery, Package Delivery, and
Legacy Software Delivery.

Software Delivery
Status

Lets you quickly find a software in the catalog.Software Finder

Displays a pie chart that summarizes all the software requests that were placed
through the Software Portal and groups them by status. It also shows the
number of requests that are in each status group.

Software Portal
Request Summary

What you can do with Software Management
Framework

Software Management Framework uses the Software Catalog and the Software Library to
provide a structure for identifying and managing software. The tasks that you can perform in
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Software Management Framework help you to define and manage the software that is used
in your organization.

See “Implementing Software Management Framework” on page 31.

Table 1-6 Key tasks in Software Management Framework

DescriptionTask

You can set up a Software Library directory and associate it with a Symantec
Management Platform installation.

See “Setting up the Software Library” on page 33.

Set up the Software Library

The Software Management Framework settings can help you manage the Software
Catalog and its resources.

Schedule the Clean up File Resources task to periodically delete any files that might
be left in the database after file resources are deleted. This task is scheduled by default.
Edit it only if you want to change the schedule or disable it.

The Known-as mappings create known-as associations to associate the unique
identifiers of two software resources so that they are identified as being the same
software. The known-as associations help the software-related operations to identify
software resources accurately. Create any necessary known-as associations before
you begin to populate the Software Catalog or as soon as you find duplications. New
known-as associations do not affect existing software resources.

The Installation Error Code Descriptions list eliminates the need to look up a
numerical error code when you run a report, associate informative descriptions with
the error codes. Some error code descriptions are predefined. Create additional
descriptions if the predefined descriptions do not meet your needs.

Configure settings

You can perform a search in the Software view and in the Software Catalog window
to find specific software. You can also use advanced search criteria to further narrow
the software that is displayed.

View the software

You populate the Software Catalog by adding software resources. You can use any
of several methods to add software resources to the Software Catalog.

Populate the Software
Catalog
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Table 1-6 Key tasks in Software Management Framework (continued)

DescriptionTask

Regardless of how a software resource is created, you can add and edit additional
information as follows:

■ Create associations between software resources.
You can define associations between software resources in the Software Catalog.
These associations add logic to software-related tasks.

■ Associate a package with a software resource.
You can define the installation package that installs a software resource.
See “Associating a package with a software resource” on page 69.

■ Associate files with a software resource.
A software resource can contain references to the important files that it installs.
These files typically are DLL and EXE files. However, you can add references to
any files that can help to identify a specific software resource.
See “Adding file resources to a software resource manually” on page 78.

■ Configure the package server settings for a package.
You can assign a package to the package servers that it can be copied to and
delivered from.

Add and edit software
resources

The Software Library is a secure directory that is the centralized repository of the
definitive, authorized versions of the software that your organization manages. Place
packages in the Software Library to ensure that external users cannot change the
packages after they have been approved for rollout in your environment.

Populate the Software Library

You can create a command line that runs a package or that runs without a specific
package.

See “Creating a command line for a software resource” on page 72.

The Command Line Builder helps you create command lines without an extensive
knowledge of the command-line options or syntax. You select the appropriate options
and the Command Line Builder creates an error-free command line for an optimal
installation, update, or other action.

Create command lines for
software resources

(Windows only) Inventory rules perform the checks that are related to the software that
is installed on a client computer and to the computer’s environment. You can create
and edit the inventory rules that you associate with specific software resources.

See “Creating or editing inventory rules” on page 73.

Create inventory rules

What you candowith SoftwareManagement Solution
Software Management Solution lets you distribute and manage the software that is used in
your organization.
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See “About Software Management Solution” on page 11.

Table 1-7 What you can do with Software Management Solution

DescriptionTask

Configuration settings control the behavior of Managed Software Delivery policies.
Rather than configuring these settings individually for each policy, you can configure
the default settings that apply to all new Managed Software Delivery policies. Then
you can change the settings for a specific policy only when needed.

See “Configuring the default settings for Managed Software Delivery” on page 63.

Configure the default settings
for Managed Software
Delivery policies.

Managed Software Delivery simplifies your advanced software deliveries by letting you
deliver software as a unit, which can include multiple software resources and their
dependencies. For example, you can create a single Managed Software Delivery policy
that installs an application and its associated patches and service packs. Managed
Software Delivery can also run any task at any stage of the delivery.

See “Performing an advanced software delivery” on page 143.

See “Performing software import and managed delivery” on page 142.

Perform an advanced
software delivery.

You can perform a quick delivery of a single software resource that runs with minimum
configuration. You can use the task-based Quick Delivery method to specify the software
to deliver, the action to perform, and the computers to deliver to. Because the software
resources and the delivery settings are predefined, Quick Delivery makes it easy for
administrators and non-administrators to deliver software.

See “Performing a quick delivery of a single software resource” on page 108.

Perform a quick delivery of a
single software resource.

Package Delivery lets you quickly push out any package regardless of whether it is
associated with a software resource.

See “Delivering a package without defining a software resource” on page 112.

Deliver a package without
defining a software resource.

By using the Software Portal, users can request and install software through a
Web-based interface with little or no administrator involvement.

See “About the Software Portal” on page 151.

Deliver software to fulfill user
requests.
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Table 1-7 What you can do with Software Management Solution (continued)

DescriptionTask

You can create policies and tasks to manage Windows Installer applications on
managed computers as follows:

■ Repair Windows Installer applications.
You can proactively identify and repair broken applications on selected computers.
If an application needs repair, a repair command is sent to the Windows Installer
service to initiate self-repair.
See “Repairing Windows Installer applications” on page 97.

■ Update the source paths for Windows Installer applications.
You can update the source paths of Windows Installer applications with resilient
source paths. The updated source paths point to the package servers that you
designate. If an application needs modification or repair, Windows Installer can
access the needed installation file from one of these servers.
See “Updating the source paths of Windows Installer applications” on page 94.

Manage Windows Installer
installations on client
computers.
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Getting Started with
Software Management

■ Chapter 2. Implementing Software Management Framework

■ Chapter 3. Implementing Software Management Solution
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Implementing Software
Management Framework

This chapter includes the following topics:

■ Introducing Software Management Framework

■ Implementing Software Management Framework

■ Setting up the Software Library

■ Configuring the Software Library

■ Scheduling a Clean up File Resources task

■ Running a Clean up File Resources task

■ Adding descriptions to installation error codes

■ Defining known-as wildcards

■ Editing or deleting a known-as association

■ Populating the Software Catalog

Introducing Software Management Framework
Before you implement Software Management Framework, it is a good idea to better understand
its components, benefits, and other useful information.

To help you get more familiar with Software Management Framework you can refer to the
following:

■ The Software Catalog component of Software Management Framework
See “About the Software Catalog” on page 25.
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■ The benefits of the Software Catalog to software management
See “Benefits of the Software Catalog” on page 26.

■ Simplifying software-related actions with user roles
See “About the separation of software-related user roles” on page 27.

■ The Software Library component of Software Management Framework
See “About the Software Library” on page 28.

■ The benefits of the Software Library to software management
See “Benefits of the Software Library” on page 30.

About the Software Catalog
The Software Catalog is a component of Software Management Framework, which is part of
the Symantec Management Platform.

See “About Software Management Framework” on page 10.

See “Components of Software Management Framework” on page 14.

The Software Catalog is a centralized model of the software that is known in your organization,
regardless of where the software is installed. The Software Catalog does not contain any
software. Instead, it contains the data that describes the software. If a package is associated
with the software, the Software Catalog also points to the source of the package file.

The Software Catalog provides a common way to describe software so that all software-related
actions can identify it accurately.

In ITIL terms, the Software Catalog represents a portion of a Configuration Management
Database (CMDB). A software resource that is defined in the Software Catalog is equivalent
to a configuration item (CI).

We recommend that you define in the Software Catalog all the software that you need to
manage. Typically, you need to manage the software that is approved for installation in your
organization. You manage approved software to ensure that is installed properly and it remains
in the correct state.

You might also decide to manage the software that is not approved for installation in your
organization. You might not think that unsupported software needs to be managed. However,
you might want to do so to ensure that it is never installed. For example, you can define game
software or certain peer-to-peer applications in the Software Catalog. Then you can check the
client computers for that software and uninstall it when it is found.

The Software Catalog eliminates the need to perform software-related tasks manually and lets
you define the software resources and rules that can automate those tasks.

See “Benefits of the Software Catalog” on page 26.
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Benefits of the Software Catalog
The initial time that you take to define your software in the Software Catalog results in both
immediate and long-term benefits. We recommend that you define in the Software Catalog all
the software that you need to manage.

See “About the Software Catalog” on page 25.

Table 2-1 Benefits of the Software Catalog

DescriptionBenefit

The Software Catalog reduces the risk of user errors because all the information about a
software resource is predefined.

Examples of how the software resource information can be used are as follows:

■ Users do not need to define the package and the command line every time they deliver
software. When users select a software resource instead of its packages or command
lines, they are less likely to act on the wrong software.

■ Users are less likely to miss dependencies and other associations between software
resources because the associations are defined in the Software Catalog.

■ The software resource’s unique identifier provides a consistent way to detect the software
on the client computers. Therefore, Inventory Solution can determine which managed
computers have specific software installed.
(Windows only) You can define a detection rule that contains additional information about
the software and makes the detection process even more accurate.

Ensures consistency
and accuracy

You can define a software resource one time and use it many times. Even non-administrators
can perform the routine tasks that are associated with managing the software on the client
computers. Then the administrators can focus on the software tasks that have more advanced
requirements

Promotes efficiency

The Software Catalog separates the software-related information from the actions that are
taken on the software. The software experts can define the software resources and make
decisions about their packages, command lines, dependencies, and other properties. The
users who perform the software tasks only need to know which software resource to select
and what action to perform. This separation of roles means that a non-administrator, such
as a technical support person, can easily deliver a patch or update when needed.

See “About the separation of software-related user roles” on page 27.

Simplifies software
-related actions
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Table 2-1 Benefits of the Software Catalog (continued)

DescriptionBenefit

Because the Software Catalog simplifies software-related actions, it becomes easy to
automate them.

Examples of some of the software-related actions that you can automate are as follows:

■ Delivering for compliance and remediation
With Software Management Solution, you can create a policy that delivers software and
verifies that it remains in the correct state after installation. The policy uses the information
in the Software Catalog to check the software on the client computer and to reinstall the
software when necessary.
See “Performing an advanced software delivery” on page 143.

■ Delivering software through the Software Portal
With Software Management Solution, end users can request software through a
Web-based portal and install it on their computers with little or no outside intervention.
The administrator decides what software each user or group of users is allowed to install
and specifies which software requires approval. That information is defined in the Software
Catalog. If the software is pre-approved, it is installed when the user creates the request.
See “About the Software Portal” on page 151.

Facilitates automation

About the separation of software-related user roles
Software Management Framework lets you separate the software-related roles in your
organization. In a small organization, the same person or persons might assume both roles.
However, in a larger enterprise, you can let your most knowledgeable administrators perform
the more advanced tasks.

See “About the Software Catalog” on page 25.

See “About the Software Library” on page 28.

27Implementing Software Management Framework
Introducing Software Management Framework



Table 2-2 Software-related user roles

DescriptionRole

These administrators act as the software librarians. A software librarian is an expert
on the software that your organization uses. The software librarian typically spends
more time on critical software issues and little or no time on day-to-day software tasks.

The primary responsibilities of the software librarian are as follows:

■ Add software resources to the Software Catalog.
■ Add package files to the Software Library.
■ Monitor and edit the software resources that internal and external processes add

to the Software Catalog. For example, from Software Discovery scans.
■ Ensure that each software resource contains the information and logic that is

required to install successfully. For example, package resources, command lines,
associations, detection rules, and file resources.

■ Distribute package files to package servers.
■ In Software Management Solution, make software available to the Software Portal.

Administrators who manage
the information in the
Software Catalog

These administrators do not need to know all the details about the software. They only
need to know which software resource to act upon and what action to take.

For example, help desk employees can quickly deliver an update by selecting the
correct software resource from the Software Catalog. They do not need to find the
correct package file and determine the command line to run it. As a result, you free
your software administrators to focus on more complex delivery tasks.

Administrators and
non-administrators who
perform software-oriented
tasks such as software
delivery, software inventory,
or patch installation

About the Software Library
The Software Library is a component of Software Management Framework, which is part of
the Symantec Management Platform.

See “About Software Management Framework” on page 10.

See “Components of Software Management Framework” on page 14.

In ITIL terms, the Software Library is equivalent to a Definitive Software Library (DSL).

The Software Library is a secure directory that is the centralized repository of the definitive,
authorized versions of the software that your organization manages. It is the physical source
for your managed packages. A package that is sourced from the Software Library is referred
to as a managed package. Each package that is in the Software Library has a unique signature
that helps to maintain the integrity of the data in the library. You place packages in the Software
Library to ensure that external users cannot change the packages after they have been
approved for rollout in your environment.

See “Benefits of the Software Library” on page 30.
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Each package is associated with a software resource. A software resource whose packages
are sourced from the Software Library is referred to as managed. A software resource whose
packages are not sourced from the Software Library is referred to as unmanaged. For example,
the packages of an unmanaged software resource might be on an unsecured network share
or a local hard drive.Before you can place a package in the Software Library, you must create
a software resource and associate the package with it.

Only the following packages are not associated with software resources:

Packages that are added when you create a Package Delivery task and source the package
from the Software Library.

See “Delivering a package without defining a software resource” on page 112.

Symantec recommend that you source all your packages from the Software Library.

The only correct ways to add package files to the library are through Software Management
Framework as follows:

Package files can be added to the Software Library automatically when you import
a package file to create a software resource.

See “Importing a package to create a software resource” on page 46.

If you have a data provider that lets you import software resources and their
associated software packages, you can create a schedule for the import. When the
import runs, it can import any available software resources and the software
packages that are associated with those software resources. The software packages
are imported into the Software Library.

See “Importing data from a data provider” on page 86.

Automatically

When you manually associate a package with a software resource, you can choose
to add the package file to the Software Library.

See “Associating a package with a software resource” on page 69.

If you have a data provider that lets you import software resources and their
associated software packages, you can manually import specific software packages.
You gather a list of software resources that are available for import. You then select
from this list the specific software resources that you want to import from this data
provider. When you import a software resource, you can also import its associated
software package into the Software Library.

See “Importing data from a data provider” on page 86.

Manually

Warning:Do not add package files directly to the Software Library directory on the file system.
This action does not create the proper associations and compromises the integrity of the
Software Library.
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You need to secure the Software Library directory so that only the application identity of
Notification Server has access. The application identity of Notification Server is the account
that is used to access Notification Server. Do not give directory access to any other users.

Each Software Library is associated with a single Symantec Management Platform installation.

See “Setting up the Software Library” on page 33.

Benefits of the Software Library
The Software Library is a secure directory that is the centralized repository of the definitive,
authorized versions of the software that your organization manages. A package that is sourced
from the Software Library is referred to as a managed package.

The Software Library puts you in control of your software packages. You no longer have to
keep track of which folders contain which packages, or which package is the correct version.
You no longer have to worry that someone might accidentally or deliberately tamper with a
package. Instead, you can let the Software Library manage your packages so that you can
spend your time more productively.

We recommend that you source all your packages from the Software Library.

See “About the Software Library” on page 28.

Table 2-3 Benefits of the Software Library

DescriptionBenefit

You can secure the Software Library so that only Symantec Management Platform
operations can access it, and only authorized administrators can perform those
operations. Unauthorized users are prevented from making any changes to the managed
packages.

Secures your software assets

When you store all your packages in the Software Library, you always know where
your physical packages are. You no longer have to keep track of which folders contain
which packages, or which package is the correct version.

Centralizes your software
assets

When you distribute a managed package to package servers, the signature of the
package on the servers is periodically compared to the original package’s signature.
If the signatures do not match, the package on the package server is replaced with the
approved version.

Ensures that package servers
contain the correct versions
of packages
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Table 2-3 Benefits of the Software Library (continued)

DescriptionBenefit

When a package is delivered, a snapshot of the package is created on the client
computer and compared to the snapshot on the package server. If the snapshots do
not match, it is possible that some kind of interception has occurred and corrupted the
package. In that case, the package is re-downloaded.

If the package is already on the client computer because of a recurring delivery or a
delivery re-attempt, its existing snapshot is used for comparison. If a mismatch occurs,
the package is re-downloaded.

The ability to deliver software is available if Software Management Solution is installed.

Ensures that the correct
versions of packages are
delivered

Implementing Software Management Framework
Because Software Management Framework is part of the Symantec Management Platform,
you do not need to perform a separate installation or configuration. However, before you use
Software Management Framework, you must set it up and prepare it for use.

Before you implement Software Management Framework, you should become familiar with
its components, benefits, and other useful information.

See “Introducing Software Management Framework” on page 24.
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Table 2-4 Process for implementing Software Management Framework

DescriptionActionStep

A managed computer is the one on which the Symantec
Management Agent is installed. The Symantec Management Agent
is the software that establishes communication between the
Notification Server computer and the computers in your network.

The Software Management Framework agent is installed on the
client computers along with the Symantec Management Agent.
Therefore, separate installation and configuration are unnecessary.
The Symantec Management Console does not contain a user
interface for viewing, installing, or configuring the agent.

The Software Management Framework agent runs on the client
computers to perform the following functions:

■ Manage the agent and plug-in rollout technology for the
Symantec Management Platform.

■ Perform the Software Discovery scan in Software Management
Framework.
Software Discovery scans managed computers and collects
information about the Windows software that they contain.
See “Discovering software on managed computers”
on page 48.
Inventory Solution uses the Software Management Framework
agent to collect the information about the key program files for
the Windows applications that are installed with an MSI-based
installer. If you have Inventory Solution installed, the gathered
data helps you track usage of a software products.
For more information, see topics about software-based usage
tracking in the Inventory Solution User Guide.

■ Create and update a client-side software cache that keeps
track of the software that is installed and discovered on the
client computer.

■ Manage all the software delivery functions in Software
Management Solution.
Software deliveries are closely integrated with the software
resources in the Software Catalog. The Software Management
Framework agent manages the package downloads and other
aspects of software delivery.

You may have performed this step when you installed Notification
Server or when you added new computers to the network.

Install the Symantec Management
Agent to manage client computers
and install the Software
Management Framework Agent.

Step 1
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Table 2-4 Process for implementing Software Management Framework (continued)

DescriptionActionStep

Administrators need the appropriate privileges to manage the
packages in the Software Library and the software resources in
the Software Catalog.

Configure security roles for
Software Management Framework.

Step 2

The Software Library is the physical source for your managed
packages. Set up a library directory for each server installation.

See “Setting up the Software Library” on page 33.

Set up the Software Library.Step 3

You can configure the following settings for Software Management
Framework:

■ Clean up File Resources
Periodically delete any files that might be left in the database
after file resources are deleted.

■ Known-As
Use known-as associations to associate the unique identifiers
of two software resources so that they are identified as being
the same software

■ Installation Error Code Descriptions
Associate informative descriptions with the installation error
codes that appear on reports.

(Optional) Configure settings for
managing the Software Catalog
and its contents.

Step 4

The software resources that you plan to manage must be defined
in the Software Catalog.

A software resource provides a common way to describe the
software so that all software-related actions can identify it
accurately. The software resource data is stored in the Software
Catalog.

See “Populating the Software Catalog” on page 40.

Populate the Software Catalog with
software resources.

Step 5

Setting up the Software Library
The Software Library is a secure directory that is the centralized repository of the definitive,
authorized versions of the software that your organization manages. Each Software Library is
associated with a single server installation.
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Warning: After you begin to populate the Software Library, do not move the directory or the
packages that it contains. If you move the packages, you break all the references to those
packages in existing policies. The only safe way to relocate the Software Library is through
the Symantec Management Console.

Table 2-5 Process for setting up the Software Library

DescriptionActionStep

The size and the number of the packages in your organization determine
the amount of free disk space that the Software Library requires. To
determine your disk space requirement, multiply the average size of
your packages by the number of packages that you plan to manage.

Calculate the disk space
requirement.

Step 1

Locate the directory on a shared drive that has sufficient disk space
and that is accessible from the current Symantec Management Platform
installation.

Create the Software Library
directory.

Step 2

In Windows Explorer, in the directory’s Properties dialog box, edit the
sharing settings and security settings as follows:

■ Share the directory.
■ Set the security levels on the directory.

Give full control to the application identity of Notification Server. The
application identity of Notification Server is the account that is used
to access Notification Server. You specify the appropriate user name
and password when you install Notification Server.
To prevent unauthorized changes to the packages in the Software
Library, do not give directory access to any other users.

Configure the directory’s
security settings.

Step 3

To let the Symantec Management Platform products access the
Software Library, point to the location of the library from Software
Management Framework. You can also configure the number of seconds
to wait before a server timeout occurs. You can increase the timeout
value if you encounter problems when you manage a package that
contains large files.

See “Configuring the Software Library” on page 34.

Configure the Software
Library.

Step 4

See “About the Software Library” on page 28.

Configuring the Software Library
The Software Library is a secure directory that is the centralized repository of the definitive,
authorized versions of the software that your organization manages. A package that is sourced
from the Software Library is referred to as a managed package. To let the Symantec
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Management Platform products access the Software Library, configure its location by using
Software Management Framework.

This task is part of the process for setting up the Software Library.

See “Setting up the Software Library” on page 33.

Warning: After you begin to populate the Software Library, do not move the directory or the
packages that it contains. If you move the packages, you break all the references to those
packages in existing policies. The only safe way to relocate the Software Library is through
the Symantec Management Console.

To configure the Software Library

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Software Catalog and Software Library
Settings > Software Library Configuration.

3 On the Software Library Configuration page, type the full UNC path to the shared
directory that represents the Software Library.

For example, \\computer_name\swlibrary

Note: Ensure that you configure the directory’s security settings to give full control to the
application identity of Notification Server.

When you specify custom ACC or DPC settings, both UNC share and NTFS directory
security settings must allow read access to ACC and DPC accounts.

4 Click Validate to verify that the path is valid.

5 (Optional) Change the timeout value.

The timeout value is the number of seconds to wait before a server timeout occurs when
you manage a package in the Software Library. If you encounter problems when you
manage a package that contains large files, increase this value.
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6 To save the configuration settings, click Save changes.

7 If a Software Library that contains packages already exists in a different location, in the
Managed packages exist dialog box, click one of the following options, and then click
OK:

Moves the existing packages from the old Software Library folder to the
new one. The migration also changes the packages’ source paths in any
existing policies or tasks that refer to those packages.

Migrate existing
packages

Leaves the packages in the old Software Library folder and marks them
as UNC-sourced. The conversion also changes the packages’ source
paths in any existing policies or tasks that refer to those packages. The
new source path is the UNC path of the old Software Library.

Convert existing
packages

Points packages already existing in the library to a new Software Library
path. This option implies that all packages from the previous location were
manually copied or already exist in the new Software Library path.

Change existing
packages

See “About the Software Library” on page 28.

Scheduling a Clean up File Resources task
The Clean up File Resources task lets you delete the files that remain after an internal or
third-party product deletes software from the Software Catalog. By default, the Clean up File
Resources task is scheduled to run every week. You cannot change the default task, but you
can create a new instance of the task that contains a different schedule. Each time you define
a new schedule, a new instance of the task appears.

The Clean up File Resources task runs on the Notification Server computer but not on the
client computers.

To schedule a Clean up File Resources task

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Software Catalog and Software Library
Settings > Clean up File Resources.

3 On the Clean up File Resources page, in the Task Status section, select a task and
click New Schedule.

4 In the New Schedule dialog box, define the schedule and click Schedule.

5 Close the Clean up File Resources page.
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Running a Clean up File Resources task
The Clean up File Resources task lets you delete the files that remain after an internal or
third-party product deletes software from the Software Catalog. By default, the Clean up File
Resources task is scheduled to run every week. If you edited the task schedule, additional
instances of the task might exist. You can run the default task or any of the other tasks
immediately.

See “Scheduling a Clean up File Resources task” on page 36.

You can run any Clean up File Resource tasks immediately, including those that have run and
those that are scheduled to run in the future. For example, the default task is scheduled to run
weekly but you decide to run it two days before its scheduled start date.

You can also re-run any task that is completed.

When you run any task, a new instance of that task appears on the Clean up File Resources
page. When the task finishes, a check mark appears to the left of the task name.

To run a Clean up File Resources task

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Software Catalog and Software Library
Settings > Clean up File Resources.

3 On the Clean up File Resources page, right-click a task and click Start Now.

Adding descriptions to installation error codes
You can add or edit descriptions of the numeric error codes that are returned when a software
installation on a managed computer produces an error.

Some error code descriptions are predefined. Create additional descriptions if the predefined
descriptions do not meet your needs.

When a software installation on a managed computer produces an error, the resulting reports
typically display a numeric error code. To eliminate the need to look up the error code when
you run a report, you can associate an informative description with the error code. Thereafter,
the reports display the description instead of the numeric code.

Examples of how you can use the installation error code descriptions are as follows:

■ A task that runs a Windows Installer installation fails and returns a numeric error code. The
error number is not a standard Windows Installer error. Upon investigation, you learn that
the error originates from a custom action in the MSI file. You can add that error number
and its description so that future reports display the description.

■ A proprietary type of installation EXE returns its own set of error codes. If you know the
meaning of the numeric codes, you can add their descriptions.
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Error code descriptions are predefined for Windows Installer installations. Other installation
types might also have predefined error code descriptions. If a description is not defined for a
particular error code, the numeric code appears on the reports.

Errors that appear to the end user always appear as numeric codes even if you define their
descriptions.

To add descriptions to installation error codes

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Software Catalog and Software Library
Settings > Installation Error Code Descriptions.

3 On the Installation Error Code Descriptions page, click Add or Edit.

4 In the Add or Edit Installation Error Code dialog box, add or edit the error code
information.

Because the error codes are saved as integers, the leading zeroes are dropped. For
example, if you enter 0050 the error code is saved as 50.

5 Click OK.

Defining known-as wildcards
Known-as associations let you associate the software resources that are similar but have
variations in their company names or software names. When you set up the known-as
associations, you define a wildcard for a specific known-as name. When a new software
resource is added to the Software Catalog, it is compared to the known-as wildcards. If a
wildcard match is found, the company name or the software resource name is changed to the
known-as name for that wildcard.

Create any necessary known-as associations before you begin to populate the Software
Catalog or as soon as you find duplications. New known-as associations do not affect existing
software resources.

When software resources originate from multiple sources, their company names and software
names can be inconsistent. Normally, if two software resources are identical but their identifying
information is different, they are considered to represent different software. You can create
known-as associations and wildcards to associate two software resources so that they are
identified as being the same software. The known-as associations help you to identify software
resources accurately.

You can create known-as associations for a company or a software resource as follows:
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During the import of a package, its company name is compared to the company
wildcards. If a wildcard match is found, the company name in the new software
resource is changed to the known-as company name for that wildcard.

For example, you associate the wildcard expression Symantec* with Symantec
Corporation. When you import any software resource whose company name
is Symantec, Symantec Corp., or any other variation, its company name is
changed to Symantec Corporation.

Company

During the import of a package, its name is compared to the software known-as
wildcards. If a wildcard match is found, the name of the new software resource
is changed to the software resource name for that wildcard.

For example, you might create a wildcard to replace MS Office with Microsoft
Office.

Warning: Be sure to make the wildcard restrictive enough. Otherwise, you
might associate multiple software resources that have the same name but do
not represent the same software. For example, the wildcard MS Office* changes
MS Office Standard, MS Office Professional, and Microsoft Office Enterprise
to the same name. Such associations can cause problems with the software
identification.

Software

The unique identifiers of the associated software resources are not changed even when their
company names or software names change.

The wildcard checks and associations occur when software resources are added to the Software
Catalog from the Import wizard or from the Software Discovery scan. When you create a new
known-as wildcard, existing software resources are not affected even if they match the wildcard.

When you resolve duplicate software resources, the association that is created appears in the
Known As Mappings list.

See “Resolving duplicate software resources” on page 54.

You cannot create a known-as association between software resources or company names
except through the wildcard matching. However, you can edit and delete existing known-as
associations.

See “Editing or deleting a known-as association” on page 40.

To define known-as wildcards

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Software Catalog and Software Library
Settings > Known-As.

3 On the Known-As page, in the Resource Type drop-down list, select the type of item to
define a known-as association or wildcard for.
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4 Under the Wildcards section, click Add.

5 In the Add or Edit Known-As Wildcard dialog box, enter the name to associate the
software resource with and the wildcard, and then click OK.

The wildcard must follow regular expression syntax.

Editing or deleting a known-as association
Known-as associations let you associate the software resources that are similar but have
variations in their company names or software names. You can edit or delete existing known-as
associations to correct association errors. For example, if a wildcard is too broadly defined,
the known-as associations for certain software resources can be incorrect.

To edit or delete a known-as association

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Software Catalog and Software Library
Settings > Known-As.

3 On the Known-As page, in the Resource Type list, select the type of association to edit
or delete.

4 In the Known As Mapping section, select an association and click Change Mapping.

5 In the Select Company dialog box or the Select Software dialog box, select a new name
to associate the software resource with, and then click OK.

Populating the Software Catalog
The software resources that you plan to manage must be defined in the Software Catalog.

See “About the Software Catalog” on page 25.

You can use any of several methods to add software resources to the Software Catalog. You
do not have to use all the population methods, and you do not have to use them in any particular
order.

By default, the Software Catalog contains predefined software resources for some of the agents
and plug-ins. The products that you have installed determine which agents and plug-ins appear
in the Software Catalog. You can use these software resources to roll out the agents.
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Table 2-6 Methods for populating the Software Catalog

When to useDescriptionMethod

Symantec recommends that when you have
Inventory Solution installed, that using an
Inventory policy is the preferred method. This
method also lets you identify what software
is installed on client computers.

If you have administrator rights and want to
deliver discovered software on additional
computers you can use the current
discovered software resources. You can add
an installation package and a command line
to the discovered software resource to make
it deliverable. You can then deliver the
package with Managed Delivery or Quick
Delivery or publish it to the Software Portal.

Software inventory tasks or policies scan the
target computers for the available applications
and report the collected information to the
Software Catalog.

You must have Inventory Solution installed
to use the Inventory policies.

Inventory policy

When you want to quickly create a software
resource for a package. This method is most
effective when you import a supported file
type because it creates the software
resource’s command lines.

Also use this method when you want to add
a package resource or command lines to an
existing software resource that does not have
them.

You can then deliver the package with
Managed Delivery or Quick Delivery or
publish it to the Software Portal.

Imports information from a package file to
create a new software resource or add to an
existing software resource.

The Import Software wizard simplifies the
software resource creation and the package
definition.

See “Importing a package to create a
software resource” on page 46.

Import from installation
file or package
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Table 2-6 Methods for populating the Software Catalog (continued)

When to useDescriptionMethod

When the software resource contains a
command line but not a package. For
example, a command line that uninstalls a
package that is already on the client
computer.

Also use this method when you need to
deliver a package and you want to take
advantage of the benefits of Managed
Delivery. You can quickly create a software
resource for the package with a minimum of
details as follows: the identifying information,
the reference to the package resource, and
an installation command line. You can take
the time to add more information to the
software resource after you deliver it.

Managed Delivery is available if Software
Management Solution is installed.

Symantec recommends that if you do not
have much experience with command lines
it is better to use an automated import method
instead. If you add a software resource
manually, you should test the command lines
carefully. By testing, you can avoid rolling out
badly configured command lines.

Adds the software resource and its
information manually.

See “Adding or editing a software resource”
on page 67.

Add a software resource
manually.
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Table 2-6 Methods for populating the Software Catalog (continued)

When to useDescriptionMethod

When Inventory Solution is not installed you
may use the Software Discovery to gather
information about the software that is installed
on client computers.

If you have administrator rights and want to
deliver discovered software on additional
computers you can use the current
discovered software resources. You can add
an installation package and a command line
to the discovered software resource to make
it deliverable. You can then deliver the
package with Managed Delivery or Quick
Delivery or publish it to the Software Portal.

Collects the information about the software
resources that are installed on managed
computers and the files that are associated
with the software. The software resource
information is added to the Software view
and appears in the Newly Discovered
Software list.

See “Discovering software on managed
computers” on page 48.

By default, the Software Discovery policy is
scheduled to run two times per week on all
the computers that contain the Software
Management Framework agent. However,
you can run the Software Discovery policy at
any time, on any managed computers that
contain the Software Management
Framework agent.

The scan can create the software resources
with the minimum metadata : the company
(vendor) name, software name, and version.
Then you can add the package resources
along with the other software resource
information as needed.

Software Discovery gathers only a part of the
data from Software Inventory task or policy.
For this reason, Symantec recommends that
you gather software inventory using an
Inventory policy instead.

Note: If you have Inventory Solution installed
the Software Discovery scan is disabled.

Perform a Software
Discovery scan.

43Implementing Software Management Framework
Populating the Software Catalog



Table 2-6 Methods for populating the Software Catalog (continued)

When to useDescriptionMethod

When you have a data provider that lets you
import software resources. Those responsible
for distributing software can then easily
deliver and manage these software
resources.

Imports data from a data provider to create
or update software resources in the Software
Catalog. The amount of information that the
resulting software resources contain depends
on what the data provider includes. To import
data from a data provider, you must install
the product that lets you connect to the data
provider.

Precedence settings determine if a data
provider can update the data that is in the
Software Catalog.

Import from a data
provider.

Introducing software resources
A software resource consists of the metadata that describes a specific instance of a software
application. For example, Norton Internet Security 2008 - English.

A software resource represents a common way to describe the software so that all
software-related actions can identify it accurately. The software resource data resides in the
Software Catalog. You create and manage the software resources in Software Management
Framework.

In ITIL terms, the Software Catalog represents a portion of a Configuration Management
Database (CMDB). A software resource that is defined in the Software Catalog is equivalent
to a configuration item (CI).

See “About the Software Catalog” on page 25.

Table 2-7 Metadata that describes a software resource

DescriptionMetadata

The properties that identify a software resource. The minimum amount of data that is required
to create a software resource is its company (vendor) name, software name, and version.

Properties

The software resource types are as follows:

■ Software release
■ Service pack
■ Software update

Type
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Table 2-7 Metadata that describes a software resource (continued)

DescriptionMetadata

A package resource is an association with the physical package or packages that install the
software. A package consists of the files that Software Management Solution uses to install
the software on the client computers.

Package resources

The command lines that are associated with a software resource determine what occurs
after the software resource is delivered to the client computer. For example, a command
line can install or uninstall the software.

Command lines

Detection rules and applicability rules help the software-related operations to identify software
accurately. A detection rule determines whether a specific instance of a software application
is installed on a client computer. An applicability rule determines whether a client computer
has the correct environment for an installation of the software.

Detection and
applicability rules

The associations between software resources define relationships such as dependency and
supersedence.

Associations

File resources are associations with the important physical files that the software resource
installs. File resources typically represent EXE or DLL files. The detection rules can use the
file resources to determine whether the software is installed on a client computer.

File resources

The package resource’s unique identifier provides consistency in the way that Notification
Server identifies specific software.

Unique identifier

A deliverable software resource is one that can be delivered to and installed on client computers.
To be deliverable, the software resource’s type must be software release, service pack, or
software update. Also, the software resource must be associated with a package, a command
line, or both.

You need to make software resources deliverable only if you plan to use Software Management
Solution to deliver the software.

See “Assigning a type to a software resource” on page 53.

See “Associating a package with a software resource” on page 69.

See “Creating a command line for a software resource” on page 72.

Examples of deliverable software resources are as follows:

■ A package and several command lines to run the package.

■ A Word template that is placed in a directory on the client computer but does not require
installation.

■ A command line that uninstalls a package that is already on the client computer.
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Importing a package to create a software resource
You can import information from a package to create a new software resource or add a package
association to an existing software resource.

Use the Import Software wizard when you want to quickly create a software resource for a
package. This method is most effective when you import a supported file type, because it
creates the software resource’s command lines. Also use this method when you want to add
a package resource or command lines to an existing software resource that does not have
them.

You can create a software resource for any type of installation file. By default, Software
Management supports several installation types, which means that it can collect more
information from installation files of those types.

For example, when you import an installation file, the software resource is created in the
Software Catalog. Its company (vendor) name, software name, and version are defined and
its package is added to the Software Library. When you import a supported installation file
type, the default command lines are created also.

Table 2-8 lists the installation file types that are supported for Windows operating systems.

Table 2-9 lists the installation file types that are supported for the UNIX, Linux, and Mac
operating systems.

Table 2-8 Installation file types for Windows

DescriptionInstallation file
type

A Windows batch installation file.BAT, CMD

A Windows script installation file.JS, VBS

An executable file. In this context, the EXE must be an installation file such as
Setup.exe.

EXE

A distributable installation database that Microsoft Windows Installer runs on the
destination computer.

MSI

A compressed archive file that installs Windows OS software.

This file format lets you import a whole folder with its structure.

ZIP

Table 2-9 Installation file types for UNIX, Linux, and Mac OS

DescriptionInstallation file
type

A compressed archive file that installs UNIX, Linux, or Mac OS software.BZ2
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Table 2-9 Installation file types for UNIX, Linux, and Mac OS (continued)

DescriptionInstallation file
type

A software depot for HP-UX.DEPOT

A compressed archive file that installs UNIX, Linux, or Mac OS software.GZ

A package of compressed installation files for Mac OS X. It must be archived. For
example, with TAR.GZ.

PKG

A package file that contains the software that Red Hat Package Manager (RPM)
can install. RPM is a command line driven package management system that installs
uninstalls, verifies, queries, and updates Linux software packages.

RPM

A native software installation package for AIX.RTE

A native software installation package for Sun OS.SUN PKG

A TAR file is an archive file that consists of one or more files and installs UNIX,
Linux, or Mac OS software. A TAR.BZ2, TAR.GZ, or TAR.Z file is a compression
of a TAR file.

TAR, TAR.BZ2,
TAR.GZ, TAR.Z

A UNIX compressed file.Z

A compressed archive file that installs UNIX, Linux, or Mac OS software.ZIP

A Mac OS X Disk Image file that installs Mac OS software.

When you add a DMG archive file, you can see its content and set the installation
file right from the content.

DMG

During the import, the ID of the new software resource is compared to the IDs of the existing
software resources. If the new software resource matches an existing software resource, you
can associate the new package and any related information with the existing software resource.
For example, the Software Catalog can contain a software resource that is not yet associated
with a package. Later, you can import the package and add it to the existing software resource.

A software resource might not be associated with a package for one of the following reasons:

■ A Software Discovery scan created the software resource with the software information
that it found on a client computer.

■ A data provider supplied the software resource without an associated software package.

The software resource’s unique identifier provides consistency in the way that Notification
Server identifies specific software. Software delivery, discovery, and usage actions are based
on the software identifier. As a result, you are assured that their data is associated with the
correct software resources.
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Typically, the main components of the unique identifier are the software resource’s company
(vendor) name, software name, and version. The unique identifier can also contain additional
information. For example, if the software is language-specific, the language code is included.
If the software is targeted for a specific architecture such as x86, the architecture type is
included.

Warning:When importing software packages using the Import Softwarewizard, package files
can be read by an unauthorized party during data transfer from package store to the Notification
Server computer. If package files contain sensitive information, such as passwords inside
scripts, in unencrypted form, then such software import can be a subject to information
disclosure threat.

To import a package to create a software resource

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, on the Software pane, click Add Software > Import.

3 On the Import Software: Specify Software page, select the package to import.

Note: To specify a folder with a structure, add the folder as a compressed ZIP file.

4 Click Next.

5 On the Import Software: Software Details page, review the information that was obtained
from the package that you imported and make changes if necessary.

6 (Optional) To return to the Import Software: Specify Software page and change the
option settings there, click Back.

7 Click OK.

Discovering software on managed computers
Software Discovery scans managed computers and collects information about the software
and the related files that they contain. By default, the Software Discovery policy is scheduled
to run two times per week on all the computers that contain the Software Management
Framework agent. However, you can run the Software Discovery policy at any time, on any
managed computers that contain the Software Management Framework agent.

Any client computer that has the Symantec Management Agent also has the Software
Management Framework agent because they are installed together.

Software Discovery performs a basic software discovery on targeted computers. To perform
a more detailed software inventory, you can run the Collect Full Inventory policy that is
provided with Inventory Solution.
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For more information, see topics about software inventory in the Altiris Inventory Solution™
from Symantec™ User Guide.

Note: If you have Inventory Solution installed, the Software Discovery policy is switch off by
default, because the Collect Full Inventory policy is available instead.

Perform Software Discovery scans for the following reasons:

■ To determine what software is installed on the managed computers that are in your
organization.
You can use this information to track software licenses and assets.

■ To add new software resources or update existing software resources for the installed
software.

■ To obtain information about the critical files that are installed with the software and associate
that file information with the appropriate software resource.
Use this file information in the software resource’s detection rule, which determines whether
that specific software is installed on a computer. For example, in Software Management
Solution, a Managed Delivery policy installs software only if its detection check determines
that the software is not already installed.

Table 2-10 Where Software Discovery finds information on the client computer

DescriptionSource

Software Discovery reads information in the registered MSI files for installed software.

An MSI file provides the information to create a software resource and its file associations.

Typically, the MSI files provide information about the majority of Windows software that is
installed in your organization.

Registered MSI files

Software Discovery reads the entries in Add/Remove Programs for the software’s company
(vendor) name, software name, and version. The Add/Remove Programs entries provide
information about MSI software and non-MSI software.

Add/Remove Programs
entries

When Managed Delivery and Quick Delivery install software, they record information about
the installed files in a cache on the client computer. This information is primarily useful for
non-MSI installations.

This information is available only if Software Management Solution is installed.

Inventory cache entries
from Managed Delivery
and Quick Delivery
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Table 2-10 Where Software Discovery finds information on the client computer (continued)

DescriptionSource

Software Discovery evaluates the detection rules that it finds on the client computer to
determine if the software that the rules define is installed. A detection rule ensures that
Software Discovery can detect an installed software resource that is EXE-based and add it
to the Discovered Unreviewed Software

The detection rules are placed on the client computer during the following processes:

■ When Managed Delivery installs a software resource.
Managed Delivery stores information about the software in a cache on the client computer.
Software Discovery collects the information from the cache.
This information is available only if Software Management Solution is installed.

■ When a Targeted Software Inventory policy runs for a specific software resource.
This information is available only if Inventory Solution is installed.

Detection rules that are
on the client computer
for specific software
resources

Table 2-11 Process for discovering software resources on managed computers

DescriptionActionStep

The Software Discovery policy runs the scan on the client computers.
You cannot create multiple instances of the policy with different
schedules and destinations. Instead, you reconfigure the schedule and
destinations when you run the policy.

See “Configuring the Software Discovery policy” on page 51.

Configure the Software
Discovery policy.

Step 1

The options for reviewing the inventory data are as follows:

■ View the contents of the Discovered Unreviewed Software list in
the Software view.
This folder displays the software resources that are marked as
installed, including those from previous Software Discovery scans.

■ If Inventory Solution is installed, run the Installed Software report.
This report lists the software resources that are marked as installed.
It also lists the computers on which the software is installed and the
installation dates. You can access the Installed Software report from
the Reports menu or from the right-click menu in the Software
Catalog.

Review the inventory data
that is returned.

Step 2
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Table 2-11 Process for discovering software resources on managed computers (continued)

DescriptionActionStep

The data that Software Discovery provides can make future inventory
scans more accurate.

Update the software resources in the following ways:

■ Resolve duplicate software resources.
Duplicate software resources can occur when Software Discovery
creates a new software resource for the software that is already
defined in the Software Catalog. Perhaps the company name in
each resource is slightly different.
See “Resolving duplicate software resources” on page 54.

■ Add the file resources to the software resource’s detection rule.
Software Discovery can add the file resources to a software resource
but it does not add those files to a detection rule. You can use those
file resources to create a detection rule or to update an existing
detection rule.
See “Adding file resources to a software resource manually”
on page 78.

Update the software
resources to facilitate future
inventory scans.

Step 3

To be deliverable, a software resource must be assigned a type and it
must be associated with a package, a command line, or both.

Make the software resources deliverable in the following ways:

■ Assign a type of software release, service pack, or software update
to the software resource.
See “Assigning a type to a software resource” on page 53.

■ Associate a package with a new software resource.
Software Discovery does not associate packages with the software
resources. If you have the package file, you can associate it with
the new software resource.
See “Associating a package with a software resource” on page 69.

■ Add a command line to the software resource.
See “Creating a command line for a software resource” on page 72.

Update the software
resources to make them
deliverable.

This step applies only if you
plan to use Software
Management Solution to
deliver the software.

Step 4

Configuring the Software Discovery policy
The Software Discovery policy scans managed computers and collects information about the
software and the related files that they contain. The Software Discovery scan is a step in the
process for discovering software resources on managed computers.

See “Discovering software on managed computers” on page 48.

The Software Discovery scan performs several tasks to collect information about the software
that is installed on client computers.
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Table 2-12 Tasks that Software Discovery performs

DescriptionTask

Software Discovery evaluates several sources of inventory information on the client computer.Scans the client
computer.

For each instance of software that it finds, Software Discovery collects the following data:

■ The software’s unique identifier, which consists of the company (vendor) name, software
name, and version.

■ The MSI product code, for Windows Installer-based applications only.
■ The unique identifiers of the critical files that are installed with the software. Only EXE

files, DLL files, and OCX files are considered to be critical.
The unique identifier consists of the file’s name, hash value, and size. The file information
is collected only for MSI-based software and any software that was originally installed
with a Managed Delivery policy.

■ The GUID that identifies the computer resource in Notification Server.
■ The GUID that identifies the user resource in Notification Server, if the software was

installed per user.

Collects the software
data.

Software Discovery updates a cache on the client computer with the data that it collects.

Inventory Solution reads the cache when an inventory task scans a client computer. The
Software Discovery data makes future inventory scans more accurate because it provides
a way to positively identify a specific instance of software.

Records the collected
data in a cache on the
client computer.

You can configure Software Discovery to send all software resources or only software
resources that changed since the last time the software inventory was collected. These
configuration options are in the Settings section of the Software Discovery policy.

Sends the data to the
server.

For each instance of software that it finds, Software Discovery updates the Software Catalog
as follows:

■ Creates a new software resource or updates an existing one, depending on whether the
found software’s identifier matches that of an existing software resource. Only the
metadata is created. Packages are not defined.

■ Associates the collected file resources with the software resource.

Updates the Software
Catalog with the
software resources and
their associated file
resources.

You can configure this policy to send all software resources or only software resources that
changed since the last time the software inventory was collected. By default, the Software
Discovery policy is scheduled to run two times per week on all the computers that contain the
Software Management Framework agent. However, you can run the Software Discovery policy
at any time, on any managed computers that contain the Software Management Framework
agent.

We recommend that you schedule the Software Discovery policy to run during a maintenance
window because the policy is processor intensive.
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To configure the Software Discovery policy

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Software Catalog and Software Library
Settings > Software Discovery.

3 On the Software Discovery page, in the Settings section, select whether to send only
the software resources that have changed or all software resources.

The option to send only the software resources that changed is selected by default. Select
the option to send all the software resources if some of the data that was previously sent
to the server has been lost. For example, sometimes when the management of a client
computer moves from one Notification Server to another, the new server does not have
this data.

4 In the Applied to section, select the destination resources to which to apply the policy.

5 In the Schedule section, set the schedule.

6 At the upper right of the page, click the colored circle, and then click On.

7 Click Save changes.

Assigning a type to a software resource
An unassigned software resource is one that is not categorized as a software release, an
update, or a service pack.

An unassigned software resource is one that is not categorized as a software release, an
update, or a service pack. Most of the unassigned software resources originate from the
Software Discovery scans. The unassigned software resources can also originate from other
internal products or third-party products that add software resources without specifying their
types.

Warning: After you set the software resource type you cannot change it.

To assign a type to a software resource

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, click Favorites > Discovered Unreviewed Software.

3 In the center pane, right-click a software resource and on the context menu, click Actions
> Assign Type.

4 In the Assign Software Type dialog box, select the type to assign, and then click OK.

The software resource types are as follows:
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■ Software release
A full version of the software. Installation of a software release results in a complete,
operational instance of the software.

■ Service Pack
A collection or roll up of the updates and fixes that bring a software release to a known
state. A service pack does not represent a complete instance of the software. It must
be installed on a computer that already contains the software release.

■ Software Update
A small number of changes that improve or fix a software release. A software update
does not represent a complete instance of the software. It must be installed on a
computer that already contains the software release.

Resolving duplicate software resources
Duplicate software resources occur when two software resources represent the same software
but have different identifiers. When you resolve duplicate software resources, both of their
unique identifiers are associated with one software resource and the other software resource
is deleted. If the duplicate software resource contains any information that is not in the original
one, you can merge the data before the duplicate is deleted.

Each software resource in the Software Catalog has a unique identifier. Two software resources
can represent the same software but have different identifiers. Such duplicate software
resources can occur when the same software is added to the Software Catalog by different
methods. For example, you import a package to create a software resource for Adobe Reader
9 from Adobe. Then a Software Discovery finds an incidence of Adobe Reader 9 from Adobe
Systems on a client computer. You know that the two software resources are the same but
because they have different company names, they have different identifiers.

Review the Software Catalog periodically to look for duplicate software resources. Look for
the software resources that have identical or similar names or company names. For example,
Microsoft Office 2008 professional and Office 2008 Professional. When you find duplicates,
you can resolve the duplication.

To resolve duplicate software resources

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, click Favorites > Discovered Unreviewed Software, right-click the
software resource that is a duplicate of another one and clickActions > Resolve Duplicate
Software Resources.

3 In the Resolve Duplicate Software Resources dialog box, specify how to resolve the
duplication, select the software resources to merge or associate, and click OK.
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4 If you selected the option to merge the software resources, complete the series of Merge
Software Resources pages that appear. Click Next to advance to each page.

These pages let you define the information that is copied from the duplicate software
resource to the original one.

5 When you complete the Merge Software Resources pages, click Merge Software.

You can complete the merge process at any point as you step through the pages. For
example, if you want to merge the packages only, you can complete the merge process
after you complete the Packages to include page.

Creating a filter for installed software
You can create a filter that finds managed computers by the software that is installed on them.
For example, you can create a filter for all the computers that contain Norton AntiVirus 2011.

A resource filter is a set of resources that are grouped according to some specific criteria. In
Notification Server, you can create a filter for any type of resource so that you can isolate
certain resources into narrow groups. You can use the filters to select the resources to act
upon throughout Notification Server.

A filter can include any software that supersedes the main software resource or that the main
software resource supersedes. For example, Norton AntiVirus 2008 supersedes both Norton
AntiVirus 2006 and Norton AntiVirus 2007. You can create a filter that finds all the computers
that have any one of the three versions.

You can view the installed software filters in the Software Filters folder, which is under the
Filters view in the Symantec Management Console. You can access the Filters view from
the Manage menu.

When you create a filter in Notification Server, you specify the filter definition with a SQL query.
When you create a filter for installed software from the Software view, the SQL query is created
for you. We recommend that you do not edit the SQL in the installed software filters. If you
need to change an installed software filter, it is best to delete it and then recreate it from the
Software Catalog.

You can view the installed software filters in the Software Filters folder, which is under the
Filters view in the Symantec Management Console. You can access the Filters view from
the Manage menu.

To create a filter for installed software

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, expand Favorites, and then click Discovered Unreviewed Software.

3 In the center pane, select the software, and on the right-click menu, clickActions > Create
Installed Software Filter.
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4 On theCreate Installed Software Filter dialog box, define the filter, select any superseding
or superseded software, and add software resources if necessary.

The Name field identifies this filter. When you create a filter from a software resource in
the Software Catalog, the software resource’s name is inserted into a default filter name.
Make the name descriptive enough for others to easily identify this filter. Change this
name if it does not follow your organization’s standards for naming filters.

The Description field lets you type a description to further identify this filter and make it
more recognizable. Do not include critical information in the description because it is not
intended to appear in all the lists that contain the name.

Click Add to add software resources to the filter. For example, three different FTP clients
are installed throughout your organization and you want to standardize on one specific
FTP client. You can create a filter that finds any of the three existing FTP client applications.

The software list shows the selected software resource and any software resources with
which it has a supersedence association. You can choose to include any superseding
software or superseded software in the filter.

5 Click OK.
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Implementing Software
Management Solution

This chapter includes the following topics:

■ Implementing Software Management Solution

■ Installing or upgrading the Software Management Solution plug-in

■ Configuring the Software Portal Client Access Policy

■ Configuring security privileges for Software Management Solution

■ Configuring the default settings for Managed Software Delivery

Implementing Software Management Solution
Before you use Software Management Solution, you must set it up and prepare it for use.

See “About Software Management Solution” on page 11.

The prerequisites for implementing Software Management Solution are as follows:

■ Symantec Management Platform and Software Management Solution must be installed
on the Notification Server computer.
The Symantec Installation Manager (SIM) handles the installation and initial configuration
of the Symantec Management Platform. SIM lets you install, upgrade, and uninstall Software
Management Solution.

■ The Symantec Management Agent must be installed or upgraded on Windows, UNIX,
Linux, and Mac computers that you plan to manage.
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Table 3-1 Process for implementing Software Management Solution

DescriptionActionStep

The Software Management Solution plug-in is required for you to
deliver and manage software on client computers.

Perform this step every time that you need to install or upgrade
the Software Management Solution plug-in on the client computers
that do not have it.

The unifiedSoftwareManagement Solution Plug-in Install policy
lets you install the solution plug-in on all supported operating
systems.

See “Installing or upgrading the Software Management Solution
plug-in” on page 58.

You may have performed this step when you installed the
Symantec Management Platform or when you added new
computers to the network.

Install or upgrade the Software
Management Solution plug-in on
managed computers.

Step 1

Administrators need the appropriate privileges to deliver and
manage the software in your organization.

You or another administrator may have already performed this
step when you configured security for the Symantec Management
Platform.

Configure security privileges for
Software Management Solution.

Step 2

You can configure the settings that control the behavior of
Managed Software Delivery policies. Rather than configuring these
settings individually for each policy, you can configure the default
settings that apply to all new Managed Software Delivery policies.

See “Configuring the default settings for Managed Software
Delivery” on page 63.

Configure default settings for
Managed Software Delivery.

Step 3

The Software Portal is installed on the Notification Server computer
when Software Management Solution is installed. If you plan to
use the Software Portal, you must perform additional
implementation steps.

See “Implementing the Software Portal” on page 157.

(Optional) Implement the Software
Portal.

Step 4

Installing or upgrading the Software Management
Solution plug-in

Before you can deliver or manage software on client computers with Software Management
Solution, you must install the Software Management Solution plug-in on those computers.
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If you upgraded from a 7.x version of Software Management Solution, you must upgrade the
Software Management Solution plug-in that is installed on the managed computers.

You install the Software Management Solution plug-in to Windows and non-Windows computers
using the Software Management Solution Plug-in Install policy.

This task is a step in the process for implementing Software Management Solution.

See “Implementing Software Management Solution” on page 57.

To install or upgrade the Software Management Solution plug-in

1 In the Symantec Management Console, on the Settings menu, click Agents/Plug-ins >
All Agents/Plug-ins.

2 In the left pane, under Agents/Plug-ins, expand Software > Software Management,
and then click one of the following policies:

■ Software Management Solution Plug-in Install
Click if it is a new installation of the product.

■ Software Management Solution Plug-in Upgrade
Click if you upgraded from the 7.x version of the product.

3 In the right pane, check or uncheck Enable Verbose Reporting of Status Events
according to your needs.

This option records the detailed events that are related to the installation and posts them
to the Notification Server computer.

4 Under Applied to, on the toolbar, click Apply to, and then choose where to install the
agent.

5 Under Schedule, next to Run, select the method to run the policy as follows:

■ To run the policy once and as soon as possible, click Once ASAP.

■ To run the policy once while maintenance window is open, click Once at next
maintenance window.

■ To schedule the policy, click By schedule, on the toolbar, click Add schedule, and
then configure the schedule for the policy.

Note that if you turn off and then turn on the policy, it cannot run on the same computer
again. To run a policy on the same computer again, you must configure it to run on a
schedule.
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6 (Optional) Under Extra schedule options, configure following options:

Allows the user on the client computer to run the policy manually.User can run

Displays a message to notify the user that new software is available. When
the user clicks the message, theNewSoftware is Available dialog box opens.
The user can start, dismiss, or defer the policy. If you do not choose to prompt
the user, the New Software is Available dialog box does not appear.

The New Software is Available dialog box appears only if Show popup
notifications is checked.

This option does not apply to UNIX and Linux.

Notify user when
the task is
available

Displays the Starting Task dialog box to notifiy the user before the policy
runs.

Unless you let the user defer the policy, the policy starts 60 seconds after the
Starting Task dialog box appears. A progress bar shows the amount of time
that remains. The user can dismiss the Starting Task dialog box but cannot
cancel the policy unless you checked User can run.

The Starting Task dialog box appears only if the Show popup notifications
is checked in the client computer’s Symantec Management Agent settings.

This option does not apply to UNIX or Linux.

Warn before
running

7 Turn on the policy.

At the upper right of the page, click the colored circle and then click On.

8 Click Save changes.

Configuring the Software Portal Client Access Policy
The Software Portal Client Access Policy lets you configure how end users access the
Software Portal from the client computers.

The Software Management Solution plug-in supports the Software Portal on Windows and
Mac client computers in the following way:

■ Provides the access to the Software Portal web application from client computers.

■ Configures the URL for the users to access the Software Portal.

■ Installs the Software Portal shortcuts on the client computers.
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Note: (Mac only)

If the Symantec Management Agent user interface (agent UI) is open on the client computer
when the computer receives the enabled Software Portal Client Access Policy, the Software
Portal shortcut does not appear. To prevent this issue and make the Software Portal shortcut
available to the user, refresh the agent UI on the client computer after the policy is received.

This task is a step in the process for implementing the Software Portal.

See “Implementing the Software Portal” on page 157.

To configure the Software Portal Client Access Policy

1 In the Symantec Management Console, on the Actions menu, click Agents/Plug-ins >
Rollout Agents/Plug-ins.

2 In the left pane, expand Software > Software Management, and then click Software
Portal Client Access Policy.

3 On the Software Portal Client Access Policy page, under Windows Settings and Mac
Settings, specify where to place the Software Portal shortcut on client computers.

Note:When you select the optionShow the link to the Software Portal in the Symantec
Management Agent context menu, the user right-clicks the Symantec Management
Agent icon in the notification area on the client computer, and then accesses the Software
Portal.

4 Under Applied to, specify the targets of the policy.

5 Click Save changes.

Configuring security privileges for Software
Management Solution

As part of the Software Management Solution implementation, you configure security privileges
for the users who need to deliver and manage software on client computers.

See “Implementing Software Management Solution” on page 57.

We provide security recommendations for two levels of software administrators and one level
of non-administrators. You can adapt these recommendations to the size of your software
management team.
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Table 3-2 Recommended security privileges for Software Management Solution

Recommended privilegesType of user

Senior administrators are responsible for the more critical software management tasks, such
as performing complex deliveries. They might also manage the Software Catalog and the
Software Library, which means that they can create and manage your organization’s software
resources and packages.

Senior software administrators need the Right Click Menu - Actions privileges that are
specific to Software Management Solution as follows:

■ Configure Managed Delivery Options
■ Managed Software Delivery
■ Quick Delivery Task
■ Source Path Update

Senior administrators might need to create and edit software resources, even if they are not
responsible for managing the Software Catalog or the Software Library. Therefore, they
need some of the Software Management Framework-related Right Click Menu - Actions
privileges. Examples are as follows:

■ Edit Command Line
■ Edit Software Resource
■ Edit Package
■ Import Package

Senior software administrators need the Software Portal Privileges.

Senior software
administrators

Software administrators perform the majority of the software delivery tasks in your
organization.

Software administrators need the Right Click Menu - Actions privileges that are specific
to Software Management Solution as follows:

■ (Optional) Configure Managed Delivery Options
You might provide this privilege depending on the administrator’s level.

■ Managed Software Delivery
■ Quick Delivery Task
■ Source Path Update

Software administrators need some of the Software Portal Privileges.

Software administrators
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Table 3-2 Recommended security privileges for Software Management Solution (continued)

Recommended privilegesType of user

You might let non-administrators perform single, routine software deliveries so you can free
your software administrators to focus on more complex delivery tasks. For example, help
desk employees can deliver a software update without escalating the requirement to the
administrators.

The Right Click Menu - Actions privileges for non-administrators are as follows:

■ Managed Software Delivery
Typically, these employees do not need to create Managed Software Delivery policies,
but you might decide to let them run the policies to deliver software.

■ Quick Delivery Task

Non-administrators who
can deliver software

To configure security privileges for Software Management Solution

1 In the Symantec Management Console, on the Settings menu, click Security > Account
Management.

2 In the left pane, click Account Management > Roles.

3 On the Roles page, in the left pane, click the security role that you want to configure.

4 In the right pane, on the Privileges tab, select the privileges that you want to assign the
role.

To select a privilege, check the corresponding check box.

Most users require other privileges in addition to the Software Management-related
privileges. For example, to run a Quick Delivery task, a user must have right-click menu
privileges for Quick Delivery and for scheduling a task.

Configuring the default settings for Managed
Software Delivery

Configuration settings control the behavior of new Managed Software Delivery policies. Rather
than configuring these settings individually for each policy, you can configure the default
settings that apply to all new Managed Software Delivery policies. Then you can change the
settings for a specific policy only when needed.

The default settings speed up the creation of Managed Software Delivery policies and promote
consistency among them.

You can override the default settings for Managed Software Delivery as follows:

■ When you create a Managed Software Delivery policy manually
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■ When you edit an existing Managed Software Delivery policy

Changing the default settings does not change the settings in the Managed Software Delivery
policies that were created earlier.

Software Management Solution settings control the behavior of the software-related policies
and tasks. The default settings let administrators create policies and tasks without having to
enter the details that they are not familiar with. Instead, a more experienced administrator can
configure the default settings that apply to all the new policies and tasks that are created.
When necessary, the administrator who runs the specific policies and tasks can change the
settings.

Table 3-3 Sources of default settings for Software Management policies and tasks

Source of default settingsPolicy or task

All new managed software delivery policies inherit the default settings
that are defined on the Managed Delivery Settings page. You can
override the default settings for specific Managed Software Delivery
policies.

Changing the default managed software delivery settings does not affect
the execution of the managed software delivery policies that were created
earlier.

Managed Software Delivery

Some of the task settings are predefined. Other settings for these tasks
are obtained from the Task Management settings or the Symantec
Management Agent settings. You can override the settings for specific
tasks.

Package Delivery

Quick Delivery

Source Path Update

Windows Installer Repair

To configure default settings for Managed Software Delivery

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, expand Software, and then click Managed Delivery Settings.

3 On the Managed Delivery Settings page, configure the settings on the following tabs:

Lets you define the schedule on which a Managed Software Delivery
policy runs.

Schedule

Lets you define how a Managed Software Delivery policy’s downloads
are handled.

Download

Lets you define how a Managed Software Delivery policy runs on the
client computer.

Run
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4 Click Save changes.
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Managing software and
applications on client
computers

■ Chapter 4. Working with software resources

■ Chapter 5. Importing data from a data provider

■ Chapter 6. Managing Windows Installer applications
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Working with software
resources

This chapter includes the following topics:

■ Adding or editing a software resource

■ Deleting a software resource

■ Associating a package with a software resource

■ Adding an existing package to the Software Library

■ Creating a command line for a software resource

■ Creating or editing inventory rules

■ Adding associations to a software resource

■ Adding file resources to a software resource manually

■ Exporting and importing a software resource and its details

Adding or editing a software resource
You can add a software resource to the Software Catalog manually or you can edit an existing
software resource.

You are most likely to add a software resource manually when you need to act on the software
resource quickly. For example, to deliver software immediately.

Warning: When you change an existing software resource, the change affects all the policies
and tasks that use that software resource.
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To add or edit a software resource

1 In the Symantec Management Console, on the Manage menu, click Software.

2 To add a software resource, in the left pane, click Add Software, and then click one of
the following drop-down menu options that corresponds to the type of the resource that
you want to add.

■ Create Product

■ Create Release

■ Create Service Pack

■ Create Update

Warning: After you set the software resource type you cannot change it.

3 To edit a software resource, do one of the following:

■ To edit an existing software resource that is undefined, click Software Catalog >
Undefined Software, and then double-click the software resource.

■ To edit an existing software resource that is defined, click All Software > All Software
Components, and then double-click the software resource.

4 On the software resource page, complete the tabs or edit the metadata on the tabs.

The information on the Properties tab and the Package tab is required. The information
on the remaining tabs is optional.

5 Click OK.

Deleting a software resource
You can only delete a software resource from the Software Catalog if it does not have a
reference. A reference is an association between the software resource and another item in
the Symantec Management Platform. For example, references are created for the policies and
tasks that contain the software resource.

See “Adding or editing a software resource” on page 67.

When you try to delete a software resource that has references, a message appears that lets
you view the Item References page. This page lists all the references to the software resource.
Before you can delete a software resource, you must delete all its references.

You can delete the references of a software resource in the following ways:

■ Delete the referenced item.
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For example, if the software resource references a Quick Delivery task, then delete that
task.

■ Delete the reference from the Item References page.

To delete a software resource

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the Software Catalog window, click All Software > All Software Components,
right-click a software resource, and then click Delete.

3 In the Delete dialog box, click Yes.

If another item does not reference the software resource, it is deleted.

4 If one or more items reference the software resource, in the Delete Item dialog box, click
Click here to display a reference dependency report for the selected item.

5 On the Item References page, select the referenced items, and on the right-click menu,
click Delete.

The [Used By] Name column shows the items that are referenced.

Warning:A referenced item is deleted even if it is referenced by other software resources.
For example, if a referenced item is a Managed Software Delivery policy that includes
other software resources, the policy is deleted. If you do not want to delete the policy,
delete the software resource from the policy.

6 In the Delete Item dialog box, click OK.

The selected items are deleted from the console. The items remain on the ItemReferences
page until you click Refresh.

7 Close the Item References page and in the Delete Item dialog box, click Retry delete.

Associating a package with a software resource
You can associate a package with a software resource manually in the following situations:

■ When you create the software resource manually

■ When the software resource was added as a result of a Software Discovery scan
The Software Discovery scan cannot associate a package with a software resource.

■ When the software resource has multiple packages
For example, you create a software resource that is associated with the package for
Microsoft Office. You also have a repackaged version of the Microsoft Office package.
Associate the repackaged version with the same software resource as the original version.
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With this exception and few other exceptions, it is best to associate only one package with
a software resource. Otherwise, it is more difficult to manage the software that each package
installs.

■ When the software resource was imported from a data provider without an associated
software package.

A software package is a folder that contains one or more files that you deliver to a managed
computer.

A package can be any of the following items:

■ An installation executable, such as an MSI or EXE.

■ A utility script or other program.

■ A non-executable file, such as a Microsoft Word template.

■ Any additional files that should be installed with the package file. For example, a package
can consist of a Microsoft Word installation file along with corporate-standard template
files.

Packages are associated with software resources. When a software resource is delivered to
a client computer, its package is downloaded to the client computer. If the package contains
an executable file, the command line that is associated with the software resource determines
how the package is executed.

Generally, it is best to associate only one package with a software resource. Otherwise, it is
more difficult to manage the software that each package installs. For example, you might be
tempted to create a single software resource and add two packages for two different versions
of an application. However, then you cannot install, associate, upgrade, or inventory each
version separately.

When you associate a package with a software resource, you define the package’s source.
Notification Server manages the package from this source. For example, the package is
distributed to package servers from the source that you define.

If you select the Software Library as the source, the package files are placed in a new folder
within the Software Library. By sourcing the package from the Software Library, you secure
the package and ensure that the correct version is always used. If you do not source the
package from the Software Library, the package is considered to be unmanaged.

See “About the Software Library” on page 28.

When you define a package, you also can configure if and how the package is made available
to the package servers in your environment. Package servers reduce the load on Notification
Server and the network by distributing packages to multiple locations for download.

When you associate a package with a software resource, you can also create command lines
for that package.

See “Creating a command line for a software resource” on page 72.
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To associate a package with a software resource

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, click All Software > All Software Components, and then double-click
the software resource.

3 On the software resource page, click the Package tab.

4 On the Package tab, click Add package.

5 In theAdd or Edit Package dialog box, enter the package details and assign the package
to package servers.

Note: To specify a folder with a structure, add the folder as a compressed ZIP file.

When you add the ZIP file, you need to decide whether to extract the archived content.
If you choose to extract the content, you can edit it according to your needs and create
subfolders after extracting. If you choose to add the content without extracting, you can
only view the content.

6 On the software resource page, click OK.

Adding an existing package to the Software Library
You can change a package’s source to the Software Library from a different source. By sourcing
the package from the Software Library, you secure the package and ensure that the correct
version is always used. After you change the source to the Software Library, you cannot change
it again.

This action copies the package file to the Software Library folder. Thereafter, any policies or
tasks that act on that package obtain it from the Software Library.

See “About the Software Library” on page 28.

To add an existing package to the Software Library

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, click All Software > All Software Components, and then double-click
the software resource.

3 On the software resource page, click the Package tab.

4 On thePackage tab, in thePackages section, right-click a package, and then clickActions
> Import package.

Note: Ensure that you have the Software Library as the selected package source.
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5 In the Import Package dialog box, click OK.

Warning: The package source changes as soon as you perform this step, even if you do
not save the changes for the software resource.

6 On the software resource page, click Save changes.

Creating a command line for a software resource
A command line determines how software is installed or uninstalled on the client computer. A
command line that is associated with a software resource can run a package or run without a
specific package. For example, a command line that is not associated with a package might
run a batch file or repair an application.

The types of actions that a command line can perform depend on the type of installation that
the package represents. They also depend on the platform that the package is installed on.
For example, a command line for an MSI package can advertise the delivered software but a
command line for an RPM package cannot. The most common command-line actions are
installation and uninstallation.

A software resource can contain multiple command lines to perform different actions.

For example, a software resource that has an MSI package might have multiple command
lines that perform the following actions:

■ Install the package silently.

■ Uninstall the package.

■ Apply a transform to the package.

■ Repair the package.

■ Install the package silently except for a progress bar.

By predefining the command lines for a software resource, you automate the software
management actions and reduce the risk of user errors. For example, a user who needs to
quickly deliver a software resource can select the software resource and the action to perform.
For example, an installation or a repair. The user does not need to create a command line or
even know the command-line syntax for the software package.

In a software delivery environment, you typically limit or hide the installation user interface.

For best results when you use command lines for software management, build the command
lines according to the following guidelines:

■ A command line should never run in a way that requires user interaction.
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For example, it should not prompt for installation configuration or display any messages
that require the user to click any option or other control.

■ A command line should contain sufficient input data so that it can run without input from
the end user.

■ Consider whether the command line requires the software package and set the package
option on the command line accordingly.
For example, Windows Installer applications can be uninstalled or repaired without requiring
the package. Instead, you can use the product code GUID value in the command line. By
not needlessly delivering the software package you save network bandwidth during the
software delivery.

You can create a command line that runs a package or that runs without a specific package.

When you import a supported installation file type into the Software Catalog, default command
lines are created automatically. When you import a non-supported installation file, or when
you add a software resource in any other way, you must create the command lines.

To create a command line for a software resource

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the Software Catalog window, do one of the following:

■ For an undefined software resource, click Software Catalog > Undefined Software,
and then double-click the software resource.

■ For a defined software resource, click All Software > All Software Components,
and then double-click the software resource.

3 On the software resource page, click the Package tab.

4 On the Package tab, add or edit the command line as follows:

■ To add a command line to the software resource, click Add command.

■ To edit an existing command line, select it in the Command Lines list and click Edit.

5 In the Add or Edit Command Line dialog box, define the command line and click OK.

For example, you use the Application Management agent command-line options to create
the command line that runs the agent according to your specifications.

Creating or editing inventory rules
Inventory rules evaluate the software that is installed on a client computer and the client
computer’s environment.

You can use inventory rules as follows:

■ To determine whether specific software is installed on a client computer.
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These rules are called detection rules.

■ To determine whether a client computer has the correct environment for an installation of
the software.
These rules are called applicability rules.

Rules are associated with software resources. A rule is not used in any way if it is not associated
with a software resource. However, if you delete a software resource, any rules that you created
and associated with that software resource are not deleted. The rules remain in the database.
All rules are listed in the drop-down list on the software resource Rules tab so that you can
associate them with another software resource.

If a rule is associated with a software resource, it appears on the Rules tab for that software
resource.

Inventory rules can be created or added in the following ways:

■ When you associate rules with a software resource, you can create or edit the rules.

■ When you import a software package to create a software resource, the import process
creates a detection rule that checks if a specific software is installed on a computer.

■ Other internal products or third-party products can be programmed to create and use rules.

Inventory rules are made up of expressions, which define the items that the rule should evaluate.
Inventory rules can contain one or more expressions.

You can create the following types of rules:

Many smart rules update dynamically based on what is selected in the
expressions that make up the rule. Smart rules can contain smart or
standard expressions.

Smart rules

Standard rules are static. Standard rules can contain only standard
expressions.

Standard rules

The Inventory Rule Management agent runs the inventory rules on client computers. The
Inventory Rule Management agent is installed on the client computer and runs as a Web
service on the Notification Server computer.

You can create new inventory rules for a software resource or edit its existing rules. A software
resource can be associated with a detection rule and an applicability rule.

Inventory rules evaluate the software that is installed on a client computer and the client
computer’s environment. You can associate a software resource with the following types of
inventory rules:
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Determine if specific software is installed on a client computer. A detection
rule ensures that Software Discovery can detect an installed software resource
that is EXE based and add it to the Discovered Unreviewed Software list. A
detection rule must also be associated with an EXE based software resource
for a compliance check in a Managed Software Delivery to report success.

A detection rule can look for information such as the file associations, MSI
product code, shortcuts, and registry entries.

For example, when you define a software resource, you can associate it with
one or more files that represent it. A detection rule looks for the presence of
those files on the client computer. If it finds those files, then it assumes that
the software resource is installed.

Detection rules

Determine whether a client computer has the correct environment for an
installation of the software.

An applicability rule can look for information such as the operating system,
processor type, Windows language, and registry entries.

For example, if the software requires a specific operating system, the
applicability rule checks the client computer for the presence of that operating
system.

Applicability rules

The detection rules and the applicability rules help the software-related operations to identify
software resources accurately.

Examples are as follows:

■ In Software Management Solution, a Managed Delivery policy uses an applicability rule to
determine whether the software can be installed on the client computer. If the client computer
has the correct environment, the Managed Delivery policy uses a detection rule to determine
whether the software is already installed. If the software is not installed, then the policy
installs it. The use of the detection rule prevents you from reinstalling the software on the
computers that already have that software.

■ In Inventory Solution, the Targeted Software Inventory policy uses a detection rule to
determine whether a specific software resource is installed on client computers. The policy
then reports the computers that contain the software.

Some rules, such as those that Software Management Solution uses, can be predefined.
Otherwise, you create the rules that you need for each software resource. Other internal
products or third-party products can be programmed to create and use detection and applicability
rules.

Best practices for creating rules are as follows:

■ In general, detection rules should be specific enough to identify a given version of a software
resource from other versions. However, the rules should not be so specific that the detection
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fails. For example, when you create file expressions, do not use a specific file version.
Instead, specify a range of versions.

■ Try to set up rules so that they find file paths by extracting them from the registry instead
of by looking in a static path. You can set up rules this way by using the Registry Key/File
Path to File Version expression type. That expression type reads the file path from the
registry and compares it against a version range.

To create or edit an inventory rule

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, do one of the following:

■ For an underfined software resource, click Software Catalog > Undefined Software,
and then double-click the software resource.

■ For a defined software resource, click All Software > All Software Components,
and then double-click the software resource.

3 On the software resource page, click the Rules tab.

4 To access the dialog box where you can edit existing rules or add a new rule, perform
one of the following actions:

■ To edit an existing rule, next to the detection or applicability drop-down list, click the
Edit detection rule symbol or the Edit applicability rule symbol.

■ To add a new rule, next to the detection or applicability drop-down list, click the Add
a new detection rule symbol or the Add a new applicability rule symbol.

5 In the Create rule dialog box or Edit rule dialog box, in the Name box, type a name to
describe the rule.

Skip this step when you edit an existing rule.
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6 To edit an existing rule expression, select the rule expression in the left pane and edit it
in the right pane.

Note:TheAnd,Not,Or operators apply to the rules, which reside under the corresponding
operator in the expression tree in the left pane. The rule does not work, if the operator
and the rules, to which it must apply, are on the same level in the expression tree. Please
see the example of correct usage of the Or operator below:

7 To add an operator, on the toolbar, click the Add a new rule expression symbol, click
Operators, and then select an operator.

The Add a new rule expression symbol is only enabled if an operator is selected in the
left pane.

8 To create a new rule expression, on the toolbar, click the Add a new rule expression
symbol, click one of the following options, and then select the expression:

■ Standard Rule
Standard rules are static and can only contain standard rule expressions. You can
add standard rule expressions to smart rules, but you cannot create new standard
rules.

■ Smart Rule
Some smart rules are dynamic and all smart rules can contain smart and standard
rule expressions.

9 Complete the fields that are necessary to add the expression.

10 Click OK.

11 Continue to add expressions until the rule is complete.

12 On the software resource page, click Save Changes.
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Adding associations to a software resource
You can define associations between software resources in the Software Catalog. These
associations add logic to software-related tasks. For example, in Software Management
Solution, you can create a policy that delivers a software resource and all the software that it
depends on.

When new software resources are created, review them for possible associations with existing
software resources. For example, when you introduce a new version of antivirus software,
create a supersedence association with the earlier version of that software.

To add associations to a software resource

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, do one of the following:

■ To add a new software resource, in the Software pane, click Add Software, and then
click the drop-down menu option that corresponds to the type of the resource that you
want to add.

■ To edit an existing software resource that is undefined, click Software Catalog >
Undefined Software, and then double-click the software resource.

■ To edit an existing software resource that is defined, click All Software > All Software
Components, and then double-click the software resource.

3 On the software resource page, click the Associations tab.

4 On the Associations tab, in Association Type, select the type of association to create.

For example, you can simplify software management in a heterogeneous environment
by categorizing software by operating system.

5 In the sections that appear on this tab, click Add to associate software resources with the
current one.

The sections that appear on this tab depend on the type of association that you selected.

6 In the Select Software dialog box, specify the software resources to add to this association
and click OK.

Adding file resources to a software resourcemanually
You can associate a file resource with a software resource. A file resource is a representation
of an important file that the specific software installs. Each software resource can contain
multiple file resources.
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A file resource is a representation of an important file that a specific instance of software
installs. These files typically are DLL and EXE files. However, you can add references to any
files that can help to identify the software on a client computer.

When you associate the file resources with a software resource, you can add the file resources
to the software resource’s detection rule. Then, the rule can look for those files on the client
computer to determine whether that software is installed.

See “Creating or editing inventory rules” on page 73.

File resources can be added to a software resource in the following ways:

Regardless of how the software resource is created, you usually need to add
the file resources manually.

The procedure that follows show you how to add file resources to a software
resource manually.

Manually

Software Discovery scans managed computers and collects information about
the critical files that are installed with each software application. Then Software
Discovery associates the file information with the appropriate software
resources.

See “Discovering software on managed computers” on page 48.

From a Software
Discovery scan

After you associate file resources with a software resource, add the file resources to the
software resource’s detection rule.

To add file resources to a software resource manually

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, do one of the following:

■ To add a new software resource, in the Software pane, click Add Software, and then
click the drop-down menu option that corresponds to the type of the resource that you
want to add.

■ To edit an existing software resource that is undefined, click Software Catalog >
Undefined Software, and then double-click the software resource.

■ To edit an existing software resource that is defined, click All Software > All Software
Components, and then double-click the software resource.

3 On the software resource page, click the File Inventory tab.

4 On the File Inventory tab, click one of the following:

■ Add local file
Local files can be selected on a local computer, even through a console has it opened
remotely.
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■ Add server file
Server files are existing file resources on Notification Server that are associated with
other software resources

5 If you selected Add local file, in the Choose File to Upload dialog box, select one or
more files and click Open.

6 If you selected Add server file, in the Select File dialog box, select one or more files and
click OK.

7 On the File Inventory tab, click OK.

Exporting and importing a software resource and its
details

You can export a software resource and any of its metadata to a detailed XML file. You might
use the XML file as a backup. You also can replicate the software resource on another
Notification Server computer by importing the XML file to that computer.

The detailed export is different from the Symantec Management Platform default export, which
exports only the software resource item. The detailed export also includes such details as
packages, command lines, detection and applicability rules, associated components, updates,
service packs, and files.

Note: You need to use the Software Resource Replicator utility to export multiple software
resources.

You need to use the Software Resource Replicator utility to export the software resource
together with its custom icon.

The exported icons are stored in the subfolder of the root export folder AppIcons.

The imported icons are stored at C:\Program
Files\Altiris\SoftwareManagement\Web\AppIcons.

For more information about replicating software resources with Software Resource Replicator,
see the following knowledge base article:

https://www.symantec.com/docs/TECH166711

To export a software resource and its details

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, click All Software > All Software Components.

3 In the center pane, right-click a software resource, and then click Actions > Detailed
Export.
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4 In the Exporting dialog box, select the information to export with the software resource.

5 Click OK.

6 In the File Download dialog box, do either of the following:

■ Click Open to open and view the file. You can save the file from the Internet Explorer
toolbar.

■ Click Save to save the file and in the Save As dialog box, specify a name and location
and click OK.

7 If the Download complete dialog box appears, click Close.

To import a software resource and its details

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, click Notification Server > Console Settings > Views > Software >
Software Catalog.

3 In the right pane, right-click a software resource, click Import, and then select the XML
file produced during the detailed export.

4 Click OK.
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Importing data from a data
provider

This chapter includes the following topics:

■ Introducing data providers

■ Adding a data provider

■ Importing data from a data provider

■ Configuring the precedence settings for a data provider

■ Importing data from a data provider with a schedule

■ Importing data from a data provider manually

Introducing data providers
A data provider is a source of software resource data that can be imported into Software
Management Framework. You can import the metadata of a software resource from a data
provider into the Software Catalog. When you import metadata from a data provider, a software
resource is created in the Software Catalog if it does not already exist. If the software resource
is already in the Software Catalog, precedence settings determine if the data provider can
update the data.

See “Importing data from a data provider” on page 86.

The ability to import metadata eliminates the need to gather much of this data and manually
enter it into the Software Catalog. A data provider’s metadata might also be used to enhance
Notification Server’s ability to identify software resources on your managed computers.

You can also import the software package that is associated with a software resource if the
data provider supports this functionality. A software package is imported into the Software
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Library and is associated with the software resource in the Software Catalog. If a software
package is already associated with a software resource in the Software Catalog, then a data
provider cannot update the software package. If a data provider’s software resource has an
associated software package, you also have the option of importing only the metadata of the
software resource. With this option, a software package resource is created in the Software
Catalog, and it is sourced from the location that the data provider specifies.

The ability to import the software packages into the Software Library lets you store all of your
managed packages in a secure, centralized repository. When you import software packages
into the Software Library, those responsible for software distribution can easily deliver and
manage the software.

Before you can import data from a data provider into Software Management Framework, you
must add the data provider. To add a data provider, you configure a connection to the data
provider. A data provider that has a configured connection is a registered data provider. If a
data provider has multiple databases, you can configure a connection to each database.

See “Adding a data provider” on page 85.

A user of the Software Catalog or a Symantec Management Platform product that adds data
to the Software Catalog is a non-registered data provider. When you configure precedence
settings, the non-registered data providers are grouped together and referred to as Other
Software Providers.

You can import the metadata of software resources from a data provider into the Software
Catalog. When you import metadata, you eliminate the need to manually enter it into the
Software Catalog. This metadata then helps you manage the software.

When you import the metadata of a software resource, it appears on the appropriate tab in
the Software Catalog for that software resource. For example, package data appears on the
Package tab.

If metadata is already in the Software Catalog for a software resource, precedence settings
determine whether a data provider can update the data. The exception is File Inventory data,
which is additive, so precedence settings don’t apply.

Table 5-1 The types of metadata that a data provider can import

DescriptionType of data

The properties data defines the properties that identify a software
resource. This data includes its name, description, version, company,
and product name.

Properties
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Table 5-1 The types of metadata that a data provider can import (continued)

DescriptionType of data

The package data defines the software packages that are associated
with a software resource. It also defines the command lines for each
software package.

A data provider can import package data for a software resource for
multiple types of software packages. However, it cannot import package
data for a software resource for two software packages of the same type.
For example, it can import package data for a software resource for an
MSI package and a VSA package. However, it cannot import package
data for a software resource for two MSI files.

Package

A detection rule is used to determine if a software resource is installed.
When a detection rule is updated, the existing rule is preserved because
another software resource may still use it.

When you import metadata with a data provider, applicability rules are
not created.

Detection rule

The associations data defines the associations the software resource has
with other software resources in the Software Catalog.

Any associations that a data provider defines are imported as long as
both software resources exist in the Software Catalog. A data provider
can only remove an association from a software resource if it imported
that association.

Associations

The File Inventory data defines the DLL and the EXE files that a software
resource installs. Detection rules can use this data to detect if software
is installed on a computer. Inventory scans can also use this data to
distinguish between known and unknown files on a computer.

File Inventory

You can use different methods for importing data from a data provider. The method you choose
depends on how much control you want over what data is imported.

See “Importing data from a data provider” on page 86.
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Table 5-2 Methods for importing data from a data provider

DescriptionImport method

This method imports data when a scheduled task runs. It imports all of
the software resource data that the task is designed to import. For
example, if you schedule a task to import data from a data provider, it
imports data for all the available software packages.

See “Importing data from a data provider with a schedule” on page 89.

If you want more control over what is imported, use a manual import.

Scheduled import

This method imports data for the software resources that you select. This
ability to select specific software resources gives you complete control
over what is imported. Before you can use this method, a list of the
available software resources must be gathered.

See “Importing data from a data provider manually” on page 90.

Manual import

When you import data with either of these methods, an import task is created. The import task
is listed on the data provider’s page in the Providers folder. You can access the Providers
folder on the Settings menu at Software > Data Provider.

Adding a data provider
Before you can import data from a data provider into the Software Management Framework,
you must add the data provider. To add a data provider, you configure a connection to the
data provider. A data provider that has a configured connection is a registered data provider.

See “Importing data from a data provider” on page 86.

Before you can add a data provider, you must install the product that lets you add the data
provider. If a data provider is added automatically when a product is installed, then you do not
add the data provider.

To add a data provider, you must be assigned the Symantec Software Librarian security role.
The Symantec Management Platform administrator can assign people to this role.

In the following procedure, the data provider is added from the Data Provider Management
page.

You can also add a data provider on the Data Providers Web part.

See “Web parts for Software Management Framework” on page 16.
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To add a data provider

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Data Provider > Data Provider
Management.

3 On the Data Provider Management page, click Add, and then select the data provider.

If a data provider is not listed, you do not have the product installed that lets you connect
to that data provider.

4 On the page that appears, click the default title, and then type a title that is descriptive of
the data provider.

5 To add a description to the task, click Add description, and then type the description.

6 Under Settings, configure the settings for connecting to the data provider.

Each data provider has its own connection settings.

7 If the data provider lets you validate the connection, click Validate.

8 To save the connection settings, click Save changes.

9 Close the data provider’s page.

You can access this page in the Providers folder and edit its settings or schedule when
you want to import or gather its data. The Providers folder is under the Data Provider
folder.

Importing data from a data provider
You can import the metadata of software resources from a data provider into the Software
Catalog. You can also import the software package that is associated with the metadata into
the Software Library if the data provider supports this functionality.

To configure and import data from a data provider, you must be assigned the Symantec
Software Librarian security role. The Symantec Management Platform administrator can assign
people to this role.

Table 5-3 Process for importing data from a data provider

DescriptionActionStep

To import data from a data provider, you must install the
product that lets you connect to the data provider.

Install the product that lets
you connect to the data
provider.

Step 1
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Table 5-3 Process for importing data from a data provider (continued)

DescriptionActionStep

You must add a data provider before you can import its
data. To add a data provider, you configure a connection
to the data provider. Each data provider has its own
connection settings.

See “Adding a data provider” on page 85.

Add the data provider.Step 2

After you configure a connection to a data provider, you
should configure the precedence settings for the data
provider. Precedence settings determine when a data
provider can update the metadata of a software resource
that is in the Software Catalog.

See “Configuring the precedence settings for a data
provider” on page 87.

Configure the precedence
settings for the data provider.

Step 3

You can import the data on a schedule or manually. A
scheduled task imports all of the software resource data
that the task is designed to import. With a manual import,
you can select specific software resources to import.

See “Importing data from a data provider with a schedule”
on page 89.

See “Importing data from a data provider manually”
on page 90.

Import the data of the
available software resources.

Step 4

This report lets you view the status of the import tasks for
all data providers or for a specific data provider. You can
double-click a task to see the status of each software
resource that the task attempted to import. This report is
in the Data Providers folder, which is in the Software
reports folder.

View the Software Data
Provider Status report.

Step 5

Configuring the precedence settings for a data
provider

After you add a data provider, you should configure the precedence settings for the data
provider. The precedence settings determine whether the data provider can update the metadata
of a software resource that is in the Software Catalog.

See “Adding a data provider” on page 85.
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Precedence settings determine whether a data provider can update the metadata of a software
resource in the Software Catalog. A data provider must have a higher precedence setting to
update data from another data provider. You should assign the data provider that has the
highest quality data the highest precedence so no other data provider can update its data.

To configure precedence settings, you arrange a list of data providers. The data provider that
is highest in the list has the highest precedence settings. This list includes all of the registered
data providers. A data provider that has a configured connection is registered data provider.
This list also includes a data provider called Other Software Providers. Other Software
Providers includes any user of the Software Catalog and any Symantec Management Platform
product that puts data in the Software Catalog. By default, Other Software Providers has the
highest precedence.

You can set precedence settings for the following types of metadata:

■ Properties

■ Packages

■ Detection rule

■ Associations

Table 5-4 displays the results when a Software Catalog user has the highest precedence, data
provider 1 the next highest, and data provider 2 the lowest.

Table 5-4 Examples of how precedence settings work

ResultData provider that
attempts to update the
data

Data provider that last provided the
data

Data not updatedData provider 1 or 2Software Catalog user

Data updatedSoftware Catalog userAny data provider

Data updatedAny data providerData provider 2

Data not updatedData provider 2Data provider 1

Data updatedData provider 1Data provider 1

If you remove a data provider, any metadata that it imported into the Software Catalog is
assigned the lowest precedence. Any other data provider can then update its data.

To configure the precedence settings, you must be assigned the Symantec Software Librarian
security role. The Symantec Management Platform administrator can assign people to this
role.
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To configure the precedence settings for data providers

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Data Provider > Data Provider
Management.

3 On the Data Provider Management page, click Set Precedence.

4 In the Set Data Provider Precedence dialog box, configure the precedence settings for
each type of metadata.

5 To save the changes, click OK.

Importing data from a data provider with a schedule
You can schedule the import of the metadata of the available software resources of a data
provider. A software resource is available, if it has data that is ready to be imported. If the data
provider supports importing software packages, you can also schedule the import of the
software packages that are associated with the metadata.

See “Importing data from a data provider” on page 86.

If you want more control over what is imported, use a manual import.

See “Importing data from a data provider manually” on page 90.

If the metadata for a software resource already exists in the Software Catalog, precedence
settings determine if a data provider can update the data. The exception is File Inventory data,
which is additive, so precedence settings don’t apply. If a software resource in the Software
Catalog already has an associated software package, a data provider cannot update the
package.

In the following procedure, you schedule the import task from the data provider in the Providers
folder. You can also schedule the task from the Data Providers Web part.

See “Web parts for Software Management Framework” on page 16.

In addition to this method of scheduling the automatic import of data, a data provider might
have other methods for automatically importing its data.

To import data from a data provider with a schedule

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Data Provider > Providers, and then
select the data provider.
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3 On the data providers page, under Task Status, click New Schedule.

You can also schedule the import from the right-click menu of the data provider on the
Data Providers Web part.

See “Web parts for Software Management Framework” on page 16.

4 In the New Schedule dialog box, under Schedule, specify a schedule for the import task.

5 Under Input, type a description for the task.

This description identifies the task in the list of tasks that are associated with the data
provider. If the task is scheduled to run in the future, it is not assigned this description
until it runs.

6 Under Action, click one of the following options:

■ Import Data
This option imports only the metadata of the available software resources into the
Software Catalog. If a software package is associated with a software resource, a
software package resource is created in the Software Catalog. This software package
resource is sourced from the location that the data provider specifies.

■ Import Data and Package
This option imports the metadata of the available software resources into the Software
Catalog and the associated software packages into the Software Library. The software
package resource in the Software Catalog is sourced from the Software Library and
not from the location that the data provider specifies.

7 Click Schedule to complete the creation of the scheduled import task.

This import task is listed in the Task Status section of the data provider.

Importing data from a data provider manually
You can import data from a data provider for selected software resources instead of importing
all of the available software resources. This ability to select specific software resources gives
you complete control over what is imported. For example, you might have an urgent need to
import the metadata and the software package of a specific software resource. You do not
want to waste time importing data for other software resources. You can select that software
resource and import only its data.

See “Importing data from a data provider” on page 86.

If your data provider has a large amount of data that is available for import, we recommend
that you import the data manually. When you import the data manually, you can avoid cluttering
the Software Catalog with the data that you do not use. If you want to import all available
software resources instead of specific software resources, import the data on a schedule.

See “Importing data from a data provider with a schedule” on page 89.
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To import data for selected software resources, you first gather a list of available software. A
software resource is available if it has data that is ready to be imported. You then select from
this list the software resources whose data you want to import.

If the metadata for a software resource already exists in the Software Catalog, precedence
settings determine if a data provider can update the data. The exception is File Inventory data,
which is additive, so precedence settings don’t apply. If a software resource in the Software
Catalog already has an associated software package, a data provider cannot update the
package.

To import data from a data provider manually

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Data Provider > Data Provider
Management.

3 In the right pane, select the data provider.

4 On the Actions menu, click View Data Provider Summary.

5 If the software resource is not listed on theData Provider Summary page, do the following
to gather the software resource from the data provider.

■ On theGathermenu, select the data provider that has the data that you want to import.

■ In the New Schedule dialog box, under Schedule, specify a schedule for the gather
task.

■ Under Input, type a description for the task, and then click Schedule.
The description identifies the task. If the task is scheduled to run in the future, it is not
assigned this description until it runs.
This task is listed on the data provider’s page in the Providers folder. You can access
the Providers folder on the Settings menu at Software > Data Provider.

6 After the data is gathered, on theData Provider Summary page, click theRefresh symbol
to display the software resources that were gathered.

Depending on the data provider, the gather can take several minutes. If no new software
resources appear, then the data provider did not have any available software resources.

7 In the list of software resources, select the software resources to import.

8 On the Import menu, click one of the following options:

■ Data only
This option imports only the metadata of the available software resources into the
Software Catalog. If a software package is associated with a software resource, a
software package resource is created in the Software Catalog. This software package
resource is sourced from the location that the data provider specifies.

■ Data and Package
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This option imports the metadata of the available software resources into the Software
Catalog and the associated software packages into the Software Library. The software
package resource in the Software Catalog is sourced from the Software Library and
not from the location that the data provider specifies.
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Managing Windows
Installer applications

This chapter includes the following topics:

■ Introducing Windows Installer applications

■ Updating the source paths of Windows Installer applications

■ Configuring a Source Path Update policy

■ Repairing Windows Installer applications

■ Configuring a Windows Installer Repair policy

■ Creating customized Windows Installer policies and tasks

Introducing Windows Installer applications
You can create policies and tasks to manage Windows Installer applications on managed
computers. The policies and the tasks work with Windows Installer to enhance its functionality.

You can manage Windows Installer applications in the following ways:

You can proactively identify and repair broken applications on selected
computers. If an application needs repair, a repair command is sent to
the Windows Installer service to initiate self-repair.

You can use a policy or a task to identify the applications that need repair.

Initiate the repair of Windows
Installer applications.
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You can update the source paths of Windows Installer applications with
resilient source paths. The updated source paths point to the package
servers that you designate. If an application needs modification or repair,
Windows Installer can access the needed installation file from one of
these servers.

You can use a policy or a task to update the source paths.

Update the source paths for
Windows Installer
applications.

When you create policies or tasks to manage Windows Installer
applications, data is gathered on broken applications and inaccessible
source paths. The Application Management reports that are listed under
the Software reports display this data. You can use this data to monitor
the state of Windows Installer applications. For example, the Software
Resources - Broken Elements report displays the computers that had
broken applications during a specified date range. For each computer,
the report lists each occurrence of a broken application and identifies its
broken element.

See “Running a Software Management Solution report” on page 117.

View reports to monitor the
state of Windows Installer
applications.

Updating the source paths of Windows Installer
applications

You can update the source paths of Windows Installer applications with resilient source paths.
The updated source paths point to the package servers that you designate. If an application
needs modification or repair, Windows Installer can access the needed installation file from
one of these servers.

You can use a policy or a task to perform resilient source path updates of Windows Installer
applications on managed computers.

When a Windows Installer application is broken, Windows Installer can repair or modify it, but
only if the original installation file is accessible. When Windows Installer tries to modify or repair
an application, it uses the application’s source path to access the installation file. This source
path is based on the application’s package code. Without resilient source paths, if the installation
file is no longer available, the modification or repair fails. With resilient source paths, Windows
Installer can look for the installation file on a set of package servers that you designate.

For example, the software delivery policies and tasks in Software Management Solution typically
install packages from a package server. If that package server becomes unavailable, a Windows
Installer application that was installed from that server cannot be repaired. To avoid this
problem, update the application’s source paths to point to additional servers from which the
installation file can be accessed.

You can perform resilient source path updates of Windows Installer applications with a policy
or a task as follows:
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Use a policy as your primary means to update the source paths of Windows Installer
applications. A policy can update the source paths of existing applications, but also the
source paths of the applications that are installed in the future. To include the applications
that are not yet installed, schedule the policy to run repeatedly.

A Source Path Update policy updates all the Windows Installer applications that are
installed on the client computer.

Policy

Use a task when you need to update the source path of a specific application and the
update needs to be done immediately. For example, a Windows Installer repair might
fail because the server that distributed the application is out of service. You can create
a task to update the source path for that application.

A Source Path Update task can update a specific application or all the Windows Installer
applications that are installed on the client computer.

Task

The Software Management Solution plug-in must be installed on the client computers for you
to update source paths.

See “Installing or upgrading the Software Management Solution plug-in” on page 58.

Table 6-1 Process for updating source paths for Windows Installer applications

DescriptionActionStep

A Source Path Update policy or task adds resilient source paths to
Windows Installer applications on managed computers.

See “Configuring a Source Path Update policy” on page 96.

See “Creating a task in Software Management Solution” on page 113.

You can also create a Source Path Update task from a software
resource in the Software Catalog. If you create the task from a software
resource, you select the computers that the task applies to and the task
runs immediately.

Configure a policy or create
a task to update the source
paths of Windows Installer
applications.

Step 1

Every task inherits the default settings that control how it runs. You can
override the default settings for a particular task.

You cannot change the settings for a Source Path Update policy.

(Optional, task only)
Configure the task settings.

Step 2

95Managing Windows Installer applications
Updating the source paths of Windows Installer applications



Table 6-1 Process for updating source paths for Windows Installer applications (continued)

DescriptionActionStep

The options for scheduling the task are as follows:

■ Run the task now.
This option runs the task as soon as possible, unless it must wait
for a maintenance window.

■ Schedule the task to run at a specific time.

See “Scheduling a task and selecting computers in Software
Management Solution” on page 116.

This additional step is not necessary for the policy because you schedule
it as part of its configuration.

(Task only) Schedule the task
and select the delivery
destinations.

Step 3

This report lists the computers that had Windows Installer applications
with inaccessible source paths during the most recent scan. Use this
report to identify the changes that you need to make to resolve
inaccessible source path problems. This report is one of the Application
Management reports listed under the Software reports.

See “Running a Software Management Solution report” on page 117.

View the Software
Resources - Inaccessible
Source Paths report.

Step 4

Configuring a Source Path Update policy
To update the source paths of Windows Installer applications with resilient source paths, you
need to configure a Source Path Update policy. Configuring the policy is a step in the process
of updating the source paths of Windows Installer applications.

See “Updating the source paths of Windows Installer applications” on page 94.

After you configure the policy, it runs as scheduled on the specified computers or for the
specified users. If you schedule the policy to repeat, it can continue to check and update the
source paths.

To configure a Source Path Update policy

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, expand Software > Application Management > Windows, and then
click Source Path Update.
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3 In the right pane, on the Source Path Update page, under Settings, specify the package
servers to use as follows:

Lets you select the first server to use as a source path. You can click Any
Server or you can select a specific server from the list. The package server
that you select must be accessible to the computers that are specified in the
policy.

To optimize bandwidth, select specific package servers to serve as the source
paths for Windows Installer applications. Servers between the first and last
are used in order of response speed.

If you do not select specific package servers, the update begins with the
fastest-responding server and works toward the slowest. It then ends with the
Notification Server computer.

First Server to
Use

Lets you select the last server to use as a source path. You can click Any
Server or you can select a specific server from the list. The package server
that you select must be accessible to the computers that are specified in the
policy.

Last Server to
Use

4 In Maximum Number of Servers, type the maximum number of servers to use for the
source path update.

5 Under Schedule, configure the schedule for the policy.

To run this policy on a recurring basis, under Schedule, click No repeat, and then, in the
Repeat Schedule dialog box, choose the repeat interval.

6 Under Applied to, choose the computers or users to which the policy applies.

7 Turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

8 Click Save changes.

Repairing Windows Installer applications
You can proactively identify and repair broken Windows Installer applications on managed
computers even before the user encounters a problem. If an application needs repair, a repair
command is sent to the Windows Installer service to initiate self-repair.

You can repair Windows Installer applications on managed computers with a policy or task as
follows:
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Use a policy as your primary means to repair Windows Installer applications. A policy
not only repairs the applications that are currently broken, but it can also repair any
applications that break in the future. To repair current and future applications, schedule
the policy to run on a recurring basis.

A policy can perform a quick repair or a full repair.

Policy

Symantec recommends that you use a task to repair a specific application. For example,
if a user reports a broken application, you can create a task to repair that specific
application on that user’s computer.

A task can perform a full repair only.

Task

Note:Windows Installer repair task or policy fail on computers with Cloud-enabled management
if the software installation package for a broken Windows Installer application is not available.

See “Repairing Windows Installer applications” on page 97.

The Software Management Solution plug-in must be installed on the client computers for you
to perform Windows Installer repairs.

See “Installing or upgrading the Software Management Solution plug-in” on page 58.

Instead of using a Windows Installer Repair policy or task to repair Windows Installer
applications, you can use the remediation feature of Managed Software Delivery. Managed
Software Delivery provides more control over the criteria that are used to determine when a
repair is needed. Instead of a predefined key path, it uses the metadata that is associated with
the software resource, that is defined in the Software Catalog. Managed Software Delivery
can also repair multiple software resources with a single policy. A Windows Installer Repair
policy or task can repair one application or all applications.

See “About policy applicability, compliance, and remediation” on page 128.

Table 6-2 Process for repairing Windows Installer applications

DescriptionActionStep

Configure a Windows Installer Repair policy to check and repair
Windows Installer applications on a recurring basis.

See “Configuring a Windows Installer Repair policy” on page 99.

Create a Windows Installer Repair task to repair a specific application.

See “Creating a task in Software Management Solution” on page 113.

Configure a policy or create
a task.

Step 1

Every task inherits the default settings that control how it runs. You can
override the default settings for a particular task.

You cannot change the settings for a Windows Installer Repair policy.

(Optional, task only)
Configure the task settings.

Step 2
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Table 6-2 Process for repairing Windows Installer applications (continued)

DescriptionActionStep

Your options for scheduling the task are as follows:

■ Run the task now.
This option runs the task as soon as possible, unless it must wait
for a maintenance window.

■ Schedule the task to run at a specific time.

See “Scheduling a task and selecting computers in Software
Management Solution” on page 116.

This additional step is not necessary for the policy because you schedule
it as part of its configuration.

(Task only) Schedule the task
and choose the delivery
destinations.

Step 3

These reports display the Windows Installer applications that had broken
elements during a specified time range. The reports also identify the
element that is broken. If an application could not be repaired, the
Software Resources - Current Broken Elements report displays
details about why the repair failed.

Use these reports to help you resolve broken Windows Installer
applications. These reports are listed under the Software reports.

See “Running a Software Management Solution report” on page 117.

View the Application
Management reports that
identify broken elements.

Step 4

Configuring a Windows Installer Repair policy
To repair Windows Installer applications on managed computers, configure a Windows Installer
Repair policy. Symantec recommends that you use a policy to check and repair Windows
Installer applications on a recurring basis. This is a step in the process for repairing Windows
Installer applications.

See “Repairing Windows Installer applications” on page 97.

After you configure the policy, it runs as scheduled on the specified computers or for the
specified users. Whenever the policy discovers a broken application, it initiates a repair. If you
schedule the policy to repeat, it can continue to check and repair the applications.

You can clone a Windows Installer Repair policy to create policies with different schedules for
different computers. To do that, right-click a policy, and the click Clone.

To configure a Windows Installer Repair policy

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, expand Software > Application Management > Windows, and then
click one of the following options:
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■ Windows Installer Full Repair

Runs a Quick Scan, like the quick repair, and then runs a deep scan.
The deep scan identifies Windows Installer applications and verifies
that all of the component’s resources are installed correctly. If any
element of a component is not installed correctly, the policy or the
task repairs that component and reports the results.

Type of scan

A Windows Installer Full Repair takes more time and resources than
a Windows Installer Quick Repair.

Scan time and resources

A full repair discovers every Windows Installer application that needs
repair while a quick repair might not.

What it discovers

Use a policy or a task.Method for performing the
repair

■ Windows Installer Quick Repair

Runs a Quick Scan that identifies Windows Installer applications and
verifies that each component’s key path is installed correctly. If the
component’s key path is not installed correctly, the policy tries to
repair the component and reports the results.

For example, if the Microsoft Word key path file, winword.exe, is not
installed in the correct path, the policy tries to repair Word.

Type of scan

A Windows Installer Quick Repair takes less time and fewer resources
than a Windows Installer Full Repair.

Scan time and resources

A quick repair discovers only broken or missing key paths. If a
component has other missing or broken files, a quick repair might not
repair them.

What it discovers

Use a policy.Method for performing
the repair

3 In the right pane, under Schedule, on the toolbar, click Add schedule, and then specify
the schedule for the policy.

To run this policy on a recurring basis, under Schedule, click No repeat and then, in the
Repeat Schedule dialog box, select the repeat interval.

4 Under Applied to, specify the computers or users to which the policy applies.
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5 Turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

6 Click Save changes.

Creating customized Windows Installer policies and
tasks

A software resource for the Application Management agent is created in the Software Catalog
when Software Management Solution is installed. You can use this software resource to create
your own policies and tasks to repair Windows Installer applications or to update their source
paths. Create your own policies and tasks only if the predefined policies and tasks do not meet
your needs.

The policies and the tasks that perform Windows Installer repairs or source path updates use
the Application Management agent. When these tasks or these policies run on managed
computers, they install the agent if it is not already installed. The Application Management
agent works with Windows Installer to help you manage Windows Installer applications.

The Application Management agent also gathers data about Windows Installer applications
on managed computers. You can view this data on the Application Management reports that
are listed under the Software reports. Create your own policies and tasks only if the predefined
policies and tasks do not meet your needs.

See “Running a Software Management Solution report” on page 117.

A software resource for the Application Management agent is created in the Software Catalog
when Software Management Solution is installed. You can use this software resource to create
your own policies and tasks to repair Windows Installer applications or to update their source
paths.

See “Creating customized Windows Installer policies and tasks” on page 101.

You can determine where the Application Management agent is installed. Create a Targeted
Software Inventory policy for the Application Management agent’s software resource so you
can look for the agent on selected client computers.

Table 6-3 Process for creating and customizing Windows Installer policies and tasks

DescriptionActionStep

You can either edit an existing command line or create a
new command line.

See “Creating a command line for a software resource”
on page 72.

Create a customized
command line for the
Application Management
agent package in the
Software Catalog.

Step 1
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Table 6-3 Process for creating and customizing Windows Installer policies and tasks
(continued)

DescriptionActionStep

You can use Quick Delivery or Managed Software Delivery
to deliver the agent. In Managed Software Delivery, you
can create the command line when you create the policy.

See “Creating a Managed Software Delivery policy with
the Managed Software Delivery wizard” on page 136.

See “Creating a Quick Delivery task with the Quick
Delivery wizard” on page 110.

Deliver the Application
Management agent with the
customized command line.

Step 2
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Delivering software

■ Chapter 7. Performing a quick delivery of a single software resource

■ Chapter 8. Performing an advanced software delivery

■ Chapter 9. Delivering software from user requests using the Software Portal

3Section



Performing a quick delivery
of a single software
resource

This chapter includes the following topics:

■ Introducing software delivery

■ Performing a quick delivery of a single software resource

■ Creating a Quick Delivery task with the Quick Delivery wizard

■ Delivering a package without defining a software resource

■ Creating a task in Software Management Solution

■ Editing a task in Software Management Solution

■ Running a Software Management Solution report

Introducing software delivery
Before you deliver software, it is a good idea to better understand what you can deliver, how
you can deliver, and other useful information.

To help you get more familiar with software delivery you can refer to the following:

■ A general overview of software delivery
See “About software delivery” on page 105.

■ The methods you can use to delivery software
See “Methods for delivering software” on page 105.
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■ The methods you can uninstall software you have delivered and installed
See “Methods for uninstalling software” on page 107.

About software delivery
Software Management Solution lets you deliver and install software safely and accurately on
managed client computers. You can create tasks and policies to respond to software delivery
needs from elementary to complex.

Software Management Solution integrates with the Software Catalog and the Software Library
that are part of the Symantec Management Platform. By leveraging this information, Software
Management Solution ensures that the correct software gets installed, remains installed, and
runs without interference from other software. This integration lets your administrators focus
on delivering the correct software instead of redefining the packages, command lines, and so
on for each delivery.

See “How Software Management Solution integrates with Software Management Framework”
on page 13.

Software Management Solution supports packages for the Windows, UNIX, Linux, and Mac
operating systems. With few exceptions, all the functions in Software Management Solution
work the same for all platforms. For example, you use the same method to create a delivery
task for a Windows, UNIX, Linux, or Mac OS package.

You can use Software Management Solution tasks or policies to fulfill any of the following
delivery requirements:

■ Perform a quick delivery of a single software resource.

■ Perform one or more advanced delivery actions.
For example, you can deliver multiple software resources and periodically check the client
computer to verify that they are in the correct state.

■ Deliver software automatically in response to a direct request from a user.

■ Deliver a package that is not associated with a software resource.

See “Methods for delivering software” on page 105.

Methods for delivering software
You can deliver software to one or more managed computers by creating and running a
Software Management task or policy. The method that you use to create the task or policy
depends on your delivery requirements.
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Table 7-1 Methods for delivering software

DescriptionDelivery methodYour requirement

You can use the task-based Quick Delivery
method to specify the software to deliver, the
action to perform, and the computers to
deliver to. Quick Delivery uses the default
task settings, which you can change when
necessary.

Because of its simplicity, Quick Delivery is an
ideal way for non-administrators, such as help
desk personnel, to deliver software safely and
accurately.

The software that you deliver in this way must
be defined as a deliverable software resource
in the Software Catalog.

Quick DeliveryPerform a quick delivery of a single
software resource.

Managed Software Delivery is a policy-based
delivery method that lets you fulfill advanced
delivery requirements. A single Managed
Software Delivery policy can perform multiple
delivery actions.

The software that you deliver in this way must
be defined as a deliverable software resource
in the Software Catalog.

Managed Software Delivery leverages the
software resource information and the logic
that is in the Software Catalog. For example,
Managed Software Delivery uses the software
resource’s dependencies, package, and
detection rule.

See “About advanced software deliveries”
on page 120.

Managed Software DeliveryPerform one or more of the following
advanced delivery actions:

■ Deliver on a recurring schedule.
■ Install to a known state and ensure

that the state is maintained.
■ Install software with the other

software that it depends on.
■ Install a software resource that

replaces other software.
■ Sequentially install multiple software

and tasks.
■ Run any client task at any stage of

the delivery.
A client task is one that is defined in
Notification Server and is intended
to run on a client computer.
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Table 7-1 Methods for delivering software (continued)

DescriptionDelivery methodYour requirement

(Windows and Mac only) With the Software
Portal, users can request software and
responds to those requests. If the user is
pre-approved to install the software, the
installation occurs without the administrator’s
involvement. Otherwise, the administrator
only needs to approve the requests and
deliver the software that is not in the Software
Catalog.

See “About the Software Portal” on page 151.

Software PortalDeliver software in response to a direct
request from a user.

Package Delivery is a task-based delivery
method. It lets you deliver any package
regardless of whether it is associated with a
software resource.

Package DeliveryDeliver a package that is not associated
with a software resource.

Methods for uninstalling software
You can uninstall software from one or more managed computers by running a Software
Management policy or task.

The method that you use to uninstall software depends on how the software was installed.

Table 7-2 Methods for uninstalling software

Uninstall methodInstallation method

You can clone the original installation task or policy and then edit the
clone to select an uninstall command line.

The software was installed
with a Software Management
Solution task or policy.

If a software resource is defined for that software, you can create a
software delivery task or policy and select an uninstall command line.

See “Methods for delivering software” on page 105.

If a software resource is not defined for that software, you can create one
in the Software Catalog.

See “Creating a command line for a software resource” on page 72.

The software was not
installed with Software
Management Solution.

Managed Software Delivery provides the ability to perform more complex uninstall tasks. For
example, you can use a Managed Software Delivery policy to not only uninstall obsolete
software but also install new software at the same time.
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See “About installing software that replaces other software” on page 134.

Managed Software Delivery can also regularly check computers for the presence of
unauthorized software and uninstall any unauthorized software that is found. For example,
you can use a Managed Software Delivery policy to remove game software from client
computers on a recurring basis.

Performing a quick delivery of a single software
resource

You can perform a quick delivery of a single software resource that runs with minimum
configuration. You can use the task-based Quick Delivery method to specify the software to
deliver, the action to perform, and the computers to deliver to.

Because the software resources and the delivery settings are predefined, Quick Delivery
makes it easy for administrators and non-administrators to deliver software. For example, help
desk personnel can easily deliver hotfixes because all they have to do is select the correct
hotfix from the Software Catalog. They do not need to know which package to select or how
to create the command line.

Most organizations can use Quick Delivery for the majority of their software delivery needs.
Quick Delivery helps you reduce the amount of time that you spend on routine deliveries so
that you can devote more time to advanced activities.

The software that you deliver in this way must be defined as a deliverable software resource
in the Software Catalog. It must also have at least one command line.

After the initial instance of a Quick Delivery task runs, you can edit and rerun it. For example,
you can deliver the software to different computers or run a different command line on the
same computers. You can also edit the delivery settings for the task. For example, you can
change the user credentials under which the task runs.

See “Editing a task in Software Management Solution” on page 115.

If you need to perform compliance checks or other advanced delivery activities, use Managed
Software Delivery instead of Quick Delivery.

See “About advanced software deliveries” on page 120.
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Table 7-3 Process for performing a quick delivery of a single software resource

DescriptionActionStep

The options for creating a Quick Delivery task are as follows:

■ Use the Quick Delivery wizard.
The Quick Delivery wizard let you create and run a Quick Delivery
task with minimum configuration.
See “Creating a Quick Delivery task with the Quick Delivery wizard”
on page 110.

■ Create and configure the task manually.
Use this method when you need to to configure the default settings
of the task or run the task on a specific schedule. You can also
configure the task that you created with a wizard.
See “Creating a task in Software Management Solution” on page 113.

Create a Quick Delivery task.Step 1

Every task inherits the default run settings. You can override the default
settings for a particular task.

For example, if you want to deliver a large package over slow network,
you may want to increase the End task after value.

(Optional) Configure the task
settings.

Step 2
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Table 7-3 Process for performing a quick delivery of a single software resource (continued)

DescriptionActionStep

When you use theQuick Deliverywizard to create the task, you choose
the destinations in the wizard. Those destinations apply to that instance
of the task only. You do not have to schedule the task because it runs
as soon as possible.

When you edit the task or create it without the wizard, you define the
schedule and the delivery destinations every time you run the task.

The options for scheduling the task are as follows:

■ Run the task now.
This option runs the task as soon as possible, unless it must wait
for a maintenance window.

Note: On computers with Cloud-enabled Management this option
only works like a schedule. Computers with Cloud-enabled
Management receive the task from the task server that depends on
the task agent schedule. Symantec recommends that you increase
the default timeout period in the advanced options for the tasks that
are scheduled on computers with Cloud-enabled Management. An
increased timeout period can significantly improve software delivery
for Quick Delivery to computers with Cloud-enabled Management.
By default, the End task after is set to 300 minutes (five hours). A
recommended value to change the timeout period to is 1440 minutes
(24 hours). The maximum timeout is 2160 minutes (36 hours).

■ Schedule the task to run at a specific time.

See “Scheduling a task and selecting computers in Software
Management Solution” on page 116.

Schedule the task and
choose the delivery
destinations.

Step 3

The Software Management reports let you monitor the software
deliveries.

The delivery reports provide information about the status of the software
downloads and executions. For example, the software downloads for
each computer, including the status and the download date.

See “Running a Software Management Solution report” on page 117.

After the task runs, view the
reports.

Step 4

Creating aQuickDelivery taskwith theQuickDelivery
wizard

A Quick Delivery task lets you deliver software without the need to know which package to
select or how to create the command line. Creating a Quick Delivery task is the first step in
performing a Quick Delivery of a single software resource.
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See “Performing a quick delivery of a single software resource” on page 108.

The Quick Delivery wizard is the fastest and easiest way to create and run a Quick Delivery
task with minimum configuration. During the wizard, you specify the software resource to
deliver, the action to perform, and the destinations to deliver to. The resulting Quick Delivery
task runs as soon as possible without further configuring or scheduling. We recommend that
non-administrators use the Quick Delivery wizard because it provides the fewest options and
therefore the fewest opportunities for errors.

Warning: When a Quick Delivery task runs automatically, you can recall, stop, or disable it
only if the task needs to wait for a maintenance window.

The advantages of using the Quick Delivery wizard are as follows:

■ It speeds the task creation.

■ It does not let non-administrators change the delivery settings.
In most cases, it is important to prevent non-administrators from changing the delivery
settings when they deliver software.

■ It sets the task to run as soon as possible.

When you create a Quick Delivery task without the wizard, it does not run automatically. You
must run it or schedule it.

The software that you deliver in this way must be defined as a deliverable software resource
in the Software Catalog.

If you need to change the task default settings or run the task on a specific schedule, create
the task without the Quick Delivery wizard.

See “Creating a task in Software Management Solution” on page 113.

To create a Quick Delivery task with the Quick Delivery wizard

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, expand Deliverable Software, and then click Software Releases.

3 In the Software Releases pane, right-click a deliverable software resource and then click
Actions > Quick Delivery Task.

4 In the Quick Delivery Task dialog box, specify the following items:
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Note: A script file needs the path to the program the script file requires on the client
computer for the task to deliver successfully. For example, consider a python script file,
test.py. If the install path on the client computer is c:\python27\python.exe, then this
path needs to be specified in the command line as follows: "c:\python27\python.exe"
"test.py". If you want to deliver to different clients with different install paths, then you
have to modify the task for each different install path.

■ The software resource to deliver

■ The command line to run
The list contains the names of the command lines that are defined for the software
resource.

■ Whether to accept the maintenance windows

■ The destinations you want to deliver the software resource to

5 Click OK.

Delivering a package without defining a software
resource

Package Delivery method lets you deliver any package regardless of whether it is associated
with a software resource.

You may need to use Package Delivery for the following purposes:

■ To deliver a package that you choose not to manage in the Software Catalog.

■ To quickly deliver a new package that is not yet in the Software Catalog.

■ To deliver a package that is in the Software Catalog, but with a command line that is not
defined for the package.
For example, a package is in the Software Catalog and is associated with predefined
command lines. You need to deliver that package with a specialized command line, but
you do not have the privileges to edit the package or its software resource. You can create
a Package Delivery task for that package and type the command line that you need.

Table 7-4 Process for delivering a package without defining a software resource

DescriptionActionStep

A Package Delivery task lets you perform a routine
package delivery.

See “Creating a task in Software Management Solution”
on page 113.

Create a Package Delivery
task.

Step 1
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Table 7-4 Process for delivering a package without defining a software resource
(continued)

DescriptionActionStep

Every task inherits the default settings that control how
the task runs. You can override the default settings for a
particular task.

For example, if you want to deliver a large package over
slow network, you may want to increase the End task
after value.

(Optional) Change the task
settings.

Step 2

Define the schedule and the delivery destinations every
time you run the task.

Your options for scheduling the task are as follows:

■ Run the task now.
This option runs the task as soon as possible, unless
it must wait for a maintenance window.

■ Schedule the task to run at a specific time.

See “Scheduling a task and selecting computers in
Software Management Solution” on page 116.

Schedule the task and
choose the delivery
destinations.

Step 3

The Software Management reports let you monitor the
software deliveries.

The delivery reports provide information about the status
of the software downloads and executions. For example,
the software downloads for each computer, including the
status and the download date.

See “Running a Software Management Solution report”
on page 117.

After the task runs, view the
reports.

Step 4

Creating a task in Software Management Solution
Creating a task is typically the first step in performing the software-related actions in Software
Management Solution. This procedure describes how to create any type of task in Software
Management Solution.

Every task inherits the default settings that control how the task runs. You can override the
default settings for a particular task.

For example, if you want to deliver a Quick Delivery on an Internet-managed computer that
uses Cloud-enabled Management, you can increase the default End task after value. Such
changes in settings can improve the performance of the software delivery considerably.
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See “Editing a task in Software Management Solution” on page 115.

Notification Server tasks let you download and run packages, programs, commands, and other
items to client computers. You use tasks to perform most of the actions in Software Management
Solution.

Table 7-5 Types of tasks in Software Management Solution

DescriptionType of task

Lets you deliver any package regardless of whether it is associated with a
software resource.

See “Delivering a package without defining a software resource” on page 112.

Package Delivery

Lets you perform a Quick Delivery of a single software resource. Creating this
task is the first step in the Quick Delivery process. The software that you deliver
in this way must be defined as a deliverable software resource in the Software
Catalog.

See “Performing a quick delivery of a single software resource” on page 108.

Quick Delivery

Lets you update the source paths of Windows Installer applications with the
resilient source paths that point to the package servers that you designate.

See “Updating the source paths of Windows Installer applications” on page 94.

Source Path Update

Lets you proactively identify and repair broken Windows Installer applications
on selected computers.

See “Repairing Windows Installer applications” on page 97.

Windows Installer
Repair

See “Scheduling a task and selecting computers in Software Management Solution” on page 116.

To create a task

1 In the Symantec Management Console, on the Manage menu, click Jobs and Tasks.

2 In the left pane, expand System Jobs and Tasks > Software.

3 Right-click the folder under which you want to create a task, and then click New > Task.

4 In the Create new task dialog box, in the left pane, expand Software, and then click the
type of task that you want to create.

The type of task that you selected determines the options that appear, as follows:

■ Package Delivery

■ Quick Delivery

■ Source Path Update (Windows only)

■ Windows Installer Repair
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5 In the right pane, configure the task.

See “Editing a task in Software Management Solution” on page 115.

6 Click OK.

Editing a task in Software Management Solution
You can edit any type of Software Management Solution task.

To edit a task

1 In the Symantec Management Console, on the Manage menu, click Jobs and Tasks.

2 In the left pane, expand System Jobs and Tasks > Software. Expand the folder in which
the task resides, and then click the task that you want to edit.

3 In the right pane, do any of the following:

■ In the top section, click Advanced to change the task settings for this instance.

■ In the top section, edit the task details. The type of task that you selected determines
the options that appear.

■ In the bottom section, click New Schedule to schedule the task and select the
destination computers.

Note: For a Quick Delivery task, on the Internet-managed computers that use
Cloud-enabled Management, theNow option works like a schedule. Internet-managed
computers receive the task from the task server that depends on the task agent
schedule. Symantec recommends that you increase the default timeout period in the
advanced options for the tasks that are scheduled on Internet-managed computers.
An increased timeout period can significantly improve software delivery for Quick
Delivery from Internet-based computer. By default the End task after is set to 300
minutes (five hours). A recommended value to change the timeout period to is 1440
minutes (24 hours). The maximum timeout allowable is 2160 minutes (36 hours).

See “Scheduling a task and selecting computers in Software Management Solution”
on page 116.

■ In the bottom section, double-click an existing instance of this task to re-schedule it.
You might want to reschedule an existing instance if the task failed due to an incorrect
setting. In that case, you can fix the setting and reschedule the task instead of creating
a new task.

4 When you finish editing the task, on the task main page, click Save changes.
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Scheduling a task and selecting computers in Software Management
Solution

Software Management tasks use the task management component of Notification Server that
provides flexibility in targeting computers and scheduling tasks. For example, when you
schedule tasks, you can configure multiple schedules for an individual task, use maintenance
windows, or use shared schedules. When you select computers, you can build and re-use
predefined groups of computers.

To schedule a task and to select computers

1 In the Symantec Management Console, on the Manage menu, click Jobs and Tasks.

2 In the left pane, expand System Jobs and Tasks > Software > Quick Delivery.

3 Under the Quick Delivery folder, click on the task you want to schedule.

4 On the task page, click either of the following:

■ Quick Run
Lets you run the task on a single destination as soon as possible, unless it must wait
for a maintenance window. This option is not available for some tasks.

■ New Schedule
Lets you schedule the task to run at a specific time. The name of the option depends
on the type of task.

Note: On the Internet-managed computers that use Cloud-enabled Management the
Now option works like a schedule. Internet-managed computers receive the task from
the task server that depends on the task agent schedule.

Symantec recommends that you increase the default timeout period for the tasks that
are scheduled on Internet-managed computers. An increased timeout period can
improve software delivery from such computers. You can configure the timeout period
in the Advanced settings dialog box, on the Task options tab. By default the Stop
task after is set to 300 minutes (five hours). The recommended timeout period is 1440
minutes (24 hours). The maximum timeout is 2160 minutes (36 hours).

To see these options, you might have to click a tab or expand a section on the task page.

5 Select the computers to run the task on.

6 (Optional) To create multiple schedules and computer lists for this task, repeat step 4
through step 5.
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Running a Software Management Solution report
You can view reports to get information about the actions that you perform in Software
Management Solution.

Predefined reports let you easily view and analyze your Software Management Solution data.
The reports are grouped in folders by type in the Symantec Management Console.

You can also create your own custom reports.

By default, all the Software Management Solution reports support resource scoping, which
limits the data that users can access based on their security roles.

The Software Management Solution reports use the scoping feature as follows:

■ When a user runs a report, the report contains only the data that the user is permitted to
view.

■ When a user saves a snapshot of a report, the snapshot is scoped according to the
permissions of that user. A user with a lower security role than the original user cannot
view the snapshot. A user with a higher security role than the original user can see only
the data that the original user is allowed to access.

■ You can clone a report and edit the SQL query of the clone to customize how the data is
scoped when it is extracted for that report. You can also include scoping information when
you create an SQL query for a custom report.

■ You can clone a report and edit the clone to select the fields that are scoped when data is
extracted from the snapshots of that report.

Table 7-6 Types of predefined reports in Software Management Solution

DescriptionReport type and folder

Contains the reports that display information about the Windows Installer
applications that are broken or that have inaccessible source paths.

Application Management

Contains the reports that display information about the compliance actions
and the remediation actions that Managed Software Delivery performs.

Compliance

Contains the reports that display information about the status of the
software downloads and executions.

Delivery

Contains the reports that display the status of software requests by end
users of the Software Portal.

Portal
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To run a Software Management Solution report

1 In the Symantec Management Console, on the Reports menu, click All Reports.

2 In the left pane, expand Software, navigate to the report that you want to run, and then
click the report.

3 In the right pane, view the report.

You can print the report or save it in a variety of formats. Other actions might be available
depending on the type of report.
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Performing an advanced
software delivery

This chapter includes the following topics:

■ Introducing advanced software deliveries

■ Viewing Managed Software Delivery policies

■ Creating a Managed Software Delivery policy with the Managed Software Delivery wizard

■ Creating a Managed Software Delivery policy

■ Editing a Managed Software Delivery policy

■ Selecting the delivery destinations for a Managed Software Delivery policy

■ Performing software import and managed delivery

■ Performing an advanced software delivery

■ Delivering multiple software resources and tasks sequentially

■ Performing an emergency policy update

■ Viewing emergency policy update reports

Introducing advanced software deliveries
Before you perform an advanced software delivery, it is a good idea to better understand what
it is, how it works, and other useful information.

To help you get more familiar with advanced software deliveries you can refer to the following:

■ About advanced software delivery as a policy-based delivery method
See “About advanced software deliveries” on page 120.

8Chapter



■ About the execution of advanced software delivery including an explanation of compliance
and remediation
See “About the execution of Managed Software Delivery policies” on page 121.

■ About the applicability, compliance, and remediation actions that let you not only deliver
software but also manage it
See “About policy applicability, compliance, and remediation” on page 128.

■ About the ways you can give the user some control over the software delivery execution
See “About software delivery deferral options for the user” on page 130.

■ About how you can schedule the execution of the remediation of an advanced software
delivery
See “About deferring the execution of software remediation” on page 134.

■ About supersedence associations in which one software resource replaces another software
resource
See “About installing software that replaces other software” on page 134.

■ About the status of an advanced software delivery and determining a Managed Software
Delivery policy’s success
See “About the status of Managed Software Delivery policies” on page 135.

About advanced software deliveries
Managed Software Delivery simplifies advanced software deliveries by letting you deliver
software as a unit, which can include multiple software resources as well as dependencies.
For example, you can create a single Managed Software Delivery policy that installs an
application and its associated patches and service packs. Managed Software Delivery can
also run any task at any stage of the delivery. For example, it can run a task that performs a
restart or runs a script.

Managed Software Delivery is a policy-based delivery method that lets you configure advanced
delivery settings.

See “Performing an advanced software delivery” on page 143.

Managed Software Delivery allows you to do the following:

■ Intelligently perform the compliance checks and the remediation actions that let you deliver
software and manage it.

■ Leverage the software resource information and the logic that is in the Software Catalog
such as dependencies, packages, and detection rules.

■ Save bandwidth by downloading packages only when they are needed. If a client computer
does not have the appropriate configuration for the software or if the software is already
installed, the package is not downloaded.

■ To perform multiple delivery actions with a single policy.
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The software that you deliver in this way must be defined as a software resource in the Software
Catalog.

See “About the Software Catalog” on page 25.

If you need to perform a Quick Delivery of a single software resource, use Quick Delivery
instead of Managed Software Delivery.

See “Performing a quick delivery of a single software resource” on page 108.

About the execution of Managed Software Delivery policies
When a Managed Software Delivery policy runs on a managed computer, it performs a series
of tasks that are grouped into the following phases:

■ Compliance
See Table 8-1.

■ Remediation
See Table 8-2.

When you schedule a Managed Software Delivery policy, you can assign different schedules
for compliance and remediation. For example, you can schedule the compliance status to be
reported during the day and the remediation to occur only during a maintenance window.

See “About policy applicability, compliance, and remediation” on page 128.

The ability to separate compliance and remediation also allows for the offline execution of
Managed Software Delivery policies. When the compliance check determines that a remediation
is required, the policy downloads the appropriate package. Remediation can occur even if the
client computer is not connected to the server because the client computer already has the
package that it needs.

See “About deferring the execution of software remediation” on page 134.

Table 8-1 How the compliance phase of Managed Software Delivery works

DescriptionActionStep

Starts the policy’s compliance process at the scheduled time on the client
computer.

Policy executionStep 1
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Table 8-1 How the compliance phase of Managed Software Delivery works (continued)

DescriptionActionStep

Evaluates the software resource’s unique identifier or detection rule to
determine whether the software resource is installed on the client computer.
The software resource’s unique identifier is used when the software resource
is not associated with a detection rule.

The compliance check runs for each software resource in the Managed
Software Delivery policy.

This compliance check determines whether the software is in the correct
state. The correct state of a software resource can mean that it is installed
or that it is not installed.

If all the software in the Managed Software Delivery policy is in the correct
state, it is compliant. Therefore, remediation is not needed and the policy
execution stops. If any or all of the software is not in the correct state, it is
out of compliance. Therefore, remediation is required and the policy execution
continues.

Compliance checkStep 2

Determines whether the client computer has the correct environment for an
installation of the software. If the computer does not have the correct
environment, the policy execution stops.

The applicability check runs for each software resource in the Managed
Software Delivery policy that is associated with an applicability rule.

Applicability checkStep 3

Downloads the package for each software resource or task in the Managed
Software Delivery policy that requires a package.

The package download might not be required when the remediation action
is to uninstall the software. In that case, the package download is skipped.

The Managed Software Delivery policy downloads the package as follows:

■ Download the package to the client computer.
■ Create a snapshot of the package that is on the client computer and

compare it to the snapshot on the package server.
If the package is already on the client computer because of a recurring
delivery or a delivery re-attempt, its existing snapshot is used for
comparison.

■ If the snapshots do not match, re-download the package.
A mismatch can occur when some kind of interception has corrupted the
package.

When the package download is successful, the compliance process is finished
and the policy is ready for the remediation process.

Package downloadStep 4
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Table 8-2 How the remediation phase of Managed Software Delivery works

DescriptionActionStep

Determines whether the software is installed on the client computer.

This compliance check ensures that the software is still in the same state
as it was during the compliance process. For example, if the remediation
was scheduled to run later than the compliance process, the software might
have been installed or uninstalled in the interim.

If the remediation is still required, the process continues.

Compliance checkStep 1

Installs, uninstalls, or performs any other remediation action that the software
requires.

If the Managed Software Delivery policy contains multiple software resources
and tasks, they are executed in the order in which they appear in the policy.

Note: If the package installation starts, and the target computer or user
remains available, the installation continues to the end even after the
scheduled end time and date of the remediation process.

Remediation actionStep 2

Determines whether the software resource is installed on the client computer.

This compliance check provides the information for reporting the results to
Notification Server.

Compliance checkStep 3

The Symantec Management Agent on the client computer reports the results
of the Managed Software Delivery process to Notification Server. You can
obtain information about the results from the compliance reports and the
delivery reports in Software Management Solution.

See “Running a Software Management Solution report” on page 117.

You can view the progress status of a Managed Software Delivery policy in
the Resource Manager, at View > Inventory > Data classes, in the data
class Managed Software Delivery Policy Progress Status.

The policy progress status is reported if you check the option Enable
reporting of a policy progress status in theReporting section. This section
is available at the following locations:

■ On the Managed Delivery Settings page, on the Run tab
■ On the Managed Software Delivery policy page, on the Policy settings

tab.

Note that this option is disabled by default.

Report to Notification
Server

Step 4

See “About advanced software deliveries” on page 120.

The following table explains how compliance tasks run with different schedules.
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Table 8-3 Behavior of the compliance process that occurs on different schedules

ResultCondition

Compliance occurs at the scheduled time.

Note: If the target computer or user is not available at the
scheduled time, compliance occurs as soon as the target
computer or user is available.

You schedule compliance and enable no advanced
options.

Compliance occurs at the scheduled time.

Note: If the target computer or user is not available at the
scheduled time, compliance occurs at the next scheduled
time.

You schedule compliance to repeat by clicking No repeat
and selecting the appropriate period of time from the
Repeat every drop-down list.

Compliance occurs at the scheduled time and until the
scheduled end date.

Note: If the target computer or user is available after the
scheduled time but before the end date, compliance occurs
as soon as the target computer or user is available and
until the scheduled end date.

If the target computer or user is not available by the
scheduled end date, compliance never occurs.

You schedule compliance and specify an end date for it
in the Advanced options dialog box.

Compliance occurs at the scheduled time until the
scheduled end date.

Note: If the target computer or user is available after the
scheduled time but before the scheduled end date,
compliance occurs at the next scheduled time until the
scheduled end date.

If the target computer or user is not available by the
scheduled end date, compliance never occurs.

You specify an end date for compliance in the Advanced
options dialog box. Then you schedule compliance to
repeat by clickingNo repeat and selecting the appropriate
period of time from the Repeat every drop-down list.

Compliance occurs at the scheduled time.

Note: If the target computer or user is not available at the
scheduled time, then compliance never occurs.

You schedule compliance, specify an exact time for it, and
check the advanced option Computer is available at the
exact scheduled time in the Advanced options dialog
box.

Compliance occurs at the scheduled time.

Note: If the target computer or user is not available at the
scheduled time, compliance occurs at the next scheduled
time.

You specify an exact time for compliance and check the
advanced option Computer is available at the exact
scheduled time in the Advanced options dialog box.
Then you schedule compliance to repeat by clicking No
repeat and selecting the appropriate period of time from
the Repeat every drop-down list.
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Table 8-3 Behavior of the compliance process that occurs on different schedules
(continued)

ResultCondition

Compliance occurs at the scheduled time until the
scheduled end date.

Note: If the target computer or user is available after the
scheduled time but before the scheduled end date, then
compliance never occurs.

If the target computer or user is not available by the
scheduled end date, compliance never occurs.

You schedule compliance, specify an exact time and an
end date for it, and check the advanced option Computer
is available at the exact scheduled time in the
Advanced options dialog box.

Compliance occurs at the scheduled time until the
scheduled end date.

Note: If the target computer or user is available after the
scheduled time but before the scheduled end date,
compliance occurs at the next scheduled time and until
the scheduled end date.

If the target computer or user is available after the
scheduled time on the scheduled end date, compliance
never occurs.

If the target computer or user is not available by the
scheduled end date, compliance never occurs.

You specify an exact time and an end date for compliance
and check the advanced option Computer is available
at the exact scheduled time in the Advanced options
dialog box. Then you schedule compliance to repeat by
clicking No repeat and selecting the appropriate period of
time from the Repeat every drop-down list.

Compliance occurs during the schedule window.

Note: If the target computer or user is not available during
the schedule window, compliance occurs as soon as the
target computer or user is available.

You schedule compliance and specify a schedule window
for it.

Compliance occurs during the schedule window.

Note: If the target computer or user is not available during
the schedule window, compliance occurs during the next
schedule window.

You specify a schedule window for compliance. Then you
schedule compliance to repeat by clicking No repeat and
selecting the appropriate period of time from the Repeat
every drop-down list.

Compliance occurs during the schedule window until the
scheduled end date.

Note: If the target computer or user is available after the
schedule window but before the scheduled end date,
compliance occurs as soon as the target computer or user
is available and until the scheduled end time and end date.

If the target computer or user is not available by the
scheduled end date, compliance never occurs.

You schedule compliance and specify a schedule window
and an end date for it.
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Table 8-3 Behavior of the compliance process that occurs on different schedules
(continued)

ResultCondition

Compliance occurs during the schedule window until the
scheduled end time and end date.

Note: If the target computer or user is available after the
schedule window but before the scheduled end date,
compliance occurs during the next schedule window and
until the scheduled end time and date.If the target
computer or user is available after the schedule window
on the scheduled end date, compliance never occurs.

If the target computer or user is not available by the
scheduled end date, compliance never occurs.

You specify a schedule window and an end date for
compliance. Then you schedule compliance to repeat by
clicking No repeat and selecting the appropriate period of
time from the Repeat every drop-down list.

Compliance occurs during the schedule window on the
scheduled start date that you specify in the Advanced
options dialog box.

Note: If the target computer or user is not available during
the schedule window, compliance never occurs.

You specify a schedule window and set the appropriate
period of time from the During window, check every
drop-down list.

Compliance occurs during the next recurring check in the
schedule window.

Note: If the target computer or user is available during the
last recurring check in the schedule window, compliance
occurs during to next schedule window.

If the target computer or user is not available during the
schedule window, compliance occurs during the next
schedule window.

You specify a schedule window and set the appropriate
period of time from the During window, check every
drop-down list. Then you schedule compliance to repeat
by clicking No repeat and selecting the appropriate period
of time from the Repeat every drop-down list.

Compliance occurs during the schedule window and until
the scheduled end time on the scheduled start date that
you specify in the Advanced options dialog box.
Specifying the end date does not influence the compliance
process in this case.

Note: If the target computer or user is not available on the
scheduled start date, compliance never occurs.

You specify a schedule window and an end date for
compliance. Then you set the appropriate period of time
from the During window, check every drop-down list.
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Table 8-3 Behavior of the compliance process that occurs on different schedules
(continued)

ResultCondition

Compliance occurs during the next recurring check in the
schedule window and until the scheduled end date.

Note: If the target computer or user is available during the
last recurring check in the schedule window, compliance
occurs during the next schedule window and until the
scheduled end date.

If the target computer or user is available during the last
recurring check in the schedule window on the scheduled
end date, compliance never occurs.

If the target computer or user is not available by the
scheduled end date, compliance never occurs.

You specify a schedule window and an end date for
compliance. Then you set the appropriate period of time
from the During window, check every drop-down list.
Then you schedule compliance to repeat by clicking No
repeat and selecting the appropriate period of time from
the Repeat every drop-down list.

The remediation process starts only after the compliance process is finished. Remediation
occurs once and cannot repeat. You can schedule the remediation action to occur immediately,
during the next maintenance window, or on the specified schedule.

Note: You can specify an end date for the remediation process. However, if the package
installation starts, and the target computer or user remains available, the installation continues
to the end even after the scheduled end date.

The following table explains how remediation tasks run with different schedules.

Table 8-4 Behavior of the remediation process that occurs on different schedules

ResultCondition

Remediation occurs at the scheduled time.

Note: If the target computer or user is not available at the
scheduled time, remediation occurs as soon as the target
computer or user is available.

You schedule remediation and enable no advanced
options.
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Table 8-4 Behavior of the remediation process that occurs on different schedules
(continued)

ResultCondition

Remediation occurs at the scheduled time.

Note: If the target computer or user is available after the
scheduled time but before the scheduled end date,
remediation occurs as soon as the target computer or user
is available.

If remediation finishes the compliance check before the
scheduled end date, remediation action occurs and
continues to the end even after the scheduled end date.

If the target computer or user is not available by the
scheduled end date, remediation never occurs.

You schedule remediation and specify an end date for it.

Remediation occurs at the scheduled time.

Note: If the target computer or user is not available at the
scheduled time, remediation never occurs.

You schedule remediation, specify an exact time for it, and
check the advanced option Computer is available at the
exact scheduled time in the Advanced options dialog
box.

Remediation occurs at the scheduled time.

Note: If the target computer or user is available after the
scheduled time but before the scheduled end date,
remediation never occurs.

If the target computer or user is not available by the
scheduled end date, remediation never occurs.

You schedule remediation, specify an exact time and end
date for it, and check the advanced option Computer is
available at the exact scheduled time in the Advanced
options dialog box.

Remediation occurs at the scheduled time.

Note: If the target computer or user is not available at the
scheduled time, remediation occurs during the next
maintenance window.

You schedule remediation to occur during the next
maintenance window.

See “Creating a Managed Software Delivery policy” on page 138.

See “Editing a Managed Software Delivery policy” on page 140.

About policy applicability, compliance, and remediation
Managed Software Delivery can intelligently perform the applicability, compliance, and
remediation actions that let you not only deliver software but also manage it. These actions
ensure that you deliver the correct software to the correct computers and that the software
remains in the correct state on the computers.

See “About the execution of Managed Software Delivery policies” on page 121.
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When you schedule a Managed Software Delivery policy, you can assign different schedules
for compliance and remediation. For example, you can schedule the compliance process to
occur during the day and the remediation to occur only during a maintenance window.

The compliance process and remediation process in Managed Software Delivery are especially
effective when you schedule the policy to run on a recurring basis. The recurring policy ensures
that the software remains in the correct state on the client computers.

Table 8-5 Applicability, compliance, and remediation actions

DescriptionAction

The applicability check determines whether the client computer has the correct environment for
an installation of the software. If the computer does not have the correct environment, the policy
execution stops.

Applicability

A compliance check uses the software resource’s unique identifier to determine whether the
software is installed on the client computer. For Windows-based software, you can define a
detection rule that contains additional information about the software and makes the detection
process even more accurate.

See “Creating or editing inventory rules” on page 73.

The compliance check always checks for the presence of the software on the client computer.
The check returns True if the software is installed and False if the software is not installed. The
correct state of a software resource can mean that it is installed or that it is not installed. A
Managed Software Delivery policy is considered compliant if all the software resources that it
contains are in the correct state on the client computer. If the software is not in the correct state,
it is considered to be out of compliance.

Compliance
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Table 8-5 Applicability, compliance, and remediation actions (continued)

DescriptionAction

Remediation is the act of fixing any software that is out of compliance on the client computer.
The nature of the remediation depends on the command-line action that the Managed Software
Delivery policy performs. For example, an installation command runs when the compliance check
returns False, and an uninstall command runs when the compliance check returns True.

Examples of how the type of command line determines the remediation action are as follows:

■ Installation command line
You want to install Symantec AntiVirus 2008 on all managed computers that do not have it
installed. You create the Managed Software Delivery policy and select an installation command
line. When the policy runs, the compliance check determines whether Symantec AntiVirus
2008 is installed.
If the software is installed, the check returns True. Because the correct state of the software
is to be installed, the software is considered to be compliant and the policy execution stops.
If the software is not installed, the check returns False. The software is out of compliance and
must be installed.

■ Uninstall command line
You want to ensure that Solitaire is not installed on any managed computers. You create the
Managed Software Delivery policy and select an uninstall command line. When the policy
runs, the compliance check determines whether Solitaire is installed.
If the software is installed, the check returns True. Because the correct state of the software
is to be uninstalled, the software is out of compliance and must be uninstalled. If the software
is not installed, the check returns False. The software is considered to be compliant and the
policy execution stops.

Remediation

See “About deferring the execution of software remediation” on page 134.

About software delivery deferral options for the user
(Windows only)

You can give the user some control over when to execute a software delivery and when to
restart or log off after the execution. In Software Management Solution, these options are
available for Managed Software Delivery policies only.
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Table 8-6 Software delivery deferral options for the user

SettingsLocation of the settingsDescriptionUser’s option

The required settings are
as follows:

■ Prompt user before
running

■ Allow user to defer up
to a total of
Lets you allow the user
to defer running the
policy up to the
maximum amount of
time that you select.

The settings for this option appear in
the following places:

■ On the Managed Delivery
Settings page, on the Run tab,
under User run conditions.

■ In an existing Managed Software
Delivery policy, in the Advanced
options dialog box, on the Run
tab, under User run conditions.

The ability to defer the
policy execution is
useful when you deliver
software during
working hours.

The user can dismiss
the Starting Task
dialog box but cannot
cancel the policy
altogether. The deferral
lets the user save work
and close any open
files or programs.

Defer the execution of a
Managed Software
Delivery policy

The settings are as follows:

■ Allow user to turn on
policy from the Altiris
Agent

■ (Optional) User must
turn on from Altiris
Agent

Note: The policy’s
remediation options
override this setting and its
related settings.

The settings for this option appear in
the following places:

■ On the Managed Delivery
Settings page, on the Schedule
tab, under User interaction.

■ In an existing Managed Software
Delivery policy, under the
Schedule section.

You might let the user
control the execution
when the software is
optional or is not critical
for that user.

Choose when to run the
policy or choose not to
run the policy
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Table 8-6 Software delivery deferral options for the user (continued)

SettingsLocation of the settingsDescriptionUser’s option

The required settings are
as follows:

■ Upon success run
Lets you specify
whether to require a
restart or a logoff after
the policy runs
successfully.

■ Allow user to defer
action up to
Lets you allow the user
to defer the
post-execution action up
to the maximum amount
of time that you select.

The settings for this option appear in
the following places:

■ On the Managed Delivery
Settings page, on the Run tab,
under Results-based actions.

■ In an existing Managed Software
Delivery policy, in the Advanced
options dialog box, on the
Results-based actions tab.

Defer a restart or a
logoff
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Table 8-6 Software delivery deferral options for the user (continued)

SettingsLocation of the settingsDescriptionUser’s option

You can set a
Managed Software
Delivery policy to
require a restart or a
logoff after the task
finishes. The restarts
and logoffs can cause
a user to lose unsaved
work. You can allow
the user to defer a
logoff. You can choose
not to force the
automated restart while
the user is logged into
the computer.

Note: If a delivery
policy installs several
software resources and
the user defers a
computer restart that is
required to complete
the installation of a
software resource, this
deferral postpones the
installation of the other
software resources in
the queue.

Starting from 8.1 RU2,
Software Management
Solution introduces the
functionality to resume
Software Management
Framework activities
and allow other
software delivery
policies and tasks to
execute on a computer
pending a restart or a
logoff that a delivery
policy requires. For
more information about
the functionality and its
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Table 8-6 Software delivery deferral options for the user (continued)

SettingsLocation of the settingsDescriptionUser’s option

limitations, see the
knowledge base article
DOC10551.

About deferring the execution of software remediation
In a Managed Software Delivery policy, you can set different schedules for the compliance
check and the remediation. You can configure these options in the default settings for all
Managed Software Delivery policies. You can also change the default settings for specific
Managed Software Deliveries.

During a Managed Software Delivery, the package download occurs during the compliance
check and the program execution occurs during the remediation. When you schedule a Managed
Software Delivery policy, you define the schedule for the compliance check and then select
an option to schedule the remediation.

See “About the execution of Managed Software Delivery policies” on page 121.

The separate schedules allow for the offline execution of the Managed Software Delivery. You
can schedule an offline execution by selecting the option to perform the remediation during
the next maintenance window.

For example, you support a large number of remote users who connect to your network a few
times a week. You need to install a new application on all their computers and you want the
installation to occur during a maintenance window. However, you cannot guarantee that the
users are connected to the network when a maintenance window is scheduled. Therefore,
you can create a Managed Software Delivery policy and schedule the compliance check to
occur as soon as a user connects to your network. Then you schedule the remediation
(installation) to occur during the next maintenance window. When a user connects to the
network, the compliance check occurs and if a remediation is required, the package download
occurs. During the maintenance window, the installation occurs on the user’s computer. The
installation can occur even if the client computer is not connected to the network, because the
computer already has the package that it needs.

See “About advanced software deliveries” on page 120.

About installing software that replaces other software
Managed Software Delivery can use the supersedence associations that are defined for
software resources to install software that replaces other software. A supersedence association
is one in which one software resource replaces another software resource.

Supersedence associations are supported in Managed Software Delivery installations only.
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See “About advanced software deliveries” on page 120.

When you create a Managed Software Delivery policy for a software resource that has a
supersedence association with other software, a message notifies you.

Depending on the nature of the association, your options are as follows:

The policy can uninstall the superseded software from the client computer
before the selected software is installed.

The selected software
supersedes other software

You can take either of the following steps:

■ Create the Managed Software Delivery policy for the superseding
software instead and ensure that you distribute only the current version
of the software.

■ Install the superseded software anyway. You can make the installation
conditional by configuring it not to install the software if a newer version
is already installed.

Other software supersedes
the selected software

The supersedence settings appear in the following places:

■ In the Managed Software Delivery wizard, on the Select software resource page.

■ In the Policy Rules/Actions section that appears when you edit a Managed Software
Delivery policy or create one without the Managed Software Delivery wizard.

See “Adding associations to a software resource” on page 78.

About the status of Managed Software Delivery policies
The information in the Software Catalog lets Software Management Solution report the status
of Managed Software Delivery policies with greater accuracy than other methods.

When a Managed Software Delivery policy completes an action on a client computer, it performs
a compliance check to evaluate the success of the execution. The compliance check uses the
software resource’s unique identifier to determine whether that software is installed on a client
computer. For Windows software, you can define a detection rule that contains additional
information about the software and makes the detection process even more accurate. After
the compliance check, the Managed Software Delivery policy reports the status information
to Notification Server. You can view the results of the Managed Software Delivery process in
the compliance reports and the delivery reports.

See “About policy applicability, compliance, and remediation” on page 128.

Using this option to determine the success of a policy is more accurate than using the package’s
exit code. A package can return an exit code that indicates success even if the delivery was
completed but the installation was not successful.
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For example, you can use a Package Delivery task to install an MSI package that contains a
custom action. However, because the custom action is placed in the wrong section of the MSI,
it is not installed on a Windows Vista computer. Even though the package is not installed, the
package execution is reported as successful because the exit code is returned. If you use a
Managed Software Delivery policy instead, the compliance check can determine that the
package is not installed. Therefore, you get an accurate report of the delivery status.

Additionally, you can view the progress status of a Managed Software Delivery policy in the
Resource Manager, at View > Inventory > Data classes, in the data classManaged Software
Delivery Policy Progress Status.

The policy progress status is reported if you check the option Enable reporting of a policy
progress status in the Reporting section. This section is available at the following locations:

■ On the Managed Delivery Settings page, on the Run tab

■ On the Managed Software Delivery policy page, on the Policy settings tab.

Note that this option is disabled by default.

See “About the execution of Managed Software Delivery policies” on page 121.

Viewing Managed Software Delivery policies
You can view all your organization’s software delivery policies.

To view Managed Software Delivery policies

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, under Policies, expand Software > Managed Software Delivery.

3 To view a policy details, in the right pane, double-click the policy.

You can edit an existing policy or create a new policy.

See “Editing a Managed Software Delivery policy” on page 140.

See “Creating a Managed Software Delivery policy” on page 138.

See “Performing software import and managed delivery” on page 142.

Creating aManagedSoftwareDelivery policywith the
Managed Software Delivery wizard

You can perform one or more advanced software delivery actions with a single Managed
Software Delivery policy. Creating a Managed Software Delivery policy is the first step in
performing an advanced software delivery.

See “Performing an advanced software delivery” on page 143.
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See “About advanced software deliveries” on page 120.

TheManaged Software Deliverywizard provides a quick way to create and schedule a policy
for a single software resource and its dependency software. We recommend that you use the
wizard because it can include any dependency software and warn you of software associations.

When you create a Managed Software Delivery policy with the Managed Software Delivery
wizard, the policy is enabled automatically. If you do not want the policy to be available to
managed computers immediately, edit the policy, and disable it. You also might edit the policy
to add information about what to deliver.

See “Editing a Managed Software Delivery policy” on page 140.

The software that you deliver in this way must be defined as a software resource in the Software
Catalog. If the software resource is not defined, contact an administrator who can edit the
Software Catalog.

You can run the Managed Software Delivery wizard from the Manage > Software view or
from other areas of the Symantec Management Console. Your point of entry into theManaged
Software Delivery wizard determines the amount of default information that is populated.

Create the policy without the wizard if you need to perform any of the following tasks:

■ Add multiple software resources and tasks.

■ Override the default settings.

■ (Windows and Mac OS only) Add the policy to the Software Portal.

See “Creating a Managed Software Delivery policy” on page 138.

See “About the execution of Managed Software Delivery policies” on page 121.

To create a Managed Software Delivery policy with the Managed Software Delivery wizard

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, expand Deliverable Software, and then click Software Releases.

3 Right-click a software resource and then click Actions > Managed Software Delivery.

If the Managed Software Delivery option is not available, the software resource does
not have a package associated with it and cannot be delivered. Click Actions > Edit
Software Resource and configure the software resource.

4 In the Managed Software Delivery wizard, on the Select software page, specify the
software to deliver and other delivery options and then click Next.

5 On the Select destinations page, specify the destinations to deliver the software to and
then click Next.

See “Selecting the delivery destinations for a Managed Software Delivery policy”
on page 141.
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6 On the Schedule delivery page, define the schedule for running the Managed Software
Delivery and then click Next.

7 (Optional) On the Specify dependencies and updates page, select any dependencies,
updates, or service packs that are defined for this software resource and then click Next.

Check Verify dependencies and select the check box for each dependency
to include.

Dependencies

Select the check box for each update or each service pack to include.Updates or
service packs

8 To complete the wizard, click Deliver Software.

Creating a Managed Software Delivery policy
A single Managed Software Delivery policy lets you perform one or more advanced software
delivery actions. Creating a Managed Software Delivery policy is the first step in performing
an advanced software delivery.

See “Performing an advanced software delivery” on page 143.

See “About advanced software deliveries” on page 120.

When you create a Managed Software Delivery policy, you can add multiple software resources
and tasks or override the default settings. You also can publish the policy to the Software
Portal for Windows and Mac client computers.

The software that you deliver in this way must be defined as a software resource in the Software
Catalog. If the software resource is not defined, contact an administrator who can edit the
Software Catalog.

If you need to quickly create and schedule a Managed Software Delivery policy, use the
Managed Software Delivery wizard instead.

See “Creating a Managed Software Delivery policy with the Managed Software Delivery wizard”
on page 136.

To create a Managed Software Delivery policy

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, under Policies, expand Software, right-click the Managed Software
Delivery folder, and then click New > Managed Software Delivery.
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3 In the right pane, click and type over the following text:

Type a name to identify this policy in any list of policies.

Make the name descriptive enough for others to easily identify this policy and
the software that it delivers or manages.

New Managed
Software Delivery

Type a description to provide further information about this policy.

Do not include critical information in the description because it is not intended
to appear in all the lists that contain the name.

Add description

4 Under Policy Rules/Actions, on the Software tab, click Add. On the Add menu, select
one of the following options:

■ Software
Lets you select from the deliverable software resources that are defined in the Software
Catalog.

■ Task
Lets you select from the client tasks that are defined in Notification Server.

5 Repeat step 4 for each software resource and task that you want to add.

6 (Optional) To change the default settings for this policy, under Policy Rules/Actions,
enter additional settings on the Policy settings tab and the Software Publishing tab.

7 (Optional) To change the default settings for a specific software resource or task, under
Policy Rules/Actions, click the software resource or task. At the right of the page, do
any of the following:

■ Change any of the options that are available on the page.

■ In a software resource, click Advanced options to display and change additional
settings.

■ In a task, click Show Task to display and change additional settings.
See “Editing a task in Software Management Solution” on page 115.

8 Expand the Applied to section to add or change the delivery destinations.

See “Selecting the delivery destinations for a Managed Software Delivery policy”
on page 141.

9 Expand the Schedule section to define the delivery schedule.

10 Turn on the policy.

At the upper right of the page, click the colored circle and then click On.

11 At the bottom of the page, click Save changes.
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Editing a Managed Software Delivery policy
You can edit a Managed Software Delivery policy for any of the following reasons:

You can add any software resources to the execution queue.

Examples are as follows:

■ You can deliver multiple software resources that comprise a set of
base applications.

■ As you discover unauthorized software on client computers, you can
add that software to a recurring uninstallation policy to keep it
uninstalled.

■ If the software in the policy requires other software, you can add the
dependency software so that all the software is installed together.
When you create a Managed Software Delivery policy with the
Managed Software Delivery wizard, the dependencies are added
automatically.

To add software resources

You can add any client task to the execution queue to perform custom
operations. For example, you can add a task that runs a script. A client
task is one that is defined in Notification Server and is intended to run on
a client computer.

To add tasks

When you add multiple software resources and tasks to a Managed
Software Delivery policy, you can set the sequence in which they run.

To rearrange the order of the
software resources and tasks

Every new Managed Software Delivery policy inherits the default settings
that are defined for Managed Software Delivery. You can override the
default settings for the entire policy.

See “Configuring the default settings for Managed Software Delivery”
on page 63.

To override the default policy
settings

The software resources and tasks that you add to the policy inherit settings
from the policy. You can edit the settings for individual software resources
and tasks.

To override the policy settings
for specific software
resources and tasks

When new managed computers are added to your organization, you can
add them to an existing Managed Software Delivery policy.

To edit the destinations

You can add schedules for the compliance check or change the
remediation options.

To edit the schedule

When you change a Managed Software Delivery policy, the updated policy is sent to the client
computers, including those on which the policy has run.
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To edit a Managed Software Delivery policy

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, under Policies, expand Software > Managed Software Delivery.

3 In the right pane, click a Managed Software Delivery policy.

4 On the policy page, do any of the following:

■ Change the policy name or description. Click either one in the upper left of the page
and type over the existing text.
Make the name descriptive enough for others to easily identify this policy and the
software that it delivers or manages.
Do not include critical information in the description because it is not intended to appear
in all the lists that contain the name.

■ Expand the Policy Rules/Actions section to add software resources and tasks and
to change the policy settings.

■ Expand the Applied to section to add or change the delivery destinations.
See “Selecting the delivery destinations for a Managed Software Delivery policy”
on page 141.

■ Expand the Schedule section to add or change the delivery schedule.

5 On the policy page, turn on the policy or turn off the policy as needed.

At the upper right of the page, click the colored circle and then click On or Off.

6 When you finish editing the Managed Software Delivery policy, click Save changes.

Selecting the delivery destinations for a Managed
Software Delivery policy

You can apply a Managed Software Delivery policy to selected resource targets, computers,
users, and resources. You can use any combination of these options to define the computers
to which the policy applies.

Managed Software Delivery supports user-based policies by letting you specify users and user
groups as policy targets. This feature lets you deliver software to any managed computer that
a specific user logs on to. When the user logs on to a computer, the Symantec Management
Agent refreshes any policy that targets that user. The policy runs on that computer according
to the schedule that you defined for it.

See “Creating a Managed Software Delivery policy with the Managed Software Delivery wizard”
on page 136.

See “Creating a Managed Software Delivery policy” on page 138.
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See “Editing a Managed Software Delivery policy” on page 140.

To select the delivery destinations for a Managed Software Delivery policy

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, under Policies, expand Software > Managed Software Delivery.

3 In the right pane, click a Managed Software Delivery policy.

4 On the policy page, expand the Applied to section to add or change the delivery
destinations.

5 On the policy page, turn on the policy or turn off the policy as needed.

At the upper right of the page, click the colored circle and then click On or Off.

6 When you finish editing the Managed Software Delivery policy, click Save changes.

Performing software import and managed delivery
You can benefit from Managed Software Delivery even if the software that you want to deliver
is not yet defined as a software resource in the Software Catalog. You can import the software
installation package and create a Managed Software Delivery policy at once to easily deliver
software to client computers.

By default, the policy is disabled and not targeted to any computer. The policy is pre-configured
to run as follows:

■ Once at 0:00 A.M. or as soon as the client computer receives the policy.

■ Daily at 2:00 A.M.

The policy delivers a software package, installs the software, and makes sure it remains
installed.

You can view the policies that you have created in the Symantec Management Console, at
Manage > Policies > Software > Managed Software Delivery.

See “Performing an advanced software delivery” on page 143.

To perform software import and managed delivery

1 In the Symantec Management Console, on the Actions menu, click Software > Import
and Deliver.

2 In the Import installation package dialog box, clickBrowse, select the software package
that you want to import, and then click Import.

You can import only the following software installation package files:

■ .exe packages
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■ .msi packages

■ .rpm packages

■ Non-DMG based .zip packages for Mac

■ .exe self-extracting (SFX) archive packages for Windows

The software packages can be local files or UNC-sourced files.

Note: To import a package, you need to configure the Software Library.

See “Setting up the Software Library” on page 33.

3 On the policy page, make the appropriate configuration changes:

In the upper left of the page, click policy name or description and
type over the existing text. Make the name descriptive enough for
others to easily identify this policy and the software that it delivers
or manages.

Policy name and description

(Optional) Under Policy Rules/Actions, you can add software
resources and tasks and change the policy settings.

Policy Rules/Actions

Under Applied to, define the set of managed computers to which
you want to apply the policy.

You can apply the policy to selected resource targets, computers,
users, and resources. You can use any combination of these options
to define the computers to which the policy applies.

Applied to

(Optional) Under Schedule, you can edit the delivery schedule.Schedule

4 Turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

5 Click Save changes.

Performing an advanced software delivery
You can perform advanced software deliveries and manage the software that is installed on
the managed computers.

See “About advanced software deliveries” on page 120.
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Table 8-7 Process for performing advanced software deliveries

DescriptionActionStep

The options for creating a Managed Software Delivery policy are as follows:

■ Use the Managed Software Delivery wizard.
The Managed Software Delivery wizard provides a quick way to deliver
the software that is already defined as a software resource in the Software
Catalog.
See “About the Software Catalog” on page 25.
You can create and schedule a policy for a single software resource and
its dependency software. Symantec recommends that you use the wizard
because it can include any dependency software and warn you of software
associations automatically.
See “Creating a Managed Software Delivery policy with the Managed
Software Delivery wizard” on page 136.

■ Create the policy manually.
This method delivers the software that is already defined as a software
resource in the Software Catalog.
Use this method to create a Managed Software Delivery policy when you
need to add multiple software resources and tasks or override the default
settings. You also can publish the policy to the Software Portal. However,
you must add any dependency software or determine software
associations yourself.
You can also edit the policy that you created with the wizard.
See “Creating a Managed Software Delivery policy” on page 138.

■ Perform software import and managed delivery.
Use this method if the software that you want to deliver is not yet defined
as a software resource in the Software Catalog. This method lets you
import the software installation package and create a Managed Software
Delivery policy at once.
See “Performing software import and managed delivery” on page 142.

Create a Managed
Software Delivery policy.

Step 1

You can edit the Managed Software Delivery policy to change or add
functionality as follows:

■ Add software resources or tasks and arrange the order in which they run.
■ Change the settings of the entire policy.
■ Change the settings of specific software resources and tasks.
■ Edit the schedule or the destinations.

See “Editing a Managed Software Delivery policy” on page 140.

(Optional) Edit the
Managed Software
Delivery policy.

Step 2
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Table 8-7 Process for performing advanced software deliveries (continued)

DescriptionActionStep

Choose the computers that you want to deliver the software to.

See “Selecting the delivery destinations for a Managed Software Delivery
policy” on page 141.

When you use the Managed Software Delivery wizard to create the policy,
you select the destinations in the wizard.

Choose the delivery
destinations.

Step 3

Define the schedule on which a Managed Software Delivery policy runs. You
schedule the compliance check and the remediation check separately.

When you use the Managed Software Delivery wizard to create the policy,
you can define the schedule during the wizard.

Schedule the policy.Step 4

The Software Management reports let you monitor the software deliveries.

The delivery reports provide information about the status of the software
downloads and executions. For example, the software downloads for each
computer, including the status and the download date. The compliance
reports provide information about the compliance actions and the remediation
actions.

See “Running a Software Management Solution report” on page 117.

After the policy runs,
view reports.

Step 5

Delivering multiple software resources and tasks
sequentially

You can deliver multiple software resources and tasks with a single Managed Software Delivery
policy. When Managed Software Delivery evaluates compliance for a group of software, only
the software that is out of compliance is downloaded and installed. You can add any client
tasks to the execution queue to perform custom operations before, during, or after the software
remediation process. A client task is one that is defined in Notification Server and is intended
to run on a client computer.

For example, you can create a single Managed Software Delivery policy that performs the
following actions:

■ Run a task that uses a script to set a registry key on the managed computer.

■ Determine whether the software resource or its dependencies are already installed.

■ Install the software and any of its dependencies that are not already installed.

■ Run every week to determine whether the registry key is still correct and the software is
still installed.

145Performing an advanced software delivery
Delivering multiple software resources and tasks sequentially



■ Reset the registry key to the correct value if necessary.

■ Reinstall any software that the compliance check determines is broken or not present.

The default settings for Managed Software Delivery determine what happens if the policy fails.
Initially, this setting is the same for each software resource and task that the policy contains.
You can edit the policy to override this setting for each software resource and task. For example,
if a critical execution in the sequence fails, you can abort the remaining items in the sequence.
Conversely, if a less-critical execution fails, you might decide to run the subsequent tasks
anyway.

Table 8-8 Process for delivering multiple software resources and tasks

DescriptionActionStep

The options for creating a Managed Software Delivery policy are as
follows:

■ Use the Managed Software Delivery wizard.
The Managed Software Delivery wizard provides a quick way to
create and schedule a policy for a single software resource and its
dependency software. We recommend that you use the wizard
because it can include any dependency software and warn you of
software associations automatically.
See “Creating a Managed Software Delivery policy with the Managed
Software Delivery wizard” on page 136.

■ Create the policy without the wizard.
Use this method to create a Managed Software Delivery policy when
you need to add multiple software resources and tasks or override
the default settings. You also can publish the policy to the Software
Portal. However, you must add any dependency software or
determine software associations yourself.
See “Creating a Managed Software Delivery policy” on page 138.

Create a Managed Software
Delivery policy.

Step 1

Select the managed computers to deliver to.

See “Selecting the delivery destinations for a Managed Software
Delivery policy” on page 141.

When you use the Managed Software Delivery wizard to create the
policy, you select the destinations during the wizard.

Select the delivery
destinations.

Step 2

Define the schedule for the entire policy. You can schedule the
compliance check and the remediation separately.

When you use the Managed Software Delivery wizard to create the
policy, you can define the schedule during the wizard.

Schedule the policy.Step 3
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Table 8-8 Process for delivering multiple software resources and tasks (continued)

DescriptionActionStep

You can add multiple software resources and tasks when you create
the policy without the Managed Software Delivery wizard. When you
use the Managed Software Delivery wizard to create the policy, you
can select only one software resource. Edit the policy to add software
and tasks.

Add the additional software
resources and tasks to the
policy.

Step 4

Move the software resources and tasks up or down in the list to
rearrange their order. Plan the sequence before you enable the policy.

Arrange the sequence in
which the software resources
and tasks are run.

Step 5

When you add software resources and tasks to a Managed Software
Delivery policy, they inherit the settings from the policy. You can change
the settings for any specific software resource or task that is in the
policy.

The settings that you can change for a specific software resource or
task include the remediation schedule, the download settings, and the
run settings.

(Optional) Change the
settings for individual
software resources or tasks.

Step 6

Performing an emergency policy update
The emergency policy update allows Managed Software Delivery policies to be rapidly deployed
throughout an environment without waiting for the normal agent configuration update interval.
Managed Software Delivery policies are only available with Software Management Solution
installed. For this reason, to use the emergency policy update feature you need to ensure that
you have Software Management Solution installed.

See “Editing a Managed Software Delivery policy” on page 140.

This feature is intended for emergency situations only, when you need to distribute a software
package as quickly as possible. This process can apply a heavy load to your system, so it
should not be used as a normal method for delivering software policies.

The emergency policy update can be used in replication and hierarchy as well. The emergency
policy update first checks if the current Notification Server computer supports hierarchy and
it has child-level Notification Server computers. If any child-level Notification Server computers
are found for the current Notification Server computer, then it starts replication immediately.
After replication is completed, the emergency policy update is executed on the child-level
Notification Server computers.
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Note:On the Internet-managed computers that use Cloud-enabled Management the emergency
policy update only works like a schedule. The Symantec Management Agent receives the
policy according to the respective schedules of either the configuration update schedule or
when client checks for new tasks. In such cases, the Notification Server computer cannot notify
the computers of the pending tasks using the tickle component of Task Management.

When you start an emergency policy update, Symantec Management Platform sends out the
appropriate client tasks. These are sent first to all of the package servers that are assigned
the relevant package, forcing those package servers to update their configuration. Second,
client tasks are sent to all of the Symantec Management Agents that the policy targets, forcing
those agents to update their configuration. These client tasks ensure that the relevant package
servers download the required package as soon as possible. They also ensure that the targeted
agents also receive the policy as soon as possible.

Note that the policy still controls how and when the software package that the updated policy
specifies is installed on a managed computer. The emergency policy update is a mechanism
for distributing the policy as quickly as possible. The emergency policy update delivers the
Managed Software Delivery policy only, not software.

You can perform an emergency policy update on Managed Software Delivery policies to
distribute a software package as quickly as possible.

Note the scenario when a Managed Delivery policy is scheduled to run once and has already
been received and evaluated on the targeted computer. If at this moment the emergency policy
update is launched, the policy does not re-evaluate again.

When you run an emergency policy update, you can monitor progress and results with the
emergency policy update reports. You can choose to have the appropriate status report
displayed in a new window when you start an emergency policy update.

See “Viewing emergency policy update reports” on page 149.

To perform an emergency policy update

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, under Policies, expand Software > Managed Software Delivery.

3 In the left pane, locate the Managed Software Delivery policy that you want to update.

4 On the policy page, turn on the policy.

At the upper right of the page, click the colored circle and then click On.

5 In the left pane, right-click on the policy and then click Emergency Policy Update.

6 In the Emergency Policy Update dialog box, read the warning message and the following
information, and then check the appropriate options:
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If the Notification Server computer is in a hierarchy, the policy and
any dependent items are replicated to each node in the hierarchy
tree. The emergency policy update process is run on each node.

This option appears only when the Notification Server computer is
part of a Hierarchy.

Replicate the policy to child
Notification Servers

Displays the appropriate status report in a new window:

■ If the policy is not replicated, the Emergency Policy Update
Status Summary report is displayed.

■ If the policy is replicated down a hierarchy, the Emergency
Policy Update Status by Hierarchy Node report is displayed.

Display status report in new
windowwhenOK is clicked
(ensure pop-ups are
enabled)

7 Click OK.

Viewing emergency policy update reports
When you run an emergency policy update, you can monitor progress and results with the
emergency policy update reports. You can choose to have the appropriate status report
displayed in a new window when you start an emergency policy update.

See “Performing an emergency policy update” on page 147.

To view the emergency policy update reports

1 In the Symantec Management Console, in the Reports menu, click All Reports.

2 In the left pane, clickReports > Notification Server Management > Server > Emergency
Policy Update, and then click the report that you want to view:

■ Emergency Policy Update Status by Hierarchy Node shows each node in the
hierarchy.
The Depth column indicates the level in the hierarchy of the particular Notification
Server computer. A depth of 0 indicates the parent Notification Server computer and
is at the top of the hierarchy environment. A depth of 1 indicates a child Notification
Server computer.
The report returns no results when the server is not in a hierarchy.

■ Emergency Policy Update Status Summary shows the number of package servers
and Symantec Management Agents that requested a new configuration since the
emergency policy update process was started.
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Delivering software from
user requests using the
Software Portal

This chapter includes the following topics:

■ Introducing software requests and the Software Portal

■ Setting up the Software Portal

■ Configuring security roles and privileges for the Software Portal

■ Reviewing and approving software requests

■ Using the Software Portal on the client computer

Introducing software requests and the Software
Portal

Before you manage software requests, it is a good idea to better understand the Software
Portal.

To help you get more familiar with software requests and the Software Portal you can refer to
the following:

■ About the Software Portal and how it lets users submit requests and install software through
a Web-based interface with little or no administrator involvement
See “About the Software Portal” on page 151.

■ About how an administrator adds software to the Software Portal and the terms that describe
the software in the Software Portal.
See “About the software in the Software Portal” on page 152.
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■ About methods for adding software to the Software Portal so that an end user can request
it
See “Methods for adding software to the Software Portal” on page 153.

■ About the status of a software request and how it indicates its place in the Software Portal
approval process
See “Statuses of software requests in the Software Portal” on page 154.

■ About the delivery methods for delivering software from approved software requests
See “Methods for delivering software from approved software requests” on page 156.

About the Software Portal
The Software Portal is a self-service software request system that lets users request and install
Windows and Mac OS applications through a web-based interface with minimal administrator
involvement. The Software Portal uses predefined software information and delivery settings
to automate the requested software deliveries.

An administrator decides, which published software requires approval, and targets a combination
of users and devices for software publishing. Requests for pre-approved applications require
no further action from anyone. Requests for other applications that are listed in the Software
Portal require approval from a manager or an administrator. Upon approval, the software
delivery is automatic. Only the requests for unlisted applications require the manager or the
administrator to take further action to deliver the software.

Users can access the Software Portal only from the client Windows and Mac computers that
are licensed for Software Management Solution and meet the following requirements:

■ The Symantec Management Agent is installed on the computers.

■ Software Management Solution Plug-in is installed on the computers.

■ The computers are present in the target of the Software Portal Client Access Policy and
the policy is enabled.
See “Configuring the Software Portal Client Access Policy” on page 60.

Note: Users can also securely access the Software Portal over the Internet on the computers
that are in Cloud-enabled mode and running Windows 7 or later and Mac OS X or later.

To benefit from the Software Portal, end users must use a HTML5-compatible browser.

The Software Portal lets you perform the following actions:

■ Configure your user information and preferences.
See “Configuring your Software Portal user profile” on page 176.

■ Request Windows and Mac OS applications.
See “Requesting software” on page 178.
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■ Review and manage your software requests.
See “Managing application requests on the My Requests tab” on page 180.

■ Review, approve, or deny application requests, if you are a manager.
Some requests may also need an administrator’s approval.
See “Managing user application requests on the User Requests tab” on page 181.

■ Specify the users whose software requests you can process, if you are a manager.
See “Manage users” on page 182.

See “Implementing the Software Portal” on page 157.

See “Processing a software request on the Administrator Portal page” on page 173.

About the software in the Software Portal
An administrator adds software to the Software Portal and configures the settings and the
permissions that let users request the software. The terms that describe these settings and
permissions appear on the Software Portal pages where the software is displayed.

Note: When you publish a software resource to the Software Portal on a parent Notification
Server computer, you cannot search for and select local users and groups of a child domain.
You can assign permissions for the users and groups that are visible on the parent domain
only. The software publishing in hierarchy works properly when the parent Notification Server
computer and its children are in the same domain.

See “About the Software Portal” on page 151.

See “Methods for adding software to the Software Portal” on page 153.

Table 9-1 Terms that describe the software in the Software Portal

DescriptionTerm

The software that is in the Software Catalog and published to the Software Portal
for the current user.

Listed software is available for the user to request.

The term Listed can also apply to a request for listed software.

Listed
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Table 9-1 Terms that describe the software in the Software Portal (continued)

DescriptionTerm

Software that meets any of the following conditions:

■ The software is not in the Software Catalog.
■ The software is in the Software Catalog but is not published to the Software

Portal.
■ The software is published to the Software Portal but not for the current user.

Unlisted software cannot be delivered automatically on request.

The term Unlisted can also apply to a request for unlisted software.

Unlisted

The listed software that is pre-approved for a specific user. Typically, the software
that does not require a license is pre-approved. For example, Adobe Reader and
the Google Toolbar do not require a license.

Approved software is delivered or scheduled for delivery as soon as the user submits
a request for it. No further action is needed.

The person who publishes the software to the Software Portal can pre-approve it.

Approved

The listed software that is recommended for a specific user. For example, the
software that is part of the user’s set of core applications should be recommended.

The Software Portal displays all software that is published for the current user.

The person who publishes the software to the Software Portal can designate it as
recommended.

Recommended

Methods for adding software to the Software Portal
Before a user requests software from the Software Portal, you must add the software that the
user can request. The process of adding software to the Software Portal is known as publishing
or creating a software publication.

Publishing software to the Software Portal consists of the following actions:

■ Selecting the software to publish

■ Defining the users who are allowed to request that software

■ Specifying whether a user needs approval to install that software

Using the Software Publication wizard is the fastest and easiest way to create software
publications.

See “Publishing software with the Software Publication wizard” on page 164.

When you create a software publication, you can select one of the following methods to publish
the software to the Software Portal:
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Publish a software resource to the Software Portal to deliver a single piece of
software with minimum configuration. Most organizations can publish the
majority of software in this way.

Software resource

Publish a Managed Software Delivery policy to the Software Portal to deliver
one or more software resources with complex delivery requirements.

Managed Software
Delivery policy

You can also perform these publishing tasks on the software resource or Managed Software
Delivery policy pages.

See “Adding a software resource to the Software Portal” on page 167.

See “Adding a Managed Software Delivery policy to the Software Portal” on page 169.

After a software request for a published software is approved, the download and installation
of the software starts within 1 minute.

Statuses of software requests in the Software Portal
The status of an application request indicates its place in the Software Portal approval process.

Users and managers can check request status at any time at the following locations:

■ Users check the status of their requests on the My Requests tab.
Users can also configure their user profile and enable the following notification option:
Receive notification email messages when someone comments on or changes the
status of the user's application request
Notification email messages contain the link to the Software Portal, where the user can
view and update the application request. The user can use the Software Portal credentials
to open the link from any device.
See “Configuring your Software Portal user profile” on page 176.

■ Managers check the status of user requests on the User Requests tab.

Table 9-2 Statuses of software requests in the Software Portal

DescriptionStatus

The request is approved and the software is either installed or scheduled for
installation.

Approved (Complete)

The request is for unlisted software and a manager approved it and sent it to
an administrator for approval.

Approved (Pending)

The user canceled the request.Canceled
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Table 9-2 Statuses of software requests in the Software Portal (continued)

DescriptionStatus

A request is closed when it has any of the following statuses:

■ Approved (Complete)
■ Approved (Pending)
■ Canceled
■ Denied

The Closed status does not appear in the UI. However, it is included in the
messages that appear when someone tries to edit a request that is closed.

Closed

The manager or the administrator denied the request.Denied

An attempt to deliver the requested software was made and it failed. This status
describes the software delivery rather than the software request. It appears
on the Software Portal reports and the Web Parts that appear in the Symantec
Management Console.

Failure

The administrator placed the request on hold pending further research.

For example, the administrator might need to check the availability of a license
or obtain the software.

On Hold

The request is not closed. For example, the On Hold request is considered to
be Open.

Open

The request is approved and is scheduled for delivery.Scheduled

The user created the request but no one has taken further action on it.Submitted

The requested software was delivered successfully. It appears on the Software
Portal reports and in the Web Parts that appear in the Symantec Management
Console.

Success

Users can also check the installation statuses of requested and approved applications on the
My Requests tab or configure their user profile and enable the following notification option:

Display notification when requested application is installed on my device

See “Configuring your Software Portal user profile” on page 176.

Table 9-3 Installation statuses of approved software requests in the Software Portal

DescriptionStatus

The software request is approved. Installation of the requested application is
currently in progress.

Installation in Progress
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Table 9-3 Installation statuses of approved software requests in the Software Portal
(continued)

DescriptionStatus

■ Installation of the requested application is completed successfully.
■ The requested application is detected as already installed on the user's

computer.

Succeeded

Installation of the requested application failed with an error.Failed

The software request is approved in the IT Management Suite versions prior
to 8.5 RU2. The installation status of the requested application cannot be
provided.

Unknown

See “About the software in the Software Portal” on page 152.

Methods for delivering software from approved software requests
When a manager or administrator approves a software request, the software is delivered to
the user.

The delivery method for requested software depends on whether the software is listed or
unlisted as follows:

Listed software is delivered automatically upon approval of the software request.
The method that was used to publish the software to the Software Portal determines
whether a task or a policy performs the delivery.

See Table 9-4 on page 156.

Listed software

Unlisted software cannot be installed automatically. The approver must take
additional action outside of the Software Portal to deliver the software.

An unlisted software resource is not in the Software Catalog or is not published to
the Software Portal for the person who creates the request.

See Table 9-5 on page 157.

Unlisted software

Table 9-4 Delivery methods for listed software

Delivery methodPublication method

The first approved request for that software creates a Quick Delivery task.
Each subsequent request for that software creates a new instance of the first
Quick Delivery task. The new instance is delivered to the user who requested
the software.

Software resource
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Table 9-4 Delivery methods for listed software (continued)

Delivery methodPublication method

A request for that software adds the user to the destinations for the policy. The
software is delivered according the schedule that is defined for that policy.

Managed Software
Delivery policy

See “Methods for adding software to the Software Portal” on page 153.

Table 9-5 Delivery methods for unlisted software

Delivery methodTypical approverSoftware resource’s state

The administrator or the manager
obtains the software and gives it to the
user to install.

Administrator or
manager

The software resource is not in the
Software Catalog and it does not need
to be added.

For example, the software might be a
special utility that only a few people in
the organization need.

Add the software resource to the
Software Catalog and create a
software delivery policy or task to
deliver it.

See “Methods for delivering software”
on page 105.

AdministratorThe software resource is not in the
Software Catalog and it needs to be
added.

For example, the software application
is one that you plan to manage.

Create a software delivery policy or
task to deliver the software.

See “Methods for delivering software”
on page 105.

AdministratorThe software resource is in the
Software Catalog but was not
published at all or was not published
for the user who requested it.

Setting up the Software Portal

Implementing the Software Portal
Before you or any users can use the Software Portal, you must set it up and prepare it for use.

See “About the Software Portal” on page 151.

The minimum prerequisites for implementing the Software Portal are as follows:

■ Software Management Solution must be installed on the Notification Server computer. The
Software Portal is installed on the Notification Server computer when Software Management
Solution is installed.
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■ The Symantec Management Agent and Software Management Solution Plug-in must be
installed on the computers on which you implement the Software Portal.
See “Installing or upgrading the Software Management Solution plug-in” on page 58.

Table 9-6 Process for implementing the Software Portal

DescriptionActionStep

The security settings provide the permissions to manage and approve
the users’ software requests.

See “Configuring security roles and privileges for the Software Portal”
on page 170.

Typically, users do not have access to the Symantec Management
Console and do not have Altiris security roles.

Configure security roles for
the administrators and
managers who need to use
the Software Portal.

Step 1

The Software Portal settings customize the portal’s behavior and
appearance. You can change these settings at any time after you
implement the Software Portal.

See “Configuring the Software Portal settings” on page 159.

Configure the Software Portal
settings.

Step 2

The Software Portal Client Access Policy lets you configure how end
users access the Software Portal from the client computers.

Windows and Mac client computers on which you implement the
Software Portal must be present in the target of the Software Portal
Client Access Policy.

See “Configuring the Software Portal Client Access Policy” on page 60.

Configure the Software
Portal Client Access Policy.

Step 3
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Table 9-6 Process for implementing the Software Portal (continued)

DescriptionActionStep

Before a user requests software from the Software Portal, you must
define the software that the user can request. In most cases, you
perform this step when software resources are added to Notification
Server and you plan to publish them. For example, when you add a
new software resource to the Software Catalog, you add the users who
are allowed to request that software.

You can define software in the Software Portal by creating a software
publication. When you create a software publication, you can select
one of the following methods to publish the software to the Software
Portal:

■ Publish a software resource to perform a quick delivery of a single
software resource with a minimum of configuration.

■ Publish a Managed Software Delivery policy to take advantage of
its ability to respond to complex delivery requirements.

Using the Software Publication wizard is the fastest and easiest way
to create software publications.

See “Publishing software with the Software Publication wizard”
on page 164.

You can also perform these publishing tasks on the software resource
or Managed Software Delivery policy pages.

See “Adding a software resource to the Software Portal” on page 167.

See “Adding a Managed Software Delivery policy to the Software Portal”
on page 169.

Define the software that
appears in the Software
Portal.

Step 4

Anyone who uses the Software Portal must configure their profiles
before they create or process requests for unlisted applications or the
applications that need approval.

See “Configuring your Software Portal user profile” on page 176.

Instruct the users and
managers to configure their
user profiles.

Step 5

Configuring the Software Portal settings
Before you use the Software Portal, configure the settings that customize its behavior and
appearance. You can change these settings at any time after you implement the Software
Portal.

This task is a step in the process for implementing the Software Portal.

See “Implementing the Software Portal” on page 157.
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To configure the Software Portal settings

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, expand Software > Software Portal Settings, and then click Software
Portal Settings.

3 On the Software Portal Settings page, underUI Settings, configure the following options
of the Software Portal user interface:

Lets you upload a custom background image file that you want to display in
the Software Portal header.

In a web browser window, the image is horizontally and vertically centered and
resized to fit the Software Portal header area.

The image file can have a standard format (for example: PNG, JPG, GIF, BMP,
etc.).

The image file dimensions are not restricted.

Use the following
background
image in the
Software Portal
header

Lets you upload a custom logo image file that you want to display in the
Software Portal header.

In a web browser window, the image is horizontally and vertically centered but
not resized.

The image file can have a standard format (for example: PNG, JPG, GIF, BMP,
etc.).

The image file dimensions are not restricted but Symantec recommends using
a reasonable file size to fit into the Software Portal header area.

Use the following
company logo in
the Software
Portal header

The Software Portal header preview demonstrates the future look of the Software Portal
header after the Software Portal Administrator specifies custom background and logo
images.

4 (Optional) Under Publishing Settings, specify the following information:

You can check this option if you do not want end users to request the software
that is not published for them in the Software Portal.

Prevent end
users from
requesting
unlisted software
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You can check this option if you want to publish software not only across the
Notification Server domain but also across other domains trusted by the
Notification Server domain.

■ All trusted domains
Lets you publish software for the users or groups in the Notification Server
domain and all domains trusted by the Notification Server domain.

Note: If you select this option, the Software Portal loading time can
increase.

■ Specified trusted domains:
Lets you publish software for the users or groups in the Notification Server
domain and some domains trusted by the Notification Server domain.
This option is available starting from 8.5 RU2.

Allow software
publishing across
the following
trusted domains:

5 (Optional) Under Delivery Settings, specify the default timeout period for the Quick
Delivery tasks to deliver the required software. An increased timeout period can significantly
improve software delivery for the Software Portal.

By default the End task after is set to 300 minutes (five hours). A recommended value
to change the timeout period to is 1440 minutes (24 hours). The maximum timeout
allowable is 2160 (36 hours).

The End task after option is only available for newly created Quick Delivery tasks.

6 (Optional) Under E-mail notifications settings, specify your email address preferences
for sending out Software Portal notifications.

Lets you define the default email address that the Software Portal Administrator
uses to send out Software Portal notifications.

You can use Admin@Symantec.com or specify other email address that
meets your needs.

Common email
address

Lets a Software Portal Manager send out messages from the email address
that the Configuration Management Database (CMDB) contains for the
manager.

The individual email address gets into the CMDB in the following ways:

■ The administrator uses Microsoft Active Directory Import to enter the
manager data into the CMDB.

■ The Software Portal Manager defines an email address in the user profile
in the Software Portal.

If the CMDB contains no manager email address, the Software Portal sends
notifications from the common email address.

Sender's
individual email
address (if
defined)

7 Click Save changes.
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Managing software publications
The Manage Publications page is the primary location for administrators to view and easily
manage all available software publications that once have been published to the Software
Portal.

A software publication or a publishing item represents the publishing settings for a software
that you can publish for end users of the Software Portal. As soon as a software publication
is created and enabled, the relevant software is published to the Software Portal. Note that if
the publication references a Managed Software Delivery policy, the policy must be enabled
for the software to be published to the Software Portal.

The Manage Publications page displays software publications that are in the published,
unpublished, or pending state.

Table 9-7 States of software publications

DescriptionState

A software publication is created, configured, and published to the Software
Portal.

Published

A software publication is created and configured, but not published to the
Software Portal.

Unpublished

A software publication is created, configured, and published to the Software
Portal but not available for the end users because the publication references
a disabled Managed Software Delivery policy.

Pending

On theManage Publications page, you can view, edit, delete, or unpublish an existing software
publication. You can publish a publication that has Unpublished or Pending state. You can
also easily create a new software publication with Software Publicationwizard. This Software
Portal administration method is fast and convenient because you do not need to go to the
software resource or Managed Software Delivery policy pages to perform the same tasks
separately for each software publication.

This task is a step in the process for implementing the Software Portal.

See “Implementing the Software Portal” on page 157.

To manage software publications

1 In the Symantec Management Console, on the Manage menu, click Software
Publications.

2 On theManage Publications page, under Software Publications, browse to the software
publication you need.

Use the search and filter features to find the publication if necessary.

3 Do one of the following:
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■ You can view the most important details of the software
publication that let you identify and classify the publication. For
example, you can see publishing and approval state, software
name, vendor, platform, version, category, and type.

■ To view more information about the software publication, such
as command line and software availability, and then double-click
the software publication.

View details of a software
publication.

■ To temporarily remove the existing software publication from the
Software Portal without losing the software settings, uncheck the
Published check box in the left.

■ To make the unpublished software publication available in the
Software Portal again, check the Published check box in the
left.

Note: When you check the Published check box for the
publication in Pending state, you are prompted to enable the
disabled Managed Software Delivery policy that the publication
references. Upon this action, the publication state automatically
changes to Published, and the publication becomes available
in the Software Portal.

Unpublish or publish an
existing software publication.

1 Click the software publication, and then click Delete
Publication.

If you want to delete many publications at once, select multiple
items while holding down the Shift or Ctrl key, and then click
Delete Publication.

Note: When you delete a software publication, all active
software requests that are associated with the publication are
denied and closed. All the publication related information is
deleted.

2 Click OK.

Delete a software publication.

1 Click the software publication, and then click Edit Publication.

If you want to edit many publications, you need to select them
and edit one by one.

2 On the software publication page, edit software publication
settings, and then click OK.

Edit an existing software
publication.

Click Publish Software and use the Software Publication wizard
that simplifies the software publication creation.

See “Publishing software with the Software Publication wizard”
on page 164.

Create a new software
publication.
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Publishing software with the Software Publication wizard
Software Management Solution provides the Software Publicationwizard that appears when
the administrator publishes software to the Software Portal on theManage Publications page.
Using the Software Publication wizard is the fastest and easiest way to create software
publications.

A software publication or a publishing item represents the publishing settings for a software
that you can publish for end users of the Software Portal. As soon as a software publication
is created and enabled, the relevant software is published to the Software Portal. Note that if
the publication references a Managed Software Delivery policy, the policy must be enabled
for the software to be published to the Software Portal.

You can view and manage all created software publications of any type and in any state on
the Manage Publications page. You can also view and manage the software components
that have the software publications of the Software Release type in the Published state at
Manage > Software > Published Software > Published Software Releases.

See “Managing software publications” on page 162.

To publish software with the Software Publication wizard

1 In the Symantec Management Console, on the Manage menu, click Software
Publications.

2 On theManagePublications page, underSoftware Publications, clickPublish Software.

3 In the Software Publication wizard, on the Select software page, specify one of the
methods to publish the software to the Software Portal, and then click Next.

1 Select Software component, click Browse, in the Select
Software dialog box, click the software resource that you want
to publish, and then click OK.

2 View the default command line for the selected software
resource or specify new command line.

Publish a software resource
to deliver a single piece of
software with minimum
configuration.
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1 SelectManaged delivery, clickBrowse, and then in the Select
managed delivery dialog box, click the Managed Software
Delivery policy that you want to publish.

Note: If you select a disabled policy, the software publication
will be created and published to the Software Portal (the
Published check box will be checked). However, the publication
will be in the Pending state and unavailable for the end users
until the policy gets enabled. To enable the policy and add the
publication to the Software Portal, you need to edit the
publishing state of this publication on theManage Publications
page as follows:

Click Edit Publications, on the software publication page, click
the colored circle, and then click Published.

See “Managing software publications” on page 162.

Note: If you have no Managed Software Delivery policies,
before publishing, you need to create a Managed Software
Delivery policy manually or with the Managed Software
Delivery wizard.

See “Creating a Managed Software Delivery policy with the
Managed Software Delivery wizard” on page 136.

See “Creating a Managed Software Delivery policy” on page 138.

2 Click OK.

Publish a Managed Software
Delivery policy to deliver one
or more software resources
with complex delivery
requirements.
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4 On the Manage availability page, target users and computers for software publishing by
configuring the following settings:

Lets you automatically target all users and all computers for software
publishing.

To edit the default targets according to your needs, click Change
User or Change Targets.

Add

Lets you change the list of users or groups of users who have
permission to request this software resource.

If you target both users and devices for software publishing, only
the selected users on the specified devices get permission to request
the software.

Change User

Lets you change the list of target devices or groups of devices for
software publishing.

If you target both devices and users for software publishing, only
the selected users on the specified devices get permission to request
the software.

Change Targets

Pre-approves the published software for the specified users or
devices. When such users request this software on the specified
devices, a software delivery task is created to install it. No further
action is required.

Approved

Makes this software appear in this user’s Software Portal display by
default for the specified users or devices.

Recommended

5 Do one of the following:

■ To create a software publication with the default name, description, and category, click
Create Publication.
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■ To review or edit the software details before the creation of the software publication,
click Next.

6 On the Review and select category page, review or edit the following settings, and then
click Create Publication.

Lets you edit a software resource or a Managed Software Delivery
policy that the software publication contains.

See “Adding or editing a software resource” on page 67.

See “Editing a Managed Software Delivery policy” on page 140.

Software

Identifies this software in any list of software in the Software Portal.

Make the name descriptive enough for users to easily identify this
software. Follow your organization's standards for naming software,
if any.

Name

Lets you type a description to further identify this software and make
it more recognizable.

Description

Lets you select a category for the published software.

The selected category is only displayed in the Software Portal for
the published software and has no associations with the software
resource in the Symantec Management Console.

Category

Adding a software resource to the Software Portal
The process of adding software to the Software Portal is known as publishing or creating a
software publication. You can publish a software resource to the Software Portal to deliver a
single piece of software with minimum configuration. You can publish only the resources that
have a command line. You can select one or more command lines that you want to publish,
and configure user and permission assignments for each of the command lines individually.
For example, you can choose to pre-approve the software install command line, but require
administrator's approval for the uninstall command line.

After a software request for a published software resource is approved, the Quick Delivery
task is created. The task starts download and installation of the software on the user’s computer
within 1 minute.

When a software resource is published to the Software Portal, its publishing settings are saved
in the Software Catalog as a reference to the software resource. A reference is an association
between the software resource and another item in the Symantec Management Platform. The
publishing settings include the permissions, software name, and software description. Because
the reference is saved with the software resource, you can temporarily un-publish the software
from the Software Portal without losing the software settings.
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For example, you publish a software resource to the Software Portal and set permissions for
12 user groups. Later, you need to make that software unavailable for a specific time, so you
uncheck the Publish check box on the Software Publishing tab or on Manage Publications
page. When you decide to make the software available again, you can check the Publish
check box and the publishing settings of the software are preserved. You do not have to reset
the permissions for those user groups.

You can delete a software publication on the Manage Publications page.

Note:When you delete a software publication, all active software requests that are associated
with the publication are denied and closed. All the publication related information is deleted.

See “Managing software publications” on page 162.

You can delete a software resource that is published to the Software Portal. However, to delete
the software resource that has references, you must delete the references first.

See “Deleting a software resource” on page 68.

Warning: If you publish a software resource that is dependent on one or more other software
resources, the other software resources are not delivered unless you create and publish a
Managed Software Delivery policy that includes all the required software resources.

Using the Software Publication wizard is the fastest and easiest way to create a software
publication that references a software resource or a Managed Software Delivery policy.

See “Publishing software with the Software Publication wizard” on page 164.

However, you can add a software resource to the Software Portal on the software resource
page too.

This task is a step in the process for implementing the Software Portal.

See “Implementing the Software Portal” on page 157.

To add a software resource to the Software Portal

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the left pane, expand Deliverable Software, and then click Software Releases.

3 In the Software Releases pane, right-click a software resource and then click Actions
> Edit Software Resource.
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4 (Optional) Add or edit a custom icon for the software resource as follows:

On the software resource edit page, click the Properties tab, and under Display Icon,
click Change Icon (to replace a predefined icon) or Upload Icon (to replace a custom
icon), and then browse for your image and upload it.

Custom icon is displayed in the Software Portal.

Warning: After you replace a predefined icon with a custom icon, you can no longer use
the predefined icon for this software resource.

The following image types are supported: PNG, JPEG, GIF.

5 On the software resource edit page, click the Software Publishing tab.

6 On the Software Publishing tab, select one or more command lines and configure other
settings for publishing this software resource.

7 Click OK.

8 Close the software resource edit page.

Adding a Managed Software Delivery policy to the Software Portal
Using the Software Publication wizard is the fastest and easiest way to create a software
publication that references a software resource or a managed software delivery policy.

See “Publishing software with the Software Publication wizard” on page 164.

However, you can add (publish) an existing managed software delivery policy to the Software
Portal on the Managed Software Delivery policy page too.

The published Managed Software Delivery policy delivers one or more software resources
with complex delivery requirements.

See “About advanced software deliveries” on page 120.

For example, you can publish a managed software delivery policy that installs a software
resource and the other software that it depends on. The user can request the main software
without having to request the dependency software or even know that a dependency exists.

After a software request for a published software is approved, the relevant managed software
delivery policy is immediately delivered to the user’s computer. The policy starts download
and installation of the software within 1 minute.

Note: During the policy approval, the policy is rescheduled to run immediately if the current
policy schedule delays policy execution.
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This task is a step in the process for implementing the Software Portal.

See “Implementing the Software Portal” on page 157.

To add a Managed Software Delivery policy to the Software Portal

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, under Policies, expand Software > Managed Software Delivery, and
then click a managed software delivery policy.

3 In the right pane, expand the Policy Rules/Actions section and click the Software
Publishing tab.

4 On the Software Publishing tab, enter the details and select the settings for publishing
this software resource.

5 In the right pane, click Save changes.

Configuring security roles and privileges for the
Software Portal

Several types of users interact with the Software Portal. As part of the Software Portal
implementation, you need to assign the appropriate user accounts to the Notification Server
security roles that can manage the Software Portal. The members of a role have all of the
privileges and permissions that are granted to the role.

Certain security roles have specific security privileges that let them manage and approve the
user software requests and publish software to the Software Portal.

See “Implementing the Software Portal” on page 157.

Table 9-8 Users of the Software Portal

Responsibilities and required rolesUser

This administrator requires the Software Portal Administrators role to administer software
requests.

The administrator manages software requests in the Symantec Management Console in
the following situations:

■ The end user is not assigned to a manager.
The administrator gets a notification e-mail when such a user requests software.

■ The manager approves the request for an unlisted software and the request is
automatically assigned to the administrator to take further action.
The administrator gets a notification e-mail about such a request.

Administrator, Software
Portal
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Table 9-8 Users of the Software Portal (continued)

Responsibilities and required rolesUser

The Software Catalog administrator requires the Symantec Software Librarian role to
manage the Software Catalog that represents the software that is known to be in your
organization.

The Software Catalog administrator’s tasks are as follows:

■ Define the software that appears in the Software Portal for specific users or groups.
■ Pre-approve software for specific users or groups.

Pre-approval streamlines the request process by eliminating the need for additional
intervention from the manager, administrator, or help desk. For example, the administrator
can pre-approve a group of software tools that users in a specific department require.

Administrator, Software
Catalog

The Software Portal manager requires the Software Portal Managers role to approve or
deny software requests from other users in the Software Portal.

The manager can be any employee in your organization who has the authority to allow users
to acquire software. Typically, a department manager fills this role.

Manager

The user on a client computer submits requests for software on the Home page in the
Software Portal. The user can be any employee in the organization who needs software.

Because the Software Portal is installed on the client computer, the user can create requests
without access to the Symantec Management Console.

Typically, users do not have access to the Symantec Management Console and do not have
Notification Server security roles.

User

Table 9-9 Security roles that can interact with the Software Portal

Manage
software
requests

Publish
software to
the Software
Portal

Default privileges and permissionsSecurity role

✓

In the Symantec
Management
Console

✓Has all security privileges and permissions assigned.

Has complete access to all aspects of the Symantec
Management Platform and any installed solutions.

Symantec
Administrators

✕✓Has most of the Management privileges and the
right-click menu privileges assigned.

Has the Read permission on resources, excluding
security resources.

Has limited access to Cloud-enabled Management
settings.

Symantec Level 2
Workers
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Table 9-9 Security roles that can interact with the Software Portal (continued)

Manage
software
requests

Publish
software to
the Software
Portal

Default privileges and permissionsSecurity role

✕✓

Software
components
only

Has limited set of privileges assigned by default.

Has the Read permission on resources, excluding
security resources.

Has no permission to modify Managed Software Delivery
policies.

Symantec Level 1
Workers

✓

In the Symantec
Management
Console

✓

Software
components
only

Has most of the right-click menu privileges assigned.

Has complete privileges to manage the Software Portal
settings.

Has no Notification Server Account Management
privilege. As a result, cannot define Software Portal
Managers.

Has no permission to modify Managed Software Delivery
policies.

Software Portal
Administrators

✓

In the Software
Portal

✕Has privileges to manage and approve user software
requests.

The manager can specify the users or groups whose
software requests the manager can process.

Software Portal
Managers

✕✓

Software
components
only

Has some of the Software Management privileges and
the right-click menu actions privileges assigned.

The privileges are limited to those needed to create and
manage software packages.

Has no permission to view Managed Software Delivery
policies.

Symantec Software
Librarian

"✓" denotes that the role can perform the action. / "✕" denotes that the role cannot perform
the action.

You can use the predefined privileges of a role or configure the set of privileges for a security
role.

To configure security roles and privileges for the Software Portal

1 In the Symantec Management Console, on the Settings menu, click Security > Account
Management.

2 In the left pane, click Account Management > Roles.
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3 On the Roles page, in the left pane, click the security role that you want to configure.

4 In the right pane, on the Privileges tab, select the privileges that you want to assign the
role.

To select a privilege, check the corresponding check box.

Reviewing and approving software requests

Finding and filtering software requests on the Administrator Portal
page

You can search for specific types of software requests on the Administrator Portal page.

To find and filter software requests

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, expand Software > Software Portal Settings, and then click
Administrator Portal.

3 On the Administrator Portal page, expand the Filtering options section.

4 Select the filter criteria.

5 Click Search.

Processing a software request on the Administrator Portal page
Every software request that is created in the Software Portal must be approved before the
software is installed. Different user roles can approve the software requests, depending on
the type of request and the stage of the software request process.

Table 9-10 Users who can approve software requests

When their approval is neededApprover

The Software Catalog administrator can pre-approve software for specific users or groups
when the software is published to the Software Portal.

Pre-approval streamlines the request process by eliminating the need for additional
intervention from the manager, administrator, or help desk. For example, the administrator
can pre-approve a group of software tools that users in a specific department require.

Administrator, Software
Catalog
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Table 9-10 Users who can approve software requests (continued)

When their approval is neededApprover

A request requires an administrator approval in the following situations:

■ When the user is not assigned to a manager
The administrator gets a notification email when such a user requests software.

■ When the manager approves the request for an unlisted software and the request is
assigned to the administrator to take further action. The administrator gets a notification
email about such a request.
An unlisted software resource is not in the Software Catalog or is not published to the
Software Portal for the person who creates the request. A request for an unlisted software
resource requires the manager or the administrator to take additional action. A manager
who has access to the software can approve the request and provide the software to
the user. A manager who does not have access to the software can approve the request
and assign it to the administrator, who can provide the software. For example, the
administrator can obtain new software or create a software delivery task.

Administrator, Software
Portal

A request requires a manager approval when the software is not pre-approved for a user
who is assigned to that manager. The software can be listed or unlisted.

When a manager approves a request for listed software, the software is delivered. When a
manager approves a request for unlisted software, the manager can choose to assign it to
the Software Portal administrator for additional action.

See “Managing user application requests on the User Requests tab” on page 181.

Manager

When you are the administrator and process a software request, you set the following request
statuses:

■ Approve

■ On Hold

■ Deny

See “Statuses of software requests in the Software Portal” on page 154.

To process a software request on the Administrator Portal page

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, expand Software > Software Portal Settings, and then click
Administrator Portal.

3 On the Administrator Portal page, under Requested Software, select the software
request.

Use the search feature to find and display other requests if necessary.

See “Finding and filtering software requests on the Administrator Portal page” on page 173.
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4 Do one of the following:

■ To open the request for review, comments, or a status change, click Edit.

■ To quickly change the status without opening the request, click Change Status and
on the Change Status menu, select the status.

5 If you have opened the software request, in the Listed Software Request Details dialog
box or the Unlisted Software Request Details dialog box, take any of the following
actions:

■ Change the status.
If you approve the request for unlisted software, take steps to obtain the software.

■ Enter comments to explain why you have changed the status or to request additional
information.
Comments are required whenever you change the status.

■ To review the comments and actions, expand the Request History section.

6 If this request is for unlisted software, you can click one of the following links:

If you know that the software resource is not in the Software Catalog,
click this link to import it. The Import Software wizard opens.

See “Importing a package to create a software resource” on page 46.

Import new software
resource

The software resource might be in the Software Catalog. However,
it might not have been published at all or it might not have been
published for this user. Click this link to open the Software Catalog
so you can determine if the requested software is in the catalog.

Search for available
software resource

If the software resource is in the Software Catalog, click this link to
start the Quick Delivery wizard and create a Quick Delivery task.

See “Creating a Quick Delivery task with the Quick Delivery wizard”
on page 110.

Create Quick Delivery task

If the software resource is in the Software Catalog, click this link to
start theManaged Software Deliverywizard and create a Managed
Software Delivery policy.

See “Creating a Managed Software Delivery policy with the Managed
Software Delivery wizard” on page 136.

Create Managed Delivery
task

7 In the Listed Software Request Details dialog box or the Unlisted Software Request
Details dialog box, click OK.

8 If you approve a request for the unlisted software, take steps to obtain the software.
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Using the Software Portal on the client computer

Opening the Software Portal
Users can access the Software Portal only from the client Windows and Mac computers that
meet the following requirements:

■ The Symantec Management Agent is installed on the computers.

■ The Software Management Solution Plug-in is installed on the computers.

■ The computers are present in the target of the Software Portal Client Access Policy and
the policy is enabled.
See “Configuring the Software Portal Client Access Policy” on page 60.

Note: The Software Portal also opens on the computers with Cloud-enabled Management
enabled.

To open the Software Portal

◆ Take one of the following actions:

■ (Windows only) Double-click the Symantec Software Portal shortcut on your Desktop.

■ (Windows only) On the Start menu, click All Programs > Symantec > Symantec
Software Portal

■ Right-click the Symantec Management Agent icon in the notification area, and then
click Software Portal.

■ (Mac only) Right-click the Symantec Management Agent icon in the notification area,
click Symantec Management Agent, and then under Software Management click
Software Portal.

The Software Portal might not be available from all these places on your computer. Which
option is available depends on the settings you chose in the Software Portal Client
Access Policy.

Configuring your Software Portal user profile
A user profile contains the information that identifies the user in the Software Portal.

You must configure your user profile before you request an unlisted application or an application
that needs approval.

See “Requesting software” on page 178.
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To configure your user profile

1 In the Software Portal, in the upper right corner of the page, click the menu icon, and then
in the drop-down menu, click the name of the user.

2 In the User Profile dialog box, configure the following options:

Lets you provide information about yourself to facilitate
communication between the people who make the requests and the
people who review the requests.

Pre-populated user details are taken from the Active Directory if the
required fields are specified for the same user.

Full Name, Email,
Department, Phone

(End users only)

Lets you enable the Software Portal notifications about the download
and installation of the requested application.

The notifications do not require user interaction and disappear after
a while. You can also close the notifications.

For example, if you enable this option, the Installation Succeeded
notification appears when the application that you have requested
in the Software Portal is installed on your device. If a software
delivery policy requires a computer restart after the installation of
an application, the Installation Succeeded notification appears,
and then your device restarts.

Note: Your preferences for this option do not apply to other users
who may log in to your device and may have different user profile
configuration.

Display notification when
requested application is
installed on my device.
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Lets you configure the notification emails as follows:

■ The status of my request changes
If you are a user, this option lets you receive an email message
when someone changes the status of one of your application
requests.
If you are a manager, this option lets you receive email messages
about new user requests and the changes related to the user
requests that you can process.

■ Comments are added to my request
If you are a user, this option lets you receive an email message
when someone comments on one of your application requests.
If you are a manager, this option lets you receive an email
message when someone comments on one of the user requests
that you can process.

Notification emails contain the link to the Software Portal, where the
user can view and update the application request. The user can use
the Software Portal credentials to open the link from any device.

Send me an email when

3 Click Save.

Requesting software
In the Software Portal, on the Applications tab, you can request and install Windows and
Mac OS applications with minimal administrator involvement.

The Applications tab displays only the applications that are compatible with the software
platform of the device that you use to open the Software Portal.

You can filter the applications by category, type, and approval. You can also search for the
applications by name, vendor, and version.

Note: Before you can request an unlisted application or an application that needs approval,
you must configure your user profile.

See “Configuring your Software Portal user profile” on page 176.

After you submit an application request, it is processed as follows:

■ If you request a pre-approved application, the application is downloaded and installed on
your device.

■ If you request an application that needs approval or that is not listed on the Applications
tab, the request is assigned to your manager or administrator.
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To receive notifications about the changes related to your request, configure your user profile
accordingly.

You can review and manage your software requests on the My Requests tab.

See “Managing application requests on the My Requests tab” on page 180.

To request an application

1 In the Software Portal, click the Applications tab.

2 In the list of applications, do one of the following:

1 Browse to the application that you need.

Use the search and filter features to find the application if
necessary.

2 Hover over the application card, and then click the Submit
request icon.

3 In theApplication Request dialog box, do one of the following:
■ To download and install a pre-approved application, click

OK.
■ To request an application that needs approval, add

justification, and then click Submit request.

Request an application.

1 Browse to the application that you need.

Use the search and filter features to find the application if
necessary.

2 Click the application card.

3 In theApplication Details dialog box, view application details,
and then click Request Application.

4 In theApplication Request dialog box, do one of the following:
■ To download and install a pre-approved application, click

OK.
■ To request an application that needs approval, add

justification, and then click Submit request.

View the details of an
application and request the
application.

1 Click the Application not listed card.

2 In the Unlisted Application Request dialog box, provide
required information about the application that you need.

3 Click Submit request.

Note: This option is available only if the administrator allows end
users to request the software that is not published for them in the
Software Portal.

Request an unlisted
application.
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Managing application requests on the My Requests tab
In the Software Portal, on the My Requests tab, you can manage your application requests
in the following ways:

■ View details of an application request.

■ View the installation status of the requested software.
This feature is available starting from IT Management Suite version 8.5 RU2.

■ Add comments to an application request to justify your need for an application or to provide
details about the unlisted application that you request.

■ Cancel an application request.

Note: If a request is closed, you cannot add comments to the request or cancel the request.

See “Statuses of software requests in the Software Portal” on page 154.

To manage your application requests

1 In the Software Portal, click the My Requests tab, and then browse to the request that
you need.

Use the search feature to find the request if necessary.

2 Do one of the following:

1 Click the request.

2 In the Application Request Details dialog box, view the
request details.

View details of the request.

1 Click the request.

2 In the Application Request Details dialog box, under New
comment, add your comment, and then click Send.

3 Click Close.

Add a comment to the
request.

1 Hover over the request.

2 Click the Cancel Request icon in the right.

3 In the Cancel Application Request dialog box, click OK.

You can also cancel the request in theApplication Request Details
dialog box.

Cancel the request.
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Managing user application requests on the User Requests tab
The User Requests tab is available only to the users (managers) who have permission to
approve and deny other user application requests.

If you are a manager, in the Software Portal, on the User Requests tab, you can manage
application requests from end users in the following ways:

■ View details of an application request.
You can filter user requests by request status and application type. You can also use the
Requests filter to view only the requests from the users who report directly to you.

■ Approve an application request.
After you approve the request for the application that is listed in the Software Portal, the
application is automatically downloaded and installed on the end user's device.
After you approve the request for an unlisted application, the request is assigned to the
administrator to take further action to deliver the software.

■ Deny an application request.

■ Add comments to an application request to explain the status that you assign to a request
or to request additional information from users.

Note: If a request is closed, you cannot approve, deny, or add comments to the request.

See “Statuses of software requests in the Software Portal” on page 154.

To manage user application requests

1 In the Software Portal, click the User Requests tab, and then browse to the request you
need.

Use the search and filter features to find the request if necessary.

2 Do one of the following:

1 Click the request.

2 In the User Request Details dialog box, view request details.

To view more information about the requested application, click
Application Details, and then click Back.

View details of a request.

1 Hover over the request.

2 Click the Approve Request icon in the right.

3 In the Approve Application Request dialog box, click OK.

You can also approve the request in the User Request Details
dialog box.

Approve a request.
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1 Hover over the request.

2 Click the Deny Request icon in the right.

3 In the Deny Application Request dialog box, specify reasons
for denial, and then click OK.

You can also deny the request in the User Request Details dialog
box.

Deny a request.

1 Click the request.

2 In theUser Request Details dialog box, underNew comment,
add your comment, and then click Send.

3 Click Close.

Add a comment to a request.

Manage users
The Users tab is available only to the users (managers) who have permission to approve and
deny application requests from other users.

If you are a manager, in the Software Portal, on the Users tab, you can specify the users or
groups whose software requests you can process.

To manage users or groups

1 In the Software Portal, click the Users tab.

2 Do one of the following:

1 Click the Add Users or Groups icon in the upper right corner
of the users and groups list.

2 In the Add Users or Groups dialog box, search for the users
or groups of users whose software requests you want to
process.

3 Browse to the user or group that you need, click the user or
group, and then click Add.

Add users or groups.

1 Browse to the user or group that you need.

Use the search feature to find the user or group if necessary.

2 Hover over the user or group.

3 Click the Remove user or group icon in the right.

4 In the Remove User or Group dialog box, click OK.

Remove users or groups.
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Installing approved software
When your software request is approved, the software is delivered to and installed on your
computer. In most cases, the software is installed automatically.

(Windows only) Your administrator might configure the software delivery to require you to
initiate the software installation. In that case, you initiate the installation from the Symantec
Management Agent that is installed on your computer.

To install approved software

1 Open the Symantec Management Agent in one of the following ways:

■ On the Start menu, click Programs > Symantec > Symantec Management Agent.

■ Right-click the Symantec Management Agent icon in the notification area and then
click Symantec Management Agent.

■ Run the following command:
installation path\Altiris\Altiris Agent\AeXAgentActivate.exe

2 In the Symantec Management Agent window, click the Software Delivery tab.

On the Software Delivery tab, under Deliveries available for this computer, click the
software to install.

3 In the left pane, under Application Tasks, click the task to install the selected software.

For more information, see the topics about the Software Delivery page in the Symantec
Management Agent User Interface Help.

You can open the Symantec Management Agent User Interface Help when you click Help in
the upper right of the Symantec Management Agent window.
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